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CHAPTER 1

Introduction

MS
HTML WEB
ELP HELP

Supported In:

ECLIPSE
HELP

HTML

5|

You can use the search feature in online outputs. Search works differently with each output
type. There are also special features that you can use to enhance search, such as micro content,
synonyms, partial-word search, filters, reports, and excluding topics from search.

General Information

"Client or Server Output” on page 10

® "Searching the Outputs' on page 11

"End User Search Features" on page 38

"Content Developer Search Options" on page 40

Required Activities

® “Including Search Bars" on page 44

® (HTML5 Only) "Setting Up a Search Engine" on page 50
» "MadCap Search" on page 57
o "Elasticsearch" on page 63

» "Google Search" on page 131
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Optional Activities

"Setting Search Results Options” on page 137

"Generating Sitemaps" on page 169

® "Optimizing Search" on page 171

"Search Filter Sets" on page 210

"Search Highlighting" on page 229 and "Customizing the Highlight Color for Search Hits" on
page 232

® "Server-Based Search HTML5" on page 240

"Creating Synonyms" on page 263

"Including or Excluding Topics in Search" on page 270
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CHAPTER 2

General Information for Search

There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Client or Server OUTPUL ... 10
Searching the Outputs ... 11
End User Search Features ... 38
Content Developer Search Options ... 40
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| Client or Server Output

The search features and capabilities that are available in your published Flare output depend on the
output type. In addition, you can perform search queries using different search methods and syntax
when you publish client- or server-based output.

Search and Client-Based Output

With the web-based output types, search operations are supported by a Flare search database. This
database consists of an array of JavaScript and XML files that are built and published with the Flare
output in the Data folder. With Microsoft HTML Help, the Microsoft Compiled HTML (CHM) Help file
format also offers a built-in search engine.

Search and Server-Based Output

There are multiple search options to choose from for online output, including server-based search
options. For example, the server-based HTMLS output type can be enabled in Flare Desktop, and
then published to an Internet Information Services (IIS) server. For these outputs, search operations
are supported by the Microsoft Indexing Service or Windows Search.

However, you do not need to use HTMLS5 server-based output to have server-based search. We
recommend that you use Elasticsearch with regular HTMLS output to produce server-based search.
Elasticsearch includes features such as search auto-complete with suggestions.
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| Searching the Outputs

Depending on the output type, the user interface for your published output offers different search
features and functionality.

When compiling online output, the build process generates a search database with the target's
output files. When an end user searches for information, the search process looks through this
database to retrieve a list of topics containing matching criteria.

NOTE End user search features are supported by the Eclipse Help Viewer and search
operations are provided by a plug-in that you develop using the Eclipse platform (for more
information, see help.eclipse.org). The Flare search engine does not handle Eclipse Help
search operations.

Searching an HTML5 System

End users have a variety of options when performing a search in an HTMLS5 system.

Search Experience

An HTMLS5 skin provides the user interface for an HTML5 system. When an end user searches an
HTMLS5 system for information, it reveals a list of topics containing the matching term or phrase.
The search results show the topic title and the topics are listed in ranked order. The results also
include an excerpt of the paragraph text from the topic (or you can opt to use the meta description
that you add to the topic properties). This helps users decide if the page contains the information
they were looking for. When a user clicks a topic to open it, the matching terms are highlighted in
the topic.
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E Contents

|=] Welcome

[l cats

[l Dogs

[l Hamsters
[l Parrots

[l POF Files

- -
™
- madcap

=]

Lists search resulis in
ranked order. r =Dogs

[l Raising Multiple Pets

Type the search query.

Narrow the scope of the search to
categories defined by a search filter set.

Your search for "dogs" returned 16 result(s).

Dogs This is where we tell you everything you need to know about dogs:
Animals/Dogs/Dogs.htm

Raising Dogs and Cats Together

Raising Dogs and Cats Together This is where we give you advice for raising dogs and cats together.

4| Animals/RaisingMultiples/Raising_Dogs_and_Cats_Together htm

Raising Dogs and Kittens Together

Results also show the
topic title, a text
excerpt (or meta

description), and a

Raising Dogs and Kittens Together This is where we give you advice for raising dogs and kittens together.
Animals/RaisingMultiples/Raising_Dogs_and_Kittens_Together.htm

Caring for Your Dogs Eyes

link to the topic.

Feeding a Dog

Feeding a Dog This is where we tell you everything you need to know about feeding dogs:

Caring for Your Dogs Eyes To your dog's vision sharp (and a twinkle in his or her eyes), follow these steps:
Animals/Dogs/Caring_for_Your_Dogs_Eyes.htm

Animals/Doas/Feeding a Dog.htm

file:///C:/Users/snelson/Documents/My Projects/Pets/Output/snelson/Example_HTMLS5/Default.htm

Allfies ¥ O

Click Search.

m

Click this button to remove
all the search highlighting.

Choosing a Dog
Feeding a Dog

Training a Dog

Grooming a Dog

Walking a Dog

This is where we tell you everything you need to know about dogs:

Search highlighting shows
the matching terms.
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Features and Capabilities

This table details the search features and capabilities of the HTMLS5 system. It also describes the
options that you have for customizing the user interface:

Feature

Search Field and
Button

Filters List

CHAPTER 2

Description

Type a search query. Then click the
button or press ENTER to initiate a

search.

NOTE Asterisk (*) wildcard
and boolean search
capabilities are available.
See "Search Methods and
Syntax" on page 27.

Provides users with the ability to

narrow the scope of their search

results to categories defined by a
search filter set.

Content Developer Options

Change the look of the field and
button.

Create filter selections by adding a
search filter set and associating it
with the Flare target. See "Creating
Search Filters" on page 219 and
"Associating a Search Filter Set
With a Target" on page 223.

Customize the order of the search
filters in the output. See
"Customizing Search Filter
Ordering" on page 221.

Change the appearance of the
drop-down in the Skin Editor.

13



Feature

Search Results

Search
Highlighting

CHAPTER 2

Description

Lists search results in ranked
order.

Matching keywords are bolded in
search results.

Highlights matching keywords in
topics.

Tripane output shows highlights
words in color by default. In Side
and Top Navigation outputs,
search results are transparent, but
you can customize this, adding
colors.

NOTE Matches are not
highlighted when users
perform searches with the
asterisk (*) wildcard
character.

Content Developer Options

Change the appearance of your
search results.

Set the number of search results
that display on each page. See
"Optimizing a Site" on page 197.

Adjust the weight the search
engine places on internal links to a
topic when ranking search results.
See "Setting Search Result
Importance" on page 149.

If you are using Pulse, you have the
option to display community
results in search.

Define the highlight color in the
project's stylesheet. See
"Search Highlighting" on page 229.
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Feature

Remove
Highlighting
Button

Search Result
Pagination
Options

Search Non-
HTML Files

(Server-Based
Output Only)

CHAPTER 2

Description

Removes search highlighting from
topics.

Change the number of search
results that appear on the page.

When end users perform a search
in your online output, you can
ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that
search.

Content Developer Options

Include this button in the toolbar.

Include and format pagination
options.

Include non-HTML files in search
results when publishing server-
based output. See "Including Non-
XHTML Files in HTMLS Search" on
page 257.
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How to Search
1. Openthe HTMLS system.

2. Inthe search field, type the search query. Then click the Search button or press Enter.

NOTE Searches are not case-sensitive. See "Search Methods and Syntax" on page
27.

NOTE If a search filter set is added to the project, users can narrow the scope of the
search by selecting an item from the Filter list. This limits the scope to search only
the topics assigned to the selected filter. See "Search Filter Set Example" on page
224.

3. Inthe search results list, double-click one of the topics to open it. Search highlighting reveals
the matches in the topic.

NOTE The search highlighting colors can be customized by the content developer.
See "Customizing the Highlight Color for Search Hits" on page 232.

NOTE If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.
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Searching a Microsoft HTML Help System

End users have a variety of options when performing a search in a Microsoft HTML Help system.

Search Experience

A Standard skin provides the user interface for a Microsoft HTML Help system. It also includes
features defined by the Compiled HTML (CHM) specification.

When an end user searches a Microsoft HTML Help system for information, it reveals a list of
topics containing the matching term or phrase. The search results shows matches by title, location,
and rank. When an end user clicks a topic to open it, the matching terms are highlighted in the
topic.

£ HTML Help T e m—— [E=REE )
L B ¢ = 0 [ 6 & &

gcate  Back Forward  Stop  Refresh  Home Font Print

Corterts | Index  Search | Favortes | Welcome to the Wonderful World of Pets
Enter a search Type in the word|s) to search for:

term or phrase.

‘Tﬂaising dogs j ﬂ
Display,

gﬂpp,ic: Found: 2

H ol
SlE et r Title [ Location [ Rank | \ Click to open the e tell you everything you need to know about dogs. See

Click to access the
search features. P_

In this Flare target, you'll find information about these animals:

7L

q — tell you everything you need to know about cats. See Cats.

Raising Dogs and Ki... example_ht... 1 highlighted topic.

Raising Dogsand C... example_ht... 2

tell you everything you need to know about fish. See Fish.

sters This is where we tell you everything you need to know about hamsters.

Hamsters. I
Rank shown in
Select topic list.

ots This is where we tell you everything you need to know about parrots. See
ots.

Turtles This is where we tell you everything you need to know about turtles. See
Turtles.

Place a checkmark L ™ Search previous results
| Match similar words

in a box to refine
[~ Search it
the search. r[ R b
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Features and Capabilities

This table details the search features and capabilities of the Microsoft HTML Help system. It also
describes the options that you have for customizing the user interface:

Feature

Search Tab

Search Field and
Button

Boolean Operators List

Advanced Search
Check Boxes

CHAPTER 2

Description

A tab that reveals the search
feature.

Type a search query. Then click
the button or press ENTER to
initiate a search.

NOTE Asterisk

(*) wildcard and boolean
search capabilities are
available. See "Search
Methods and Syntax" on
page 27.

A drop-down list of boolean
operators that can be used with
search.

A series of three advanced search

check boxes:
® Search previous results
® Match similar words

B Search titles only

Content Developer Options...

Enable the search feature using
the Skin Editor. See "Including
Search Bars" on page 44.

Cannot be turned on and off.

Cannot be turned on and off.

Supports the listed boolean
operators only. See "Search
Methods and Syntax" on page
27.

Enable or disable these options
in the Skin Editor by clicking the
HTML Help Setup tab. Under
MiscOptions, place a check
mark in theShow Advanced
Search box.
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Feature

Search Results

Display Button

Search Highlighting

CHAPTER 2

Description

Lists search results in ranked
order.

Opens the highlighted topic. End
users can alternatively double-
click a topic to open it.

Highlights matching keywords in
topics.

Content Developer Options...

Cannot be turned on and off.

Optimize topics to improve
search results. See "Optimizing
Search” on page 171.

Cannot be turned on and off.

Cannot modify search highlight
color.
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How to Search
1. Open the Microsoft HTML Help system.

2. Inthe navigation pane, click the Search tab.

3. Type the search query. Then click List Topics or press ENTER.

NOTE Searches are not case-sensitive. See "Search Methods and Syntax" on page
27.

NOTE The search query can include boolean operators or the asterisk (*) wildcard
character. See "Search Methods and Syntax" on page 27.

TO USE THE ADVANCED SEARCH OPTIONS

If you enabled the Advanced Search check boxes, users have option to refine the search
query as follows:

® Search Previous Results If you want to search only the topics included in the previous
results list, place a check mark in theSearch previous results box.

® Match Similar Words To find words with similar spelling, place a check mark in
theMatch similar wordsbox. For example, if you type puppy and select this check box,
the search finds "puppy" and "puppies.”

® Search Titles Only To search topics only for matches in the topic title, place a check
mark in theSearch titles only box.

CHAPTER 2 20



4. Inthe search results, open the desired topic using one of these methods:
® Highlight a topic in the list. Then click Display.

® Double-click a topic in the list. Search highlighting reveals the matches in the topic.

NOTE If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.

NOTE Unlike other output types, you cannot modify the search highlighting color in
Microsoft HTML Help. See "Search Highlighting" on page 229.

Troubleshooting the No Topics Found Issue

A common issue encountered by Microsoft HTML Help developers is when a "No Topics Found"
message appears while searching a CHM file.

Typically, this is the result of an unregistered dynamic link library (DLL) file on the computer building
the Help file. The DLL is named "itcc.dll" and is a component of Microsoft's CHM specification. Its
purpose is to supply the operating system running Flare Desktop with the ability to build a CHM file
with index and search capabilities.

A variety of software vendors (particularly those that develop Help authoring tools) distribute a
copy of the itcc.dll file along with their program installation files. Should you happen to install or
uninstall program with a copy of this file (e.g., a Help tool or software program from another vendor
or another MadCap software tool that requires this file), it is possible for other copies of the itcc.dll
file to become unregistered.

To resolve this issue, the Flare\bin directory contains a batch file named Registerltcc.bat. You can
run this batch file to re-register the DLL in Windows.

NOTE Users running Windows 7 may need to switch off the computer's User Account
Control (UAC) settings before beginning. For instructions, visit this link:

http://windows.microsoft.com/en-us/windows?7/products/features/user-account-
control
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How to Register the DLL Using the Batch File

1. In Windows Explorer, navigate to the Flare Desktop installation's \bin directory. Typically, the
path is as follows (where [#]= the Flare Desktop version number):

= Windows 7 or 8 (64-bit versions)

« |f you are using Flare Desktop 12 or later

C:\Program Files\MadCap Software\MadCap Flare [#]\
Flare.app\Resources\Bin

« |f you are using Flare Desktop 11 or earlier

C:\Program Files\MadCap Software\MadCap Flare V[#]\
Flare.app\Resources\Bin

= Windows 7 or 8 (32-bit versions)

CHAPTER 2

C:\Program Files (x86)\MadCap Software\MadCap Flare VI[#]
\Flare.app\Resources\Bin

NOTE The path that you use depends on your specific system configuration.
For users running the 64-bit version of Windows, you will see two folders
named Program Files on your C: drive. Typically, the folder named

"\Program Files (x86)" stores non-native 32-bit applications, and the "\Program
Files" folder stores native 64-bit applications, such as Flare Desktop. If you
installed Flare Desktop in a different location, you need to determine the
appropriate path to the \bin directory.
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2. Inthe bin directory, double-click the file named Registerltcc.bat.

This runs the batch file. If the registration is successful, a message appears telling you so.

NOTE If the following error message appears, the account you are using may not
have sufficient permissions to run the batch file on the computer.

The module "itcc.dll” was loaded but the call to
DlIRegisterServer failed with error code 080070005,

For more information about this problem, search
online using the error code as a search term.

You will need to use your computer's command line utility to register the DLL as

described below or contact your Windows administrator for assistance with
registering the DLL.
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How to Register the DLL Using the Command Line Utility

1. In Windows Explorer, open the computer's System32 directory. The path is
C:\Windows\System32.

2. Right-click the application file named cmd.exe and select Run as administrator from the
context menu.

Navigate to the
System32 directory.

- “m
| = |
K55  » Computer b LocalDisk (C) » Windows » System32 » - Search System3Z o

Organize = Open Burn New folder =« [ @
5| Documents (4 Name ’ Date modified Type =
&' Music &) cfsw32.dl 7/13/20096:40 PM  Applica
[] Pictures | ﬂ %] cliconfg.dil 7/13/20096:40PM  Applica[ ]
E Videos L‘.E;“ cliconfg 7/13/2009 6:39 PM Applica

%) cliconfg.rll 7/13/2008 5:28 PM Applica
1M Computer == clip 7/13/2009 6:39 PM Applica
E._-:" Local Disk (C:) %] clusapi.dll 11/20/2010 7:24 PM  Applica
2. 5fifal%4ddald3ad42fbecchdbe51499 %) emefg32.dll 7/13/2009 6:40 PM  Applica
L Dell - 110202010 723 DM Applica
W Drivers Select Run as - e | Appica
. Hotfix administrator from the '@ Run as administrater Applica
. Exp0.tmp context menu. W Scan with VIPRE... Applica
b I%‘(Fftl_mp =T : g Add to archive... I; -
§ Dte modified: 11/20/2010723PM  Date created: 11/20/2010 | 38 Add to "emd.rar”
Application Size: 337 KB B Compress and email..

Compress to "cmd.rar” and email

3. If the User Account Control message appears, click Yes. This lets you use the command
prompt to make changes on the system.

NOTE In Windows 7, you can use this method to run the command prompt as an
administrator when you are using an account that does not have administrative
credentials. This typically allows most users to make changes to the itcc.dll file in the
Flare \bin directory.
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4. At the command prompt, do the following:

a. Type cdto change directories and press the SPACEBAR. Then type the path to the

CHAPTER 2

Flare \bin directory as shown in this example:

1’} EXAMPLE Use this information to enter the following path, depending on your
version of Flare Desktop.

IF YOU ARE USING FLARE DESKTOP 12 OR LATER

C:\Program Files\MadCap Software\MadCap Flare [#]\
Flare.app\Resources\Bin

Below is an example:

C:\Program Files\MadCap Software\MadCap Flare 22\
Flare.app\Resources\Bin

-
ER Administrator: C:\Windows\System32\cmd .exe |ﬂ|ﬁ]

Microsoft Windows [Version 6.1.76811
Copyright ¢c)> 2809 Microsoft Corporation. HAll rights reserved.

C:“Windowz~8yztemn32>cd C:“Program Filesz\MadCap SoftwaresMadCap Flare 17~Flare.ap

p~Resources~Bin

25



¢ IF YOU ARE USING FLARE DESKTOP 11 OR EARLIER

C:\Program Files (x86)\MadCap Software\MadCap Flare V[#]\
Flare.app\Resources\Bin

Where [#] appears above, you must enter the correct Flare Desktop version
number when typing the system path (e.g., V8, V9, V10.). Below is an example:

C:\Program Files (x86)\MadCap Software\MadCap Flare V9\
Flare.app\Resources\Bin

BEX Administrator C\Windows\Syste

Microsoft Windows [Uersion 6.1.76811
Copyright <c?> 28087 Hicrosoft Corporation. A1l rights reserved.

C:sUWindowsssystemd2>cd C:wProgram Files {(x86>~MadCap Software~MadCap Flare U?-F1
are.app~ResourcessBing

b. Press ENTER.

5. Atthe command prompt, type: registeritcc.bat. Then press ENTER. This runs the batch
file. If the registration is successful, a message tells you so.

6. Click OK to acknowledge the message.

7. Close the command prompt.

After registering the DLL, build your Microsoft HTML Help output again. Then retry your search in

the output.

CHAPTER 2
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Search Methods and Syntax

Depending on the output type you are searching, end users can perform a variety of simple text and
phrase searches. Some output types also support the use of boolean operators, the asterisk (*)
wildcard character, and other syntax.

Full-Text Search

All online output types support full-text search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based output,
search is provided by the either the Microsoft Indexing Service or Windows Search.

For all other output types, Flare Desktop scans all of the target content and creates a database
index for search. When a user enters a search query, the search engine in the index to retrieve a list
of topics with matches. In Flare Desktop, search results include these matches:

® Case-insensitive Matches Search is not case-sensitive. For example, a search for the word
"run” will find matches for "Run" and "run."

® Matches with Variant Endings For example, a search for the word "run” will also find matches
for words such as, "runner," "running,” and "runs." Since matches are not case-sensitive, the
results will include topics containing matches such as, ‘Runner," "Running,” and "Runs."
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How to Perform a Full Text Search

1. Open the online output.
2. Inthe search field, type a partial word or number string.
For example, type ham.

3. Press ENTER or click Search.

Type a partial word or

Edit  View

numberstring.
= AT R [ Hamsters  x
= v [ Sewcn |0 HepTopic [ QO R W@ BB % % - 4
Title Rank File

This is where we tell you everything you need to know about hamsters:

Hamsters 1 Animals/Hamst
Choosing a Habit... Animals/Hamst Choosing a Hamster A

Feeding a Hamster Animals/Hamst
Choosing a Hams.... Animals/Hamst

Choosing a Habitat for a Hamster Matches with
vanantendings.

Showing Your Dog Animalz/Dogs.|

Animals/Dogs/ Matches are not
case-sensitive.

2

3

4
Welcome tothe ... |5 Welcome htm Feeding a Hamster
PDF Files ] Animals/Files/F ; i

7

2

Maming Your Dog

NOTE Search highlighting reveals the matches in the topic. In supported output types, you
can change the highlighting color for search hits. See "Search Highlighting" on page 229.
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Phrase Search

All online output types support phrase search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based outputs,
search is provided by the either the Microsoft Indexing Service or Windows Search.

End users can search for phrases by enclosing their search terms in quotation marks. This is useful
when end users want to restrict a search to locate terms that appear in an exact order. For
example, you might want to search for a phrase such as "Dog Friendly."

How to Perform a Phrase Search

1. Open the online output.
In the search field, type a word, number, or character string.

Press ENTER or click the Search button.

> W™

Double-click a match in the list to open the corresponding topic.

(D IMPORTANT If you have enabled the stop words feature, search will not find
matches for queries containing stop words in quotes. For example, if you search for
the phrase "Pets are fun," search will only include topics with the words "pets" and
"fun." This is because the word "are" is part of the stop word list. See "Including Stop
Words in Search" on page 142.

NOTE Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting"
on page 229.
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Boolean Operators

The Microsoft HTML Help, WebHelp, and HTMLS5 output types support boolean operators —e.g.,
AND, OR, NEAR, NOT, and (). Note that when providing users with server-based WebHelp or HTML5
output, boolean operators are not supported. Operators can be used in combination with search
terms to increase or decrease the number of search results.

Requirements and Dependencies

® Eclipse Help Boolean search is supported by the search engine that you configure in the
Eclipse platform. See the Eclipse documentation at help.eclipse.org.

® HTML Help Boolean search is provided by the viewer in accordance with the Microsoft
Compiled HTML (CHM) specification. You must select the supported boolean operator from a
predefined drop-down list. See "Searching a Microsoft HTML Help System" on page 17.

® HTML5 Boolean search is provided by Flare Desktop in client-based output only. When
delivering server-based output, the Microsoft Indexing Service or Windows Search handles
search. See the Microsoft documentation for information about the Indexing Service:

http://msdn.microsoft.com/en-us/library/ee805985(v=vs.85).aspx

See the following for information about Windows Search:

http://msdn.microsoft.com/en-us/library/windows/desktop/ff628790(v=vs.85).aspx

See also "Enabling HTMLS5 Server-Based Output’ on page 241.

® WebHelp and WebHelp Plus Boolean search is provided by Flare Desktop in client-based
output only. When delivering server-based output (WebHelp Plus), the Microsoft Indexing
Service or Windows Search service handles search. See the Microsoft documentation for
information about the Indexing Service:

http://msdn.microsoft.com/en-us/library/ee805985(v=vs.85).aspx

See the following for information about Windows Search:

http://msdn.microsoft.com/en-us/library/windows/desktop/ff628790(v=vs.85).aspx
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How to Search with Boolean Operators

In the table below, a check mark shows the operators supported by each client-based output type. It

also details any supported variables and provides usage examples:

Operators

AND

CHAPTER 2

HTML
Usage Help

Use to narrow the search and
retrieve only the topics that
contain all of the words it
separates.

Type AND between two or more
terms. This is not case sensitive.

When separating terms with a X
blank space, the AND is always

inferred. This is only available in

HTMLS help.

Instead of the word AND, type the
plus symbol (+).

Instead of the word AND, type the
ampersand symbol ().

HTML5!

WebHelp

3



Operators

Usage

HTML
Help

HTMLS5?

WebHelp

OR

Use to search for two or more
words. This broadens the search
results by retrieving topics that
contain any of the words it
separates.

Type or between two or more
terms. This operator is not case
sensitive.

v

When separating terms with a
blank space, the OR is always
inferred. This is not available in
HTMLS help.

Type the pipe symbol (]) instead of
typing OR.

NEAR

Select from the operator list to find
topics that contain matches that
are in close proximity to each
other.

This is only available in Microsoft
HTML Help. The operator must be
selected from a list.
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Operators

NOT

()

Usage

Use to search only for matching
topics that do not contain the term
following the operator.

Type NOT before a term. This
operator is not case-sensitive.

Type the exclamation mark (!)
instead of the word NOT.

Use to find topics that contain one
term but not the other.

Type a term, followed by the carat
symbol (»), and then type another
term.

Use parentheses to combine
boolean phrases and search
terms.

Type parentheses ( ) around the
combined terms.

HTML

B[ HTMLS'
‘ x
x x
x 3
x

WebHelp

TIn HTMLS5, this is supported only with MadCap Search set as the search engine.

2This only works if you search for one term but not another (e.g., MadCap NOT Flare).

3The carat symbol (*) can be used interchangeably with an exclamation point (1) and

NOT.
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Asterisk (*) Wildcard Search

In the Microsoft HTML Help and WebHelp output types, end users can use the asterisk (*) wildcard
character with the search feature as detailed below.

Requirements and Dependencies

® Eclipse Help Asterisk (*) wildcard search is supported by the search engine that you configure
in the Eclipse platform. For details, see the Eclipse documentation at:

help.eclipse.org

® WebHelp For asterisk (*) wildcard search capabilities to be supported, you must enable the
partial-word search feature. See "Enabling Partial-Word Search" on page 153.

How to Search With the Asterisk (*) Wildcard

In the table below, a check mark shows the different ways you can use the asterisk (*) wildcard in
search. It also provides usage guidelines and examples.

HTML
Placement Usage Help WebHelp
Before a Place the asterisk (*) in front of a term to !
Term represent unknown characters.
Inside a Term  Place the asterisk (*) inside a term to represent p 4

unknown characters.

After a Term Place the asterisk (*) after a term to represent
unknown characters.

TIn Microsoft HTML Help, the asterisk (*) wildcard cannot be used in combination with
other characters and symbols. For example, instead of searching for * . doc, end users
must search for *doc.
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Partial-Word Search

The HTMLS5, WebHelp, and WebHelp Plus output types support partial-word searches in their target
outputs. This search method is similar to simple text search, only it allows users to search for
partial-word and number strings. This feature can be enabled in the Performance tab of the

Target Editor. See "Enabling Partial-Word Search" on page 153.

For Eclipse Help, partial-search is provided by the Eclipse platform.

How to Perform a Partial-Word Search

1. Inthe search field, type part of a word or number string.

For example, type cond.

NOTE The minimum number of characters that you can set for partial searches is 3.
See "Enabling Partial-Word Search" on page 153.

2. Press ENTER or click Search.

The system reveals a list of ranked topics that include matches for the entered search string.

3. Double-click a topic in the list to open it.

NOTE Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting"
on page 229.
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and "second."

Search for cond.

¥% EXAMPLE Search for cond.

As shown below, search retrieves topics containing the string "cond," such as "condition”

Thesfring "cond" is
foundin "Conditioning”

Fiter: {urfitered) -

Title: Rank File

Training a Pamrat 1

The Search pane shows
a ranked list of topics
containing the partial

word "cond."

1 I
/ W x Training a Parmot = ‘ l
cond - i, Help Topic Qo NBe 3% % "

Training a Parrot

It is important to give your parrot positive reinforcement. Conditioning is the process of helping your parrot
understand simple concepts. For example, making a clicking sound equals a treat. This creates an important bond

between pet and owner.

As the owner, you can use your communication link to express to the parrot what you want bird to do. You can then

mold the parrot's behavior and teach the bird unique tricks.

Third Time Owner

Time Owner

First Time Owner

How may parrots have W

you owned?

[ \

Thestring "cond"is
foundin "Second”
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¢ Search for 201,

Search for201. Then

As shown below, the search retrieves topics containing the number string "201," such as
2010,2011,2012,2013,2014,2015,0.201, and 0.0201.

The string "201" is

Welcome to 2010 Welcome htm

The Search pane shows
a ranked list of topics
that start with the
number string "201 "

press ENTER or foundin 2010.
ﬂ click Search.
» i @ x /[ elcometo 2010
201 - ¥, HelpTopic | & & 4 & |G % % -
Filter: {unfitered) 4 You are here: Welcoi §:
Title Rank File

Welcome to

Welcome to 2010. Here is a look ahead at future years:

@ 20

@ 2012

"] 2013?
@ 2014

@ 2015

ltis also found in
2011, 2013, 2013,
2014 and 2015.

Here is a list of numbers:

@ 0201

@ 0.0201

Itis also found in
0.201 and 0.0201.

@ 0.02.01
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I End User Search Features

The table below summarizes the key search features and capabilities for each output type. With
HTMLS and WebHelp outputs, you can distribute either client- or server-based outputs. This is why
the table below lists them twice—under client- and server-based output.

HTMLS5 (Client) HTML5 (Server)  HTML Help

Glossary Search (Find Matching
Terms)

Index Search (Find Matching Terms)

Predictive Search X
See "Setting Up a Search Engine” on

page 50.

Search Favorites (Save Queries to e x X

Favorites List)

Search Query (Asterisk (*) Wildcard by X
Character)
Search Query (Boolean Operators) % 1

See "Search Methods and Syntax" on
page 27.

Search Query (Full-text Search—not
case sensitive)

See "Search Methods and Syntax" on
page 27/.
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HTML5 (Client)

Search Query (Enclose Terms in
Quotes)

See "Search Methods and Syntax" on
page 27.

Search Results (Narrow Search 2
Scope Using Search Filter Sets)

See "Search Filter Set Example" on
page 224.

Search Results (Results Listed in 3
Ranked Order and Show Rank
Number)

See "Optimizing Search" on page 171.

Search Results (Search Hits
Highlighted in Topics)

See "Search Highlighting" on page
229.

Search Results (Search Hits
Bolded)

1Select the operator from the built-in list.

2Search filters are not supported in Elasticsearch.

3Results are listed in order. Rank number is not visible.
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| Content Developer Search Options

This table summarizes the key search features and capabilities that are available to you, the
content developer, for each output type. With HTML5 and WebHelp outputs, you can distribute
either client- or server-based outputs. This is why the table below lists them twice—under client-
and server-based output.

HTMLS

HTML5 (Client)  (Server) HTML Help
Enable 1 1 2
"Including Search Bars" on page 44
Content Optimization 3 X X
"Setting the Search Abstract
Character Limit" on page 140
Content Optimization 3 X X
"Setting Search Result Importance’
on page 149
Content Optimization 3 X
"Including Glossary Terms in
Search Results" on page 156
Content Optimization 3 3 %
'Setting the Number of Search
Results Per Page" on page 138
"Elasticsearch" on page 63 b4
"Google Search” on page 131 4 % %
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HTMLS5 (Client)

HTMLS
(Server)

HTML Help

Micro Content Search Integration v'?

"Setting Micro Content Containers”
on page 155

Vfﬂi

x

Search Highlighting v

"Customizing the Highlight Color
for Search Hits" on page 232

Search Optimization v

"Enabling Partial-Word Search" on
page 153

Search Optimization v

"Including Stop Words in Search"
on page 142

vl"ﬁ

Search Optimization v

"Excluding Index Entries From
Search" on page 161

Vi"'ﬁ

Search Optimization v

"Excluding Non-Words From
Search" on page 160

V,f?

Search Optimization v

"Setting the N-Gram Size for
Search" on page 167
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HTMLS

HTMLS (Client)  (Server) HTML Help
Search Performance v v X
"Chunking Large Search Database
Files" on page 163
Search Performance v v Y4
"Pre-Merging Search Database
Files" on page 162
Search Results v v X
"Customizing Search Filter
Ordering" on page 221
Search Toolbar % pee Y4

Web Toolbars in WebHelp Outputs

CHAPTER 2
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HTMLS
HTML5 (Client)  (Server) HTML Help
Styles 4 3 %

Styles for Generated Pages

THTML5 skin.
2Standard skin.

3This is supported if you are using Elasticsearch or MadCap Search, but not
Google Search.

4This is supported only in HTML5 Side Navigation, Top Navigation, and skinless
outputs. It is not supported in HTMLS5 Tripane output.

SStop words are always enabled.
6|ndex entries are always excluded.
/Non-words are always excluded.

83QL Server Compact is required.
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CHAPTER 3

Including Search Bars

The first step in making search accessible in your online documentation is to include a search bar.

HTMLS output is designed to show a search bar at the top of all topics via the skin. You just need to
make sure this option is enabled, which is the default setting. Therefore, you might not need to do
anything.

However, you might want to insert a search bar elsewhere (e.g., in the middle of your Home page).
In this case, you would need to use a Search Bar proxy. You might also need to hide the search bar
from some topics so that you do not have two search bars on a page.

This chapter discusses the following:

How to Enable the Search Barinan HTMLS Skin .............................. 45
How to Insert a Custom Search Bar ... 46
How to Hide the Search Bar From All TOPICS ... 47
How to Hide the Search Bar From a Single Topic ............................. 48
How to Enable Search in a Skin for Other Output Types .................... 49
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I How to Enable the Search Bar in an
HTML5 Skin

1. From the Project Organizer, open the HTML5 skin.
. Select the Styles tab.

2
3. Inthe Header section, expand Search Bar.
4. Expand Layout.

5

. Inthe Display field, make sure block is selected.

6. CIicklE' to save your work.
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I How to Insert a Custom Search Bar

1. Open a template page or topic, depending on whether you want the search bar to be show on
many pages or only one page.

2. Place your cursor where you want the search bar to be shown in the output.
3. Select Insert > Proxy > Insert Search Bar Proxy. The Search Bar Proxy dialog opens.

4. If you have added a Search Bar skin component to your project and want to use it to control
the look of the search bar, you can select it from the Skin File field.

If you do not select a Search Bar skin component in this field, Flare Desktop uses the first one
it finds in your project (if one exists). Otherwise, Flare Desktop provides a default design.

NOTE The Search Bar proxy and skin component are not supported in HTML5
Tripane output.

5. Click OK. The proxy is added.

6. CIicklE' to save your work.
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| How to Hide the Search Bar From All
Topics
1. From the Project Organizer, open the HTML5 skin.
2. Select the Styles tab.
3. Inthe Header section, expand Search Bar.
4. Expand Layout.
5. Inthe Display field, select none.

6. CIicklE' to save your work.

CHAPTER 3

47



I How to Hide the Search Bar From a
Slngle Topic

. Assuming you are already using a primary stylesheet for all topics, make sure the option to
Allow local stylesheets is selected.

2. Create a new stylesheet to be used for the topic where you want to hide the search bar.

3. Open the new stylesheet in the Internal Text Editor (i.e., in the Content Explorer, right-click it
and select Open with > Internal Text Editor). Then, copy and paste the following into it.

.nav-search

display: none;

4. Click[&l to save your work.

5. Associate the topic with the new stylesheet.

CHAPTER 3 48



I How to Enable Search in a Skin for
Other Output Types

HTML Help, WebHelp, and WebHelp Plus are not as commonly used as HTML5. However, if you are
using one of these outputs, you can enable search as follows.

1.

2
3.
4

From the Project Organizer, open the Standard skin.

. Select the General tab.

In the Features list, click the Search check box.

. (Optional) If you are creating Microsoft HTML Help, you can include advanced search

options. To enable or disable these options, open the skin. In the Skin Editor, click the HTML
Help Setup tab, then place a check in the Show Advanced

Search box.

CIicklE' to save your work.
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CHAPTER 4

Setting Up a Search Engine

Supported In:

HTML

For HTMLS5 targets, you can choose the type of search engine you want people to use—MadCap
Search, Google Search, or Elasticsearch (for Side Navigation, Top Navigation, or skinless output).
There are additional steps that you can follow and features you can select, depending on the search
engine you choose. For MadCap Search and Elasticsearch, you can include micro content in the
output, which can especially enhance your search results.

This chapter discusses the following:

Comparison of Search Engine Options ... 51
MadCap Search ... 57
Elasticsearch ...l 63
GOOGle SEAICN .. 131
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I Comparison of Search Engine Options

There are benefits to any of the search methods offered by Flare Desktop. Some users might prefer
the search results returned by Google. However, others might prefer the results returned by
MadCap. Or some users might want all of the configurable options provided by Elasticsearch.

TIP To determine the type of search that is best for you, we recommend that you generate
different outputs using each method. Then perform several different searches and see
which results you like best.

Less Time and
Effort to Set Up

Public vs. Local
Output Flexibility

CHAPTER 4

MadCap Search

Setting up MadCap
Search in a Flare
project takes only a
few seconds.

Output can be
searched whether it is
available publicly or
locally.

Elasticsearch

Setting up
Elasticsearch is done
within the Target
Editor and Destination
Editor in Flare
Desktop. Web servers
also need to be
configured to support
Flare Desktop, along
with the Elasticsearch
service.

Output must be
published on a server
in order to use the full
capability of
Elasticsearch.

Google Search

Setting up a Google
custom search engine
(CSE) and performing
other necessary tasks
requires a
combination of steps
in both Google and
Flare Desktop. This
can take a bit of time
to complete.
However, it is usually
just a one-time setup.

Output must be
available publicly so
that you can use
Google. Output
cannot be behind a
firewall.
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Multiple Outputs

Other File Types

Search Tailored to
Flare Projects

CHAPTER 4

MadCap Search

Searches will include
results for only the
Flare output that is
open.

In order to include file
types such as PDF in
your search results,
you need to generate
and publish server-
based output.

MadCap Search
rankings are
specifically tailored
for Flare users. They
take into account not
only H1-H6 headings,
but also index
keywords, glossary
terms, etc. See
"Ranking Search
Results" on page 204.

Elasticsearch

You can manage
multiple HTML5
targets that use
Elasticsearch through
the Content Services
Portal.

Most file types are
included in the search
results.

Elasticsearch does
not provide any direct
mapping of search
criteria to the
structure of a Flare
project.

Google Search

You can add
multiple folders/sites
to be included in your
Google custom
search engine (CSE).
Each of these sites
can be a separately
published Flare
output. When users
search from one of
the published Flare
outputs, results will
display for all of the
outputs.

If you have added
other types of files
(e.g., PDF) to the site
(s) associated with
your CSE, they may be
included in search
results.

Google does not
recognize the unique
characteristics of a
Flare project (e.qg.,
index keywords,
glossaries).
Therefore, those
elements will have no
effect on how Google
ranks pages in the
results.
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Micro Content in
Results

Glossary
Definitions in
Results

Results for
Incorrectly Typed
Searches

CHAPTER 4

MadCap Search

MadCap Search
lets you include micro
content in your search
results, which can
especially improve the
experience for users.

MadCap Search
will fetch your
project’s glossary
terms and feature
them at the top of
search results.

Incorrectly typed
search terms will not
return results.

Elasticsearch

Elasticsearch lets
you include micro
content in your search
results, which can
especially improve the
experience for users.

Elasticsearch does
not provide an option
to include glossary
terms in your search
results.

The partial-word
search and fuzzy
match settings allow
for numerous
searches to be
returned when these
settings are enabled.

Google Search

Google does not
include micro content
(created in Flare
Desktop) in your
search results.

Google will not fetch
your project’s
glossary terms and
feature them at the
top of search results.

If an end user
incorrectly enters a
search term (e.g.,
types “Thle” instead of
“Table”), Google will
often guess the
correct term and
show results anyway.
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Better Search and
Indexing Speed

Mobile Devices

CHAPTER 4

MadCap Search

Search results
might be faster
because the output is
immediately indexed
once it is generated.
You do not need to
spend any extra time
indexing your pages
or waiting for search
results to appear.

Search results are
“‘chunked” and then
collapsed so that they
can be displayed
when a search is
performed. This is
usually okay on PCs,
but if you try to
perform a search on a
mobile device, the
results might be slow
or even crash
because the device
cannot handle the
number of search
results.

Elasticsearch

The administrator
portal allows for the
search indexes to be
managed closely.
This will assist in
keeping search result
times optimal.

Search results
always come from a
server, so you do not
need to be concerned
about the ability of the
mobile device to
handle the
information.

Google Search

Search results might
lag at times,
depending on the size
of the output and
whether Google is
finished with the
indexing (i.e., making
your output available
for searches).

Google will index your
pages automatically
over time, but it can
take awhile,
sometimes weeks.

Search results
always come from a
server, so you do not
need to be concerned
about the ability of the
mobile device to
handle the
information.
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No
Advertisements

Customize Auto-
Complete Results

Customize
Predictive Search

CHAPTER 4

MadCap Search

No advertisements
are included in search
results.

There are no options
available for auto-
complete results.

MadCap Search does
not offer any
predictive methods in
obtaining search
results.

Elasticsearch

No advertisements
are included in search
results.

You can enable
multiple options to
include a mix of
personal and global
searches on your
output. Thereis also
an option to include
project content
information such as
topic titles and the file
path in your project.

There are multiple
options that allow you
to obtain predictive
results when
searching, especially
when using auto-
complete options.

Google Search

Users might see
advertisements in
search results.

While Google Search
does provide auto-
complete results, it
does not provide the
ability to customize
these results.

Google Search
provides a measure of
predictive results,
although it is not
customizable within
Flare Desktop.
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NOTE Google Search is not supported for HTML5 Tripane output.

NOTE For MadCap Search, the look of the search bar and results can be customized

through these skins and components: Top Navigation skin, Side Navigation skin, Search
Bar skin component, and Search Results skin component. However, with Google Search,
any changes in these skins are not supported. Instead, the look is controlled via Google.

NOTE Keep in mind that the exact steps in Google may change over time as the user
interface is adjusted.

CHAPTER 4
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| MadCap Search

Supported In:

HTML

MadCap Search is Flare Desktop's built-in search engine. When an HTML5 target is created, it is set
by default to use this search engine. MadCap Search considers heading styles, index keywords,
glossary terms, and more when ranking regular search results, and it considers phrases and
alternate phrases when ranking micro content. You can customize the search engine by setting
options such as search result importance, glossary terms in the results, number of search results
per page, and abstract character limit.

How to Set Up a MadCap Search Engine

1. Open an HTMLS target.

2. Select the Search tab.

w

. From the Search Engine field, select MadCap Search.

4. You can complete various options to optimize the search, then C|iCk|E| to save your work.

Search Results

Results per page You can change the number of search results that appear on each page.
This makes it easier to navigate between pages of search results and
improves loading times, especially for users who access output from a
mobile device. Setting a reasonable number of results per page also
makes it easier for search indexing services (i.e., spiders, crawlers, or
bots) to locate pages in output, improving search results. See "Setting the
Number of Search Results Per Page" on page 138.
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Abstract character In HTMLS5 output, you can set a character limit for automatically

limit generated abstracts that appear in your search results. This allows your
users to see a brief summary of each topic in the search results, while
keeping the search results page easy to scan. You can set the character
limit as long or as short as you like. When creating an automatic abstract,
Flare Desktop scans all text elements in the topic, including headings and
paragraphs, and includes them in the abstract until the character limit is
met. See "Setting the Search Abstract Character Limit" on page 140.

Partial word This allows part of a word to be searched in the target database. For
searching example, the string "sear" could return results for "search." The Minimum
word size field can be set from 3-10.

NOTE Enabling this setting could increase the build time and the
size of the search index for your target.

Advanced Search Options

Include Importance  In HTMLS5 output, the Flare search engine uses a combination of factors

(recommended) to rank search results. The search engine considers the number of links
to a topic (Importance) and the number of times a search term appears
in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each
topic. This is not recommended unless you have one topic that is linked
too many times that it would skew your search results. See "Setting
Search Result Importance” on page 149.

Include glossary For HTML5 output, search results display glossary terms if they are used

results as the search text. This option to display glossary terms in search results
is enabled by default. However, it can be turned off in the HTML5 Target
Editor. See "Including Glossary Terms in Search Results" on page 156.
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Exclude non-words
from search

Exclude index
entries from
search

Pre-merge search
database file

Chunk large search
database file

CHAPTER 4

If you have a project that contains a lot of content that is not composed
of regular letters and numbers (e.g., angled brackets), you can set your

target to avoid these "non-words" when users perform a search in your

Help system. This will improve the search performance that your users

experience. See "Excluding Non-Words From Search" on page 160.

If you insert index markers in your project, those markers by default are
included in searches that users perform in your output. If you want to
exclude index entries from searches, you can do so. See "Excluding Index
Entries From Search” on page 161.

If you have multiple projects whose outputs are set to be merged when
you build the parent project, you can pre-merge search database files. If
you select to pre-merge the search database file, you disable runtime
merging, which means that you cannot compile and publish a "sub-
project” later. You must generate and publish all linked Help systems at
the same time. Selecting this option may slow down the generation of
the output, but it will significantly increase the speed with which the
output loads for the end user.

You can control the size of "chunks" used when generating the search
database files for a target. After you choose this option, select the
number of bytes for each chunk. The chunk size affects the speed that a
Help system loads for a user. Depending on the internet connection,
different results will be seen. The smaller the chunk size, the greater the
number of chunks that will be sent. A large number of chunks may result
in a slower speed, especially if you have many merged "sub-projects" and
the index is being merged. Chunking may slow down the generation of
your output somewhat, but it increases the speed that the output loads
for end users. For best results, you should test the different chunk sizes.
Click the drop-down next to the Maximum chunk size field to set the
maximum size of your search database file.
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N-gram size

CHAPTER 4

You can adjust the n-grams, which are character chunks used to
separate words in Chinese, Japanese, and Korean projects. Chinese,
Japanese, and Korean languages do not have spaces as word
boundaries, so n-grams are used to separate the words. Smaller n-gram
values produce smaller search database file sizes. They also lead to
more search results, which may be less accurate. On the other hand,
larger n-gram values produce larger search database file sizes. They also
lead to fewer search results, which may be more accurate. The default
size in this field is optimal for most situations.
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Featured Snippets

Filter

Limit number of
results

CHAPTER 4

Select to control which pieces of micro content to include for the
featured snippets area.

® Do not include in search results No micro content is included in the
featured snippets area.

= All micro content files Every phrase from all of your micro content
files may be included.

= Specific micro content files In the drop-down(s), choose one or
more micro content files. Every phrase from those files may be
included.

Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values. Micro
content phrases that match may be included.

Control the maximum number of micro content responses that are
allowed to display in the featured snippets area. If you leave it set at 1,
Flare Desktop displays only the best match from your micro content file
(s); if you enter 3, Flare Desktop displays up to the best three matches (if
that many exist).

61



Knowledge Panel

Filter

Limit number of
results

Sitemap

Generate sitemap

Web URL

CHAPTER 4

Select to control which pieces of micro content to include the Knowledge
Panel.

® Do not include in search results No micro content is included in the
Knowledge Panel area.

= All micro content files Every phrase from all of your micro content
files may be included.

= Specific micro content files In the drop-down(s), choose one or
more micro content files. Every phrase from those files may be
included.

Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values. Micro
content phrases that match may be included.

Control the maximum number of micro content responses that are
allowed to display in the Knowledge Panel. If you leave it set at 1, Flare
Desktop displays only the best match from your micro content file(s); if
you enter 3, Flare Desktop displays up to the best three matches (if that
many exist).

For web-based targets, you can generate a sitemap when compiling your
output. This helps with search engine optimization (SEO), making it
easier for search indexing services (i.e., spiders, crawlers, or bots) to find
your output. Therefore, the entire output is indexed and search engine
results are improved. See "Generating Sitemaps" on page 169.

This is the URL used for your published output.
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| Elasticsearch

Supported In:

HTML

Elasticsearch is a powerful search engine that provides numerous unique, configurable options,
including "fuzzy matching” (i.e., matching similar words), predictive search, and auto-completion.

Elasticsearch is enabled by two web services, one used by Flare Desktop and the other used by

Elasticsearch. The Elasticsearch web service runs a portal that lets you manage the targets, topics,
and indexes employed by the Elasticsearch engine in your server-based HTMLS target.

This example of Elasticsearch uses partial-word
searching and auto-complete features.
Elasticsearch combines multiple facets of the
available options for this search engine to provide
more accurate and predictive search results.

When you enter the string "glo,"
notice that the drop-down
displays results for glossary,
glossares, and global toolbars.

The Elasticsearch method will display results
in the drop-down for phrases that contain
your search criteria, regardless of where your

-~
gl

search string resides in the file name.

| OPENING A

| AB O*GSSARIES - FLARE/GLOSSARIES/ABOUT-GLOSSARIES. HTM

= @AL TOOLBARS - FLARE/INTERFACE/GLOBAL-TOOLBARS.HTM

GLO

ESARY - FLARE/GLOSSARIES/MORE/OPENING-GLOSSARY.HTM

| ADDING A G‘GARY FILE - FLARE/GLOSSARIES/MORE/ADDING-GLOSSARY.HTM
| EDITING GLOSSARIES - FLARE/GLOSSARIES/MORE/EDITING-GLOSSARIES.HTM

= IMPORTING GLOSSARIES - FLARE/GLOSSARIES/MORE/IMPORTING-GLOSSARIES.HTM
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Process

1. 'Installing Elasticsearch on a Remote Server" on page 70

2. "Enabling Elasticsearch in the Target Editor" on page 102
3. "Creating Destination Files for Elasticsearch" on page 110
4. "Associating Elasticsearch Destinations With a Target" on page 112
5. Generating and Testing Output—"MadCap Process Manager" on page 113
6. Managing Size of Search Indexes—"Content Services Portal" on page 114
7. (Optional/Periodic) "Upgrading Elasticsearch and Content Services on a Remote Server" on
page 122
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¢ EXAMPLE Bob wants to use Elasticsearch with his HTML5 output.

First, he sends his network administrator the steps for setting up an Elasticsearch remote
server.

After the network administrator finishes setting up the server, she sends Bob the URL for it.
In this case, let's say the URL is:

https://ourelasticsearchservices.fictionsoft.com

Bob opens his HTMLS5 target, selects the Search tab, and chooses Elasticsearch as the
search engine type.

Target Editor | 73 Build ) View - /& Publish | Open Build Log

-

General Search Engine
Skin Type: Elasticsearch w
elLearning
Search Results
Conditional Tet¢ Results per page: /=
Variables Fragments per result: 1=
Publishing Fragment character limit: 300 =

Glossary [ indude stop-words in search

Partial word chi '
Relationship Table [] Partial word searching

Minimum word size:
Search
@ Advanced Search Options

Meta Tags

4

Advanced Auto-complete Results

| ]

He also decides which Elasticsearch options on that tab he wants to use and sets them
accordingly.
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send his output.

% Next, Bob creates a primary publishing destination. This is the destination where he will

FEEEEECIE

=] Project
|1 | Advanced
||| Conditional Text

|| Destinations
9 Primary-Destination

Exports
Glossaries

[

Imports
Reports
Skins
Targets
TOCs
Variables

COCEEDEE

Destinations Date modified: 4/27/2018 10:32:28 AM
File folder

§  Primary-Destination x HTMLS - Top Navigation K Start Page 3
Destination Editor
e ——
General Type:
FTP ~
Server
Host Mame: Port: Connection Mode:

>

~ ‘ I:l Passive

|ﬁ:p.myf'q:server .com

Destination

Directory: Comment:

[public_ntmi v This is my publish
destination

Credentials

Login Credentials. .. [ anonymous Login

Please set cedentials
View
Wiew URL:

|ht‘b:u:,ffwu\'vn'.madcapsuf‘tware‘:um,i' w

Upload

Upload Log File
Upload Only Changed Files
Remove Stale Files

help.fictionsoft.com/myoutput/

Let's say Bob needs to upload his output to this location:
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% One option is that Bob could use file transfer protocol (FTP) to copy his output directly up
to the server where his output will be hosted. But suppose Bob prefers to use a third-party
tool (say, FileZilla) to transfer his output files to the server. In that case, Bob chooses File
System as the type, and for the directory he selects a folder that he created in his
Documents folder.

Destination Editor

General Type:

File System w

Destination

Directory: Comment:

|C:Wsers\bob¥pocumentswly HTMLS Cutput R This iz my publish
destination

View
View LURL:

|htn3:,.'fwww.madcapsoftware.com,.’ o

Upload

Upload Log File
Upload Only Changed Files
Remove Stale Files

Now Bob creates an Elasticsearch destination file. In this file, he chooses Elasticsearch as
the type, and he enters the URL that his network administrator gave him
(https://ourelasticsearchservices.fictionsoft.com).

;ID © i / @ Elasticsearch-Destination* kL Primary-Destination HTMLS - Top Navigation *
] Project Destination Editer
Advanced

] Conditional Text T

v Destinations General Type:

| 9 Elasticsearch-Destination | Elasticsearch ~

Pni -Destinat
Y Ex rr;mary sshnation Search Destination URL
ports

Glossaries

|ht|ps: [fourelasticsearchservices. fictionsoft.com

] Imports
[ Reports
[ Skins
Targets
TOCs
Variables
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ﬁ Next, Bob returns to his target and opens the Publishing tab. In this tab, he places a check
mark next to his primary destination. Then in the Elasticsearch Destination cell, he chooses
the other destination file.

Target Editor | [ Build 5 View ~ [ Publish |, Open Build Log

General Destinations

Skin Edit Destination Mew Destination... View Published Help System
eLearning Destination ~ Publish  Target Elasticsearch Destination View URL
Conditional Ted Primary-Destination - TN TIT LS D S U Elasticsearch-Destination

R Glossary
After saving all his changes, Bob builds the target. When that is done, he clicks the Publish

button in the Target Editor, which copies the output files to the local folder he set up in his
Documents directory.

Finally, Bob uses his third-party tool to transfer the output files from that Documents folder
up to their final destination (help.fictionsoft.com/myoutput/). When users access that
output, the search function will be using Elasticsearch features. (If Bob decided to use FTP
or SFTP, the output would transfer directly to the server, and using the third-party tool
would not be necessary.)

NOTE Synonyms are not supported in Elasticsearch.

NOTE Elasticsearch is not supported for outputs built on MadCap Flare Online. However,
you can publish directly from Flare Desktop to Flare Online via a destination and
Elasticsearch will be supported.

NOTE Search filters are not supported in Elasticsearch.
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NOTE Multilingual Elasticsearch publishing requires all targets to use the same GUID. This
is set on the Search tab of the Target Editor. If the GUIDs in the targets are different, you
might have empty targets on the portal or experience a publishing failing with error 400. If
necessary, open targets in the Internal Text Editor to modify the GUID.
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Installing Elasticsearch on a Remote Server

Information for Network Administrators

Before you can publish HTMLS output to use Elasticsearch, you must have a remote server
configured to run the Elasticsearch service as well as the Content Services web application. The
Elasticsearch service is required to perform searches from the indexed search data. The Content
Services Portal is provided as a central location to manage the search data published from Flare
Desktop.

NOTE Please be aware that setting up a remote server for Elasticsearch can be a lengthy
process. The procedure typically requires administrator permissions. If you are unfamiliar
with how to install a web server, it is highly recommended to contact your Network
Administrator for assistance.

Prerequisites for Elasticsearch

The following prerequisites for Elasticsearch are only necessary if you do not already have the
programs on your computer. Go through each section to confirm you have all the programs and
correct options set, and then follow the given procedures if anything is missing.

NOTE When setting up a computer as a remote server, you can use a Windows Server
operating system (e.g., Windows Server 2016), or a regular Windows operating system
(e.g., Windows 10). Which system you use depends on your needs. A Windows Server is
often used in business settings.
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Prerequisite

Operating System With Internet Connection

.NET Framework 4.6 or newer

ASP .NET

[IS Web Server

.NET 6.0.13 Windows Hosting Bundle

Java SE Development Kit

CHAPTER 4

Description

Make sure your operating system is updated
with the latest service packs, critical patches,
and security updates from Microsoft.

This is the software development framework
for building and running applications on
Windows. The minimum required .NET
Framework version required is 4.6. It also
works with newer versions of NET
Framework.

ASP.NET is part of NET Framework (it does
not require a separate install from .NET).
ASP.NET is the web application framework for
building dynamic web pages.This feature gets
“turned on” in Windows.

Microsoft Internet Information Services (IIS) is
a web service role that is enabled in the
operating system to give the system its web
server capabilities. IIS must be installed on the
computer that will act as your Elasticsearch
web server. The minimum version required is
[IS 6. Newer versions work as well.

Microsoft .NET Core is used to create server
applications that run on Windows, Linux, and
Mac.

You can install a paid Oracle (JDK) Java SE
Development Kit, or a free Open JDK Java 1.8
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NOTE For details about supported operating systems and hardware requirements for

Microsoft programs, refer to Microsoft documentation for downloads. See the following:

https://www.microsoft.com/en-us/download/windows.aspx

NOTE The following procedures use Windows 10. Be advised that some user interfaces
might vary slightly depending on the operating system you are using.
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How to Determine if Programs are on the Computer

1. Open the Control Panel.
2. Select Programs and Features.

3. Compare the listed applications with the required programs (e.g., Microsoft NET Core 6.0.13
Windows Server Hosting). If programs for a remote server are missing, you may have to add

them.
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How to Install .NET Framework

It is necessary to install NET Framework to run certain applications on Windows that were created
with it. However, many versions of Windows already include .NET Framework.

NOTE It is important to install NET Framework before installing the IS web server.

1. Inabrowser, navigate to:

https://dotnet.microsoft.com/download/dotnet-framework

2. Locate the .NET Framework version, and click the link to download the runtime installer. You
can choose to install version 4.6 or newer.

3. In Microsoft's configuration dialog, follow the installation wizard.

NOTE If you are installing on a Windows Server operating system, you can use the Server
Manager to enable .NET Framework features. See "How to Set Roles and Features With the
Server Manager on Windows Server" on page 76.

CHAPTER 4 74



Installing Internet Information Services

The Microsoft Internet Information Services (1IS) gives the system its web server capabilities. If the
server that will act as your Elasticsearch web server does not yet have IIS, find the download on the
Microsoft website and install it.

NOTE Since newer versions of Windows come with IIS, check to see if IIS is already on
your computer. It might be installed, but you just have to enable it via the Control Panel
(Turn Windows features on or off). If you want a newer version, then you might have to
download and install it.

NOTE If working with a Windows Server operating system, the Server Manager program is
available to you to manage and configure web server roles and features (see "How to Set
Roles and Features With the Server Manager on Windows Server" on the next page). If you
are working with a regular Windows operating system, use the Windows Feature dialog to
manage and configure web server roles and features for NET and IIS (see "How to Set
Roles and Features With Windows Desktop" on page 78).
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How to Set Roles and Features With the Server Manager on Windows
Server

To enable roles and features on a Windows Server, you can do so via the Server Manager.

1.
2.
3.

From the Windows Server operating system, open the Server Manager.
From the Manage menu, select Add roles and features. Click Next.

In the Add Roles and Features wizard, select Role based or feature based installation. Click
Next.

Choose Select a server from the server pool. Click Next.
Scroll down in the Server Roles list and select Web Server (IIS). Click Next.

In the Features list, expand and select .NET Framework 4.x Advanced Services, and then
select ASP .NET 4.x.

In the Role Services list, select the following under Web Server (IIS):
" Web Server
e Common HTTP Features
o Static Content
o Default Document
o Directory Browsing
o HTTP Errors
e Security
o Request Filtering
° Basic Authentication
° Windows Authentication
» Application Development
o .NET Extensibility 4.x
° |ISAPI Extensions
° ISAPI Filters
o ASP .NET 4.x
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e Health and Diagnostics
o HTTP Logging
» Performance
o Static Content Compression
® Tools Management
* |IS Management Console
» IS 6 Management Capability
° ]IS Metabase and IIS 6 Configuration Compatibility

8. Click Next through to the screen with the Install button enabled, then click Install.
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How to Set Roles and Features With Windows Desktop

To enable roles and features on a regular Windows desktop to set it up as a remote server, you can
do so via the Windows Feature, Control Panel app.

1. Inthe Windows Search bar, type turn on windows.

2. Click the resulting item, Turn Windows features on or off. The Windows Features dialog
opens.

3. Expand .NET Framework 4.x Advanced Services (the version number may vary depending on
the original installation and updates).

4. Select the ASP.NET 4.x check box.

. ndows Features - O

Turn Windows features on or off [ 7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on,

(m] | .METFramework 3.5 (includes MET 2.0 and 3.0) ~
= [m] | .MET Framewaork 4.8 Advanced Services
ASP.MET 4.8

WCF Services

Active Directory Lightweight Directory Services
Containers

m| [%]

Data Center Bridging

OO000

Device Lockdown

=

5. Expand Internet Information Services.

6. Expand Web Management Tools, and select [IS Management Console.
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7. Expand the IS 6 Management Compatibility folder, and select |IS Metabase and 1IS 6
configuration compatibility (the version number may vary depending on original installation
and updates).

[

Turn Windows features on or off [ 7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. Afilled box means that only part of the feature is turned on.

= [m] | Internet Information Services #
[] | FTP Server
= W | Web Management Tools
= @ | 156 Management Compatibility
[] 1156 Management Console
(]  lIS6 Scripting Tools
] | 1156 WMI Compatibility
15 Metabase and 115 & configuration compatibility
15 Managernent Conscle
L] 1S Management Scripts and Tools
] IS Management Service v

8. Expand World Wide Web Services, and expand the Application Development Features folder.
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9. Select items .NET Extensibility 4.x, ASP.NET 4.x, ISAPI Extensions, and ISAPI Filters.

a2
Turn Windows features on or off e

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

o [m | World Wide Web Services A
= [ | Application Development Features
[/ | .NET Extensibility 3.5
MET Extensibility 4.8
[]  Application Initialization
[] | Asp
[] | ASP.MET3.5
ASP.MET4.8
] Cal
ISAP| Extensions
|54P1 Filters
[] | Server-Side Includes
[] | WebSocket Protocol

— - b b—

10. Expand the Common HTTP Features folder.

CHAPTER 4



11. Select items Default Document, Directory Browsing, HTTP Errors, and Static Content.

&
Turn Windows features on or off [ 7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. Afilled box means that only part of the feature is turned on.

= m | World Wide Web Services A
m]  Application Development Features
= [m | Commen HTTP Features

Default Docurment

Directory Browsing

HTTP Errors

HTTP Redirection

Static Content

WebDAV Publishing W

12. Expand the Health and Diagnostics folder, and select HTTP Logging.

ORIORIEE

&
Turn Windows features on or off 7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

= W | World Wide Web Services ~
] | Application Developrment Features
@] | Cormmon HTTP Features
= [m] | Health and Diagnostics

Custom Logging

HTTP Legging

Legging Tools

ODBC Logging

Regquest Monitor

OO0 R U

Tracing v

Cancel
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13. Expand the Performance Features folder, and select Static Content Compression.

a2
Turn Windows features on or off e

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

o [m | World Wide Web Services A
W]  Application Development Features
[m] Common HTTP Features
(W] | Health and Diagnostics
= [m] Performance Features
[l  Dynamic Content Compression
Static Content Compression W

14. Expand the Security folder.

15. Select items Basic Authentication, Request Filtering, and Windows Authentication.

=

Turn Windows features on or off 7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

= [m] Security A
Basic Authentication

Centralized 551 Certificate Support

Client Certificate Mapping Authentication

Digest Authentication

115 Client Certificate Mapping Authentication

IP Security

Request Filtering

URL Authorization

Windows Authentication W

Cancel

RORMOOOO0OE

16. Click OK. The installation begins.

17. At the Windows completion message, click Close.
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Optional—How to Verify IS Installation

Verifying the installation of IS is not necessary to do, but it might provide peace of mind that it got

installed correctly.

1. From the Windows Search bar, type 11s.

2. Click the resulting item, Internet Information Services (IIS) Manager app. The IIS Manager
opens, and should look similar to the image below. When you install IIS for the first time, a

"Default Web Site" is automatically created.

Ready

'@j Internet Information Services (1IS) Manager — [m} >
o =
€« = €3 & @
File  View Help
Connections ‘i‘ Actions
;! Manage Server
[CE] 2 Res
v X — = FRestart
: Filter: - Go - \ggShowAll | G by: - [E&] -
3 Application Pools ten ¥ bo % o roup by: Area P Start
~ -6 Site;ef — ASP.NET . _ A2 m step
| > -iii ault Web oite | t= > A | [ —]
’*i \\2 0 L‘? =  Application Pools
NET NET NET Error NET MNETTrust  Application View Sites
Authorizat..., Compilation Pages Globalization Levels Settings Doy (a)
) Els = : g Smmr—
ab) =S (3?) . 4 Export Server Package...
A = — B2 i C
N Import Server or Site Package...
Connection Machine Key Pages and Providers  Session State SMTP E-mail a’ bl bl L ST
Strings Controls Change .NET Framework
Version
lis B ~ o Get New Web Platform
%’!) % ] ‘,#j Components
/ ) @ a 4= @ Hep
Authentic... Compression  Default Directory  Error Pages Handler
Document  Browsing Mappings
EY, f - .
€ & ¢ 8§ = M
HTTP ISAPI and  |SAPIFilters  Logging  MIME Types  Modules
Respen...  CGl Restri..
3 = %
i" = o= Lugh” @ty
Qutput Request Server Worker
Caching Filtering Certificates  Processes
Management ~
—
B & [E
Sy
Configurat... Feature Shared
Editar Delegation  Configurat... w
[ Festures View ] 2 Content View

hE
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3. Open a web browser, and in the URL field type 1ocalhost. The default IIS web page
displays.

&« C | @ localhost

=R Windows

Internet Information Services

Welcome Bienvenue Tervetuloa

£3c% Benvenuto gl

E & b.. Bienvenido Hos geldiniz | o'xan oomna Welkom

Bem-vindo ‘ )
KoAwg
Vitejte Oploate

Microsoft Willkommen [Melkommen -

What's Next?

"Configuring the Web Server" on the next page.
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Configuring the Web Server

At this point, NET Framework and IIS are installed for the Elasticsearch engine. A couple more
programs are needed for the server, and a new system environment variable. Go through each
section to confirm you have all the programs and correct options set, and then follow the given

procedures if anything is missing.

How to Install .NET Core

The Microsoft .NET Core 8.0 Windows Hosting Bundle is needed for apps to run behind the IIS. This
Windows Hosting Bundle should be installed after IIS is installed.

1. Install the Microsoft .NET Core 8.0 Windows Hosting Bundle from the following link.

https://dotnet.microsoft.com/en-us/download/dotnet/8.0

@ N(I WSO LA B lthe downloads page for more options.

~ 8.0.25

Relesse notes  Latest release date March 10, 2026

Build apps - SDK @

SDK 8.0.419

0s Installers Binaries

Linux Package manager instructions Arm32 | Arm32 Alpine | Arm64 |
Arme4 Alpine | x64 | x64 Alpine

mac0s Arm64 | x64 Arm64 | x64

Windows x64 | x86 | Arm64 | x64 | x86 | Armb4

winget instructions

All dotnet-install scripts

Included runtimes
.NET Runtime 8.0.25
ASP.NET Core Runtime 8.0.25
.NET Desktop Runtime 8.0.25

Install this.

Download .NET 8.0

Run apps - Runtime @

ASP.NET Core Runtime 8.0.25

The ASP.NET Core Runtime enables you to run existing web/server applications. On
Windows, we recommend installing the Hosting Bundle, which includes the .NET
Runtime and IS support.

11S runtime support (ASP.NET Core Module v2)

18.0.26044.25

0s Installers Binaries

Linux Package manager instructions Arm32 | Arm32 Alpine | Arm64 |
Armb4 Alpine | x64 | x64 Alpine

mac0S Arm64 | x64

\ winget instructions

2. In Microsoft's configuration dialog, follow the installation wizard.

3. Reboot (server or computer).
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How to Download Java JDK

NOTE Oracle charges license fees to use their Java Development Kit (JDK). Therefore, we
also provide support for a free alternative to Oracle's JDK. This alternative—Open JDK—can
be used to support Elasticsearch on both local and remote servers made through the
Content Services Portal.

1. Inabrowser, navigate to:

https://www.madcapsoftware.com/downloads/java.aspx

2. Choose one of the following Java JDK links to download.

= Click Oracle (JDK) Java SE Development Kit (this option may have costs
associated with it).

i. From the Java SE Development Kit 8 Download web page, scroll down to
the Java SE Development Kit 8u261 section.

The latest version available is subject to change.

ii. Determine the appropriate Windows option for your machine (e.qg.,
Windows x64, or Windows x86).

iii. Select the corresponding download file (e.g., for Windows x64, the link is
jdk-8u261-windows-x64.exe).

iv. Click the executable file to install.
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® Click Open JDK Java 1.8 (this option is free).

From the ojdkbuild web page, scroll down to the Downloads for Windows
x86_64 section. See the following:

https://github.com/ojdkbuild/ojdkbuild

From the bulleted list items, locate the latest version for the MSI installer
(e.g., java-1.8.0-openjdk-1.8.0.265-1.b07.0jdkbuild. windows.x86_64.msi).
The latest version available is subject to change (build numbers in path for
given example might not match).

Downloads for Windows x86_64

e 1.8.0_265-1 (LTS, supported until May 2026, announcement)

o java-1.8.0-openjdk-1.8.0.265-1.b01.ojdkbuild.windows.x86_64.zip (sha256)
| o java-1.8.0-openjdk-1.8.0.265-1.b01.0jdkbuild.windows.x86_64.msi (sha256)

Click the MSI executable file to install.
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How to Edit Environment Variables

After Java JDK has been installed, a new environment variable is needed.
1. From the Windows Search bar, type Environment Variables.

2. Click the resulting item from the Control Panel, Edit the system environment variables. The
System Properties dialog opens.

3. Click the Environment Variables button.

Computer Name Hardware Advanced  System Protection Remote

“fou must be logged on as an Administrator to make most of these changes

Performance

Visual effects, processor scheduling, memory usage, and vitual memary

Settings...
User Profiles
Desktop settings related to your signin

Settings...
Startup and Recovery
System startup, system failure, and debugging information

Settings...

) Environment Variables...

4. In the Environment Variables dialog, in the System variables section, click New.

5. Inthe New System Variable dialog, in the Variable name field, type JAVA HOME.

6. Use the Browse Directory or Browse File to navigate to the folder where Java JDK was
installed. Once selected, the Variable value field populates with that path (e.g., C:\Program
Files\ojdkbuild\java-1.8.0-openjdk-1.8.0.252-2). Then click OK.

Variable name: [ sava_HomE |

Variable value: [ cavprogram Files\ojekbuildjava-1.8.0-openjak-1.8.0.252-2 |

Browse Directory... Browse File... oK Cancel

7. Inthe Environment Variables dialog, click OK.
8. Inthe System Properties dialog, click OK.

9. Reboot after adding the environment variable.
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Optional—How to Verify the Java JDK Installation

1. From the Windows Search bar, type cmd, and press ENTER to open a command prompt.

2. At the command prompt, type javac and press ENTER. If you see javac options display
below the command prompt, then Java JDK is working properly.

: WAPTE , SOUPCE} Generat gging info
Generate no i
Output 3 what the compiler is doing
Output = ce locations where deprecated APIs are u

Specify where to Find uwser class Files and annotati
Gpecify where to find user class files and annotati

specify where to find input =
Oyeprride location of hoot

LUH of i

ion of

r annota

of the annotation processors

to find annotation proc ) o
Generate metadata for reflection on method paramete

Fy where to |_|l A
Fy where
y where

not to generate class Files for

Specify character encoding used by source Files
Provide source compatibility with specified release

filesz for ecific UM we
uzed : avallahle in the

—yersion Ue 0 information

—help ! s of standard optio
Akey[=value] Opti to pa . ion

H :

(Flagk P " ﬂl ;:tly tn the
-Herror i t : lation if warninc
B<Lfilename > Read optionz and filenames from

wAdninistratorro

3. Close the command prompt.

What's Next?

"Gathering Required Files for the Remote Server" on the next page.



Gathering Required Files for the Remote Server

With the IS Web Server configured, it is necessary to gather the required files from Flare Desktop
and copy them to the remote server.

How to Copy Files to the Remote Server

1. From the computer where Flare Desktop is installed, use Windows File Explorer to navigate to
the Elasticsearch folder (e.g., C:\Program Files\MadCap Software\MadCap Flare
22\Flare.app\Resources\Elasticsearch).

2. Copy the Elasticsearch folder to the remote server computer (e.g., C:\Elasticsearch). (If you
copy files to this location, you may receive a message requiring administrative permission for
this action. Click Continue.)

NOTE The Elasticsearch folder can be copied anywhere on the computer. It is also
better to keep the Elasticsearch folder outside of the web server for security
purposes.

3. Navigate to the Web.ContentServices folder from the location where you have Flare Desktop
installed (e.g., C:\Program Files\MadCap Software\MadCap Flare
22\Flare.app\Resources\WebHelp2\ContentServices\Web.ContentServices).

4. Copy the Web.ContentServices folder to the web server folder of the remote server (e.g.,
C:\inetpub\wwwroot). (If you copy files to this location, you may receive a message requiring
administrative permission. Click Continue.)

#» This PC » Windows (&) # inetpub » wwwroot
Mame
aspnet_client
Web.ContentServices
@' lisstart
|£| lisstart

What's Next?

"Setting Up the Elasticsearch Server and Content Portal” on the next page.

CHAPTER 4 90



Setting Up the Elasticsearch Server and Content Portal

Work through each section below to complete the remaining items needed for the Elasticsearch
service.

How to Install the Elasticsearch Service

Install Elasticsearch on the remote server to provide the engine for the Elasticsearch service.

1. From Windows File Explorer, right-click the Elasticsearch folder on the remote server, and
select Properties.

2. Inthe Elasticsearch Properties dialog, select the Security tab.

3. Inthe Groups or user names section, select the Everyone account. If this account is not listed,
do the following.

a. Create this account by clicking Edit. (You need to be signed is as an administrator.)

b. Inthe Permissions for Elasticsearch dialog, click Add. The Select Users, Computers,
Service Accounts, or Groups dialog opens.

c. Inthe Enter the object names to select section, type Everyone. Click OK.

4. In the Permissions for Elasticsearch dialog, choose the permissions for Everyone. Under the
Allow category, select Read and Write.

5. Click OK.

6. Navigate to Elasticsearch\config directory, and open the elasticsearch.yml file in a text editor
(e.g., right-click, and select Edit with Notepad++).

7. Under the Network section, find the string “http.port: 9200" and remove the # character from
it.

NOTE Elasticsearch uses port 9200 by default. You will notice in the
Elasticsearch.yml file that the http port is 9200, and in the appsettings.json file the
port is 9602 (in a later step). These numbers must match. You can choose to edit one
of the files with either number. Just make sure they show the same number after the
edits. If you change the port number in the YML file, you can specify the port number
where it reads: http.port: 9200.
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fnetwork.host: 192.165.0.1

—F 9F 9F F 9F 9F °F

W1ore information, consult the network module documentation.

Remove this symbol to
enable this port number.

8. Save the YML file.
9. Inthe Windows Search bar, type cmd.

10. Inthe command prompt, navigate to the location of the copied Elasticsearch\bin directory
(e.g., cd C:\Elasticsearch\bin).

11. Typeelasticsearch-service.bat install and press ENTER.

12. Typeelasticsearch-service.bat start andpress ENTER. Elasticsearch is now
running as the remote web server.
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How to Set Up the Content Services Portal

The Content Services Portal is necessary in order to manage the search data for the Elasticsearch-
enabled HTMLS output.

1.

From Windows File Explorer, right-click the Web.ContentServices folder on the remote server,
and select Properties.

In the Web.ContentServices Properties dialog, select the Security tab.

In the Groups or user names section, select the Everyone account. If this account is not listed,
do the following.

a. Create this account by clicking Edit. (You need to be signed is as an administrator.)

b. Inthe Permissions for Web.ContentServices dialog, click Add. The Select Users,
Computers, Service Accounts, or Groups dialog opens.

c. Inthe Enter the object names to select section, type Everyone. Click OK.

In the Permissions for Web.ContentServices dialog, choose the permissions for Everyone.
Under the Allow category, select Read and Write.

Click OK.

In the Web.ContentServices folder on the remote server, create a folder titled "logs.”
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7. Inthe Web.ContentServices folder on the remote server, open the appsettings.json file in a
text editor (e.g., right-click, and select Edit with Notepad++).

a. Under the ConnectionStrings section, update the path to be used for the
DefaultConnection. The default string line should read as shown in the following image.

_ﬂ
—| "ApplicationInsights": {
"InstrumentationKey": "

ke

= "Logging"™: {
"IncludeScopes™: true,

"LogLevel™: {
"Default™: "Information™,
"System": "Information®,
"Microsoft": "Information”™
= }
ke
=] "ConnectionStrings™: {
|"DefaultCnnnection": "Data Source=\"C:\\inetpub\\wwwwrnot\\Web.ContentServices\\Indices.db\""J
"ElasticsearchUrl"™: "http://localhost:9602™,
"LegacyElasticsearchUxrl™: ™"

Lo,
Eﬂ "ContentServicesStartUplonfigSettings™: {
"DataRootDir": "$LocallpplDatai'\‘\MadCap Software\‘\ContentServices'\\Web.ContentServices"

-}

NOTE The Indices.db file is actually not created until the Content Services
application is started in IIS and users start searching on the Elasticsearch
output. In this step, you are simply specifying the location of where you want
this file to reside on your remote server.

NOTE Elasticsearch uses port 9200 by default. You will notice in the
Elasticsearch.yml file that the http port is 9200 (in a previous step), and in the
appsettings.json file the port is 9602. These numbers must match. You can
choose to edit one of the files with either number. Just make sure they show
the same number. If you change the port number in the JSON file, you can
specify the port number where it reads: http://localhost: 9602.
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b. Under ContentServicesStartupConfigSettings, update the path to be used for the
DataRootDir. The default string line should read as shown in the following image.

=K

=1

"ApplicationInsights™: {
"InstrumentationEey™:
Fr
"Logging™: {
"IncludeScopes": true,
"LogLewvel™: {
"Default": "Information™,
"System™: "Information"™,
"Microsoft": "Information"
}
Fr
"ConnectionStrings": {
"DefaultConnection™: "Data Source=\"C:\\inetpubk\‘\wwwwroot\\Wek.ContentServices\\Indices.dk\"",
"ElasticsearchUrl": "http://localhost:8602",
"LegacyElasticsearchUrl™: ™"
e
"ContentServicesStartUpConfigSettings™: {
|"DataRootDiz": "C:\\inetpub\\wwwroot\\Web.ContentServices" |
}

wn

c. Save the JSON file.
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NOTE Ensure that the paths you provide for DefaultConnection and
DataRootDir in the appsettings.json file have read/write permissions for the
user account logging into the web server.

WARNING If you decide to place the Web.ContentServices folder in a different
location from the C:\inetpub\wwwroot location, make sure the configuration
settings in the appsettings.json file match the location on your remote server
where you placed the Web.ContentServices folder.
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Optional—How to Restrict Access to Content Services

To restrict access to the Content Services Portal, configure the Content Services web application.

This is done by installing the URL Rewrite Module, which will enable IP address security restrictions
to work in your web.config.file. This is an optional procedure.

1. Inabrowser, navigate to:

https://www.iis.net/downloads/microsoft/url-rewrite

2. From the URL Rewrite web page, scroll down to the Download URL Rewrite Module 2.1

section.

a. Determine the appropriate download option for your machine (e.g., x64 installer), and
it.

select

b. Click the executable file to install.

3. Inthe Web.ContentServices folder on the remote server, open the web.config file in a text

editor (e.g., right-click, and select Edit with Notepad++).

4. Remove the comment characters from the <rewrite> and </rewrite> tags in this file.

Remove the
commentdashesin
the <rewrite= and
</rewrite> tags.

<?xml version="1.0" encoding="RLf-8"2>
<configuration>

1

Configure your application settings in gpRSSLGings.isen. Learn more at http://go.microsoft.com/fwlink/?LinkId=786380
<system.webServer>
<handlers>
<add name="aspNetCore" path="+#" verb="#" modules="AspNetCoreModule" resourceType="Unspecified" />
</handlers>
<defaultDocument>
<files>
<clear />
<add value="/Views/Admin/Indices" />
</files>
</defaultDocument>

Uncomment the section below to allow public access only To the '/search' endpoint (public API) .

Ffrewrices
<rules>
<rule name="Fail all non search requests from outside of corporate domain® stopProcessing="trus"s>
<match ggr)}=""search*" negate="true" />
<conditions logicalGrouping="MatchAny">
<add input="{REMOTE ADDR}" pattern="[YCUR IP_ADDRESS]" negate="trus" />
</conditions>
caction type="hbortRequest" />
</rule>
</rules:
</rewrite

Tne sxampls providsd in the section below ISSTricts access To all OTASr sndpolints TO reguests originating from [YOUR_IF_ADDRESS].

<!--ProjectBuid: 70D2F133-EFC2-4C41-8518-4339FFDDOOE2-->

<aspNetCore processPath="dotnet" arguments=".\Web.ContentServices.dll" stdoutlogEnabled="true" stdoutlegFile=".\logs\sidont" forwardW
- </system.webServer>
“</configuration>

5. Modify YOUR_IP_ADDRESS with your desired IP address pattern. You can enter a range of IP

addresses in this field, or a singular IP address. This will block other addresses that do not
match your IP address pattern from gaining administrator access to your Content Services

Portal.
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<!
Uncomment the section below to allow public access only to the '/search' endpoint (public API) ‘
The example provided in the section below restricts access to all other endpoints to requests originating from [YOUR_TIP_ADDRESS].
<!-——<rewrite>
<rules>
<rule name="Fail all non search reguests from ocutside of corporate domain® stopProcessing="true":>
<match Qrl=""search*" negate="trus" />
<conditions logicalGrouping="MatchAny":
<add input="{REMOTE ADDR}" pe.t.t,ern="" negate="true" />
</conditions>
<action type="LbortRegquest" />
</rule>
</rules>
</rewrites---

NOTE You can enter a single IP address of the remote server to limit portal access to
users only on that computer. However, you might need to provide access for more
than just the remote server computer. For example, enter a range of IP addresses to
provide access for authors to publish to the server.
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How to Configure the Content Services Web Application

1. From the Windows Search bar, type 11s.
2. Click the resulting item, Internet Information Services (IIS) Manager app to open IIS Manager.

3. Right-click Application Pools, and select Add Application Pool. The Application Pool dialog
opens.

4. In the Name field, type a name (e.g., MyAppPool). Keep the other default settings, and click
OK. For information about application pools, refer to Microsoft documentation:

https://docs.microsoft.com/en-
us/iis/configuration/system.applicationhost/applicationpools/

Add 4 e
Marme:
MyAppPool
JMET CLR version:
JMET CLR Version w4.0.30319 w

Managed pipeline mode:

Integrated ~

Start application pool immediately

QK Cancel

In the 1IS Manager, navigate to Sites > Default Web Site.
Right-click Default Web Site, and select Add Application.

Enter the name of the Alias for your Elasticsearch website (e.g., MyPortal).

© Noo o

Click the Select button, and choose your Application pool.
NOTE You can use the default Application pool or create a new one for this service.

9. Next to the Physical path field, click the ellipsis button.
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10. Select the C:\inetpub\wwwroot\Web.ContentServices directory. Or, if you placed the
Web.ContentServices directory in another location on your server, select that location
instead.

Site name:  Default Web Site

Path: )
Alias: Application pool:
| MySearch | | MyAppPool Select...

Example: sales

Physical path:

| Chinetpubiwwwroot\Web. ContentServices

Pass-through authentication

Connect as... Test Settings...

[] Enable Preload

QK Cancel

11. Click OK. Your Content Services application is now displayed under Default Web Site in IIS.

|2} Application Pools
w.[a| Sites
v & Default Web Site
: ~| aspnet_client
' -[2¥ MyPortal

«__| Web.ContentServices
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12. Click Start (or Restart if it is already running) on your Default Web Site. The Content Services
application is now running.

W

...} Application Pools

Sites

& Default Web Site

> | asphet_chent
> [ MyPortal
s .| Web.ContentServices

Edit Site
Bindings...

B Basic Settings...

View Applications

View Virtual Directori

Manage Website
) e Restart
P Start

Stop

Browse Website
Browse *:80 (http)
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Optional—How to Verify Content Service Portal Installation

Verifying the installation of Content Services Portal is not necessary to do, but it might provide
peace of mind that is running properly.

1. From the Windows Search bar, type 11s.

2. Click the resulting item, Internet Information Services (IIS) Manager app. The IIS Manager
opens and should show the website configured from earlier steps.

3. Right-click the portal (e.g. MyPortal) and select Manage Website > Browse. If the following
page displays, the portal was configured successfully.

Targets Help

All Targets

I'here are no Targets to display.

The URL for the portal displays as http://localhost/MyPortal where “MyPortal” is the name of
the website picked in an earlier step. In order for another computer to have access to this
server, replace “localhost” with the name of the remote server. For example, the URL to use
from another computer to access this portal is http://[name of server]/[MyPortal].

4. Ensure the computer with Flare Desktop (used to publish to the server) has access to the
remote server. Open a browser on that local computer and browse to http://[name of server]/
[MyPortal]. It should display the same portal page as in the last step. This URL is the also the
one to use for the Elasticsearch destination file in the Flare project.

What's Next?

The next steps in the process involve integrating Elasticsearch with Flare Desktop. Once those are
complete, you'll be able take advantage of the full capabilities of Elasticsearch as your search
engine. See "Enabling Elasticsearch in the Target Editor" on the next page.
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Enabling Elasticsearch in the Target Editor

Follow these steps to configure Elasticsearch for your server-based HTMLS5 target.

How to Enable Elasticsearch

1. Open the target and click the Search tab.
2. Click the drop-down in the Type field and select Elasticsearch.

Search Engine

Type: Elasticsearch e

Search Results

4k

Results per page: 20

4k

Fragments per result: 1
Fragment character limit: 300 =
Indude stop-words in search

[] Partial word searching i

[¥X]
4k

I Minimurm word size:
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3. Configure the following options you need to enable Elasticsearch for your output.

Search Results

Results per page You can change the number of search results that appear on each
page. This makes it easier to navigate between pages of search
results and improves loading times, especially for users who
access output from a mobile device. Setting a reasonable number
of results per page also makes it easier for search indexing
services (i.e., spiders, crawlers, or bots) to locate pages in output,
improving search results. You can set between 1-100 search
results per page.

Fragments per This sets the number of fragments that contain the text of the

result searched item shown in the preview text. The fragment level can be
set anywhere from 0-5. This applies to both search results and
Autocompletion Types. For example, if you type in the word
"Search" in the search bar, the search result extract might display
like this:

® "Search can be conducted from multiple locations. There are
three types of searches that can be selected in the Target
Editor. Use the search bar to locate the feature you want to
use."

® |n this case, the Fragments Per Limit level is set to 3.

Fragment This sets the character limit of the fragment phrase used in the
character limit search.
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Include stop-words  Flare Desktop has a hard-coded stop words list that works behind

in search the scenes to filter out common structure-class words (i.e.,
function words) from search operations. This means the Flare
search engine excludes words (e.g., "an," "for," "of," and "the") by
default. If you want the search engine to search for queries with
these words, you can include the stop words list in search.

Partial word This allows part of a word to be searched in the target database.
searching For example, the string "sear" could return results for "search.” The
Minimum word size field can be set from 3-10.

NOTE Enabling this setting could increase the build time
and the size of the search index for your target.

Advanced Search Options

Include Importance  In HTMLS5 output, the Flare search engine uses a combination of

(recommended) factors to rank search results. The search engine considers the
number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate
results. You can turn off Importance and search using only the
number of search term hits in each topic. This is not recommended
unless you have one topic that is linked too many times that it
would skew your search results.
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Include fuzzy Fuzziness is when two words are spelled similarly and could be
matches considered the same word.

" Substitution: tabs could be construed as tags
Insertion: tab could be construed as table
Deletion: server could be construed as sever
Transposition: file could be construed as flies

Multiple edits: imeg > image. The first edit substitutes e for i.
The second edit inserts e at the end of the string to find the
word image.

By enabling this setting, this allows the following fuzzy matches:

| |
Zero edits for strings of one or two characters (i.e., to, by, on)

One edit for strings of three to five characters (i.e., rnu could
be construed as run, hleps could be construed as helps)

Two edits for strings greater than five characters (i.e., sievrly
could be construed as severely)

NOTE Sometimes a search string is stemmed when
displaying the search results. Stemming is when a word is
reduced to its root. For example, say you enter a search
criteria for "important.” If this word is stemmed, then
Elasticsearch may return fuzzy matches for "importing.”
This occurs because the initial search criteria has been
stemmed to the root "import.”
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Featured Snippets

Filter Select to control which pieces of micro content to include in the
featured snippets area.

. . . . . .
Do not include in search results No micro content is included

in the featured snippets area.

All micro content files Every phrase from all of your micro
content files may be included.

Specific micro content files In the drop-down(s), choose one
or more micro content files. Every phrase from those files
may be included.

Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values.
Micro content phrases that match may be included.

Limit number of Control the maximum number of micro content responses that are

results allowed to display in the featured snippets area. If you leave it set
at 1, Flare Desktop displays only the best match from your micro
content file(s); if you enter 3, Flare Desktop displays up to the best
three matches (if that many exist).
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Knowledge Panel

Filter Select to control which pieces of micro content to include in the
Knowledge Panel.

® Do not include in search results No micro content is included
in the Knowledge Panel area.

= All micro content files Every phrase from all of your micro
content files may be included.

®  Specific micro content files In the drop-down(s), choose one
or more micro content files. Every phrase from those files
may be included.

Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values.
Micro content phrases that match may be included.

Limit number of Control the maximum number of micro content responses that are

results allowed to display in the Knowledge Panel. If you leave it set at 1,
Flare Desktop displays only the best match from your micro
content file(s); if you enter 3, Flare Desktop displays up to the best
three matches (if that many exist).

Auto-complete Results

Enabled This option enables the other options in this area. If this box is not
checked, all of the other options in this area are disabled.

Number of results This field sets the limit of personal searches that display in the
drop-down while entering the search string. This can be set from a
value of 1-25.
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Include project This displays the topic title, the path of where the topic resides in
content your project, and the file name based on the search criteria. These
results are displayed with a topic icon.

Include search This includes a mix of personal and global searches in the output.

history

Global search This threshold determines the minimum number of times a term

threshold must be searched from unique IP addresses before it becomes a
global search term. This threshold can be set from a value of 0-
10000.

® Assuming that this field is set to a value of 50, if the term
"autocompletion" is searched from 49 unique IP addresses
on your HTML5 output, "autocompletion” does not become a
global search term until that term is searched from a 50th
unique IP address.

Sitemap

Generate sitemap This box should be checked to generate the sitemap required for
Elasticsearch on your output.

Web URL This is the URL used for your published output.
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Administrator Tools

Target GUID This provides the key used to identify and link a target to the
corresponding Elasticsearch index.

NOTE Multilingual Elasticsearch publishing requires all
targets to use the same GUID. If the GUIDs in the targets
are different, you might have empty targets on the portal or
experience a publishing failing with error 400. If necessary,
open targets in the Internal Text Editor to modify the GUID.

Generate GUID This generates the key to be used by the target for the
Elasticsearch index.

Launch Content This opens the target in the content services portal. You can
Services manage your targets, and search indexes in the portal.

4. CIicklE' to save your work.

TIP If you are producing different versions of your online output and using Elasticsearch,
you probably want to create a target with a different name for each version. Then, generate
a unique GUID for each of those targets.

The reason for this is that a search database/index is created for each output. If those
outputs share the same GUID, all the outputs will share the same search results, which
would could cause problems, because some outputs might have content that is not
actually available in other outputs.

Also, the paths to the topics linked in search results are also stored in the index. If you
change the path of a topic between the versions, the search result paths will also be wrong.
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Creating Destination Files for Elasticsearch

Elasticsearch is tied to your target—and therefore your output—through the use of publishing
destinations. You must create both a primary destination and an Elasticsearch destination. With the
primary destination, you tell Flare Desktop where to send your output files. With the Elasticsearch
destination, you specify where your search indexing data should be stored (i.e., the server location

that is set up by your network administrator).

— OUTPUT —

PROJECT |
Primary

Destination File

N —

Elasticsearch
Destination File

ONE OF THESE

Computer/Network
Directory (File System)

& =

MadCap Web Server
Central (FTP or SFTP)

ELASTICSEARCH
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How to Create a Primary Destination File
1. Inthe Project Organizer, right-click the Destinations folder and select Add Destination.
2. Give the file a name and click Add.

3. Complete the fields in the Destination Editor, depending on how you want to transfer a copy
of your output files to their destination (e.g., FTP, SFTP). For more about the available
options, see the Help system.

4. CIicklE' to save your work.

NOTE You have the option in the Destination Editor to choose “File System” as the method
for transferring files. In this case, you would be storing the copy of your output files to a
local folder instead of transferring them remotely. You might choose to do this if you prefer
to use a third-party tool to then move those files up to the server hosting your output.

If you choose to publish your files locally in this way, you must have Java Development Kit
(JDK) version 8 installed. See the following:

https://www.madcapsoftware.com/downloads/java.aspx

How to Create an Elasticsearch Destination File
1. Inthe Project Organizer, right-click the Destinations folder and select Add Destination.
2. Give the file a name and click Add.

3. Inthe Destination Editor, click the drop-down arrow for the Type field and select
Elasticsearch.

4. Enter the Search Destination URL. This is the location provided by your network administrator
where the search index files will be uploaded for your output.

5. Click [l to save your work.
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Associating Elasticsearch Destinations With a
Target

Now that the Elasticsearch destinations have been created, you need to associate them with your
HTMLS target.

How to Associate Elasticsearch Destinations with a
Target

1.

From the Project Organizer, open the target that you want to associate with the destinations.

2. Click the Publishing tab.
3. Click the check box in the Publish column next to the primary destination file that you
created.
4. Click the drop-down arrow in the Elasticsearch Destination column and choose the
Elasticsearch destination file that you created.
NOTE Elasticsearch destinations will not display in the list of destinations on the
Publishing tab in your Target Editor. This is because you will select one from the
Elasticsearch Destination field on the Publishing tab of the Target Editor.
5. Click [l to save your work.
CHAPTER 4

112



MadCap Process Manager

The Process Manager is a background process that manages the Elasticsearch service and the
Flare web service. This process can be found in the system tray. It is initiated when the Content
Services Portal is launched. See "Content Services Portal" on the next page.

The MadCap Process Manager continues to run even after Flare Desktop is closed. This process
allows any Elasticsearch output to continue running.

If you need to troubleshoot your Elasticsearch output, you will need to stop the Elasticsearch
process from running through the MadCap Process Manager. In order to do that, find the MadCap
Process Manager icon in your system tray. Then, select Elasticsearch Service > End Process.

End Process | Elasticsearch Service K
Content Services K
B Bt

Once you are done using the Content Services Portal or any output configured with Elasticsearch,
you can end the MadCap Process Manager by ending the task. Select the MadCap Process
Manager icon in your system tray. Then, select Content Services > End Process.

Elasticsearch Service

Open Portal

Content Services k

By Exit

End Process
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Content Services Portal

The Content Services Portal is used to manage search indexes on your Elasticsearch output. You
can review and manage search indexes by topic, micro content, user searches, and global
searches.

How to Access the Production Content Services Portal

Installation and configuration of the Content Services Portal results in a URL for the portal. To
access Content Services on the production server, you can enter the URL into a web browser. For
example, the URL to use from another computer to access this portal is http://[name of server]/
[MyPortal]. See "Optional—How to Verify Content Service Portal Installation” on page 101.

How to Access the Local Content Services Portal

The following steps describe how to open the local version of Content Services. You might want to
do this to test the portal locally.

1. Open a project.

2. Openan HTMLS5 target that has been built using Elasticsearch as the search engine.
3. Click the Search tab.
4

. After all of the settings have been configured for Elasticsearch, click the Launch Content
Services button.
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Managing Search Indexes

The All Targets window displays all HTML5 targets using Elasticsearch. You can access search
data by an individual target. Each of the columns on this window can be sorted in ascending or
descending order by clicking on the column name.

The Target column is

Al | Ta rg etS sorted in ascending order.

\/ Click anywhere within the

row of the specific target

to access specific search
data forthat target.

Project Target T Language Date Created

i My-New-Project27 First-Target en-us 11/2018 12:07:59 PM
(] My-New-Project27 Fourth-Target en-us 12/11/2079 12:02:46 PM
(] English 5 en-us 12/11/2079 11:52:32 AM

Click this icon to delete
the search data of the

] individual target. If you en-us 12/11/2012 11:54:17 AM
delete your target, it

deletes all of the search

s3]
J

@ gl history forthattarget |5 en-us 12/11/2019 11:54:51 AM
W English HTMLS en-us 12/11/2019 11:56:10 AM
W French HTMLS fr-r 12/11/2019 11:57:13 AM
W German HTMLS de-de 12/11/2019 11:57:14 AM

When you click an individual target, the Summary window is displayed for it. This window shows
the total number of searches done, number of files that can be searched, and users that have
searched on the individual target. The bottom half of this window displays the settings you
configured for your Elasticsearch output.
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Theicon on the leftlets you
- delete the search indexes for
. this target. The icon on the right
My-New-Project27 / My-Flare-Target / Summary | ] © 'Q gives a waming that the search
data for this target will be

S u r deleted from the portal.

This path displays the name

of your project, followed by
the specific target, then the Y Es T
page name (Summary) you
are cumrently viewing.

User Searches

84

yA

Global Searches

A

R N

| nfo You can click on the individual
box graphics for Topics, Micro

_ Content, User Searches, and
Target GUID: Teaa3faf-0680-456d-Baab-e219152e190c_en-us Global Searches to drill down into
and obtain more granular
Target Path: Flare-Top-Nav-Server-2019 fltar information for the specific index.

Language: en-us

Date Created: 12/11/2019 12:02:46 P

This bottom section displays all

Date Modified: 12/11/2019 12:13:27 PM EUILE B UE S ST T2
specific target that you

configured in the Target Editor.

Settings

Please note that if you do
notenable the Auto-
complete Results setting in

Search Results

Fragment per result: 1 the Target Editor, this
section will not display for
Fragment character limit: 200 this target on the Summary

page in the portal

>

Include stop-words in search: Dizabled
Partial word search: Disabled

Advanced

Include importance: Enabled

Auto-complete Results
Number of results: 6

LInclude project content: True
Include search history: True

Global threshold: 10
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If you click the red Topics button in the top left corner, the Topics window displays the total number

of files searched on this target. You can enter a string in the search field to filter the list of files

displayed.

with this target. The information

This icon will delete all search
data for the topics associated

icon to the right of this icon is
there as a waming.

b yd

Shared / Flare\Onlir}

Topics

This box lists the
number of topics for
your targets. In this
case, there are 1680
topics in this target

19 / Summary / Topics

Topics

1680

Micro Content

84

Title: HTML Help TOC Options Dialog

Path: Flare/Interface/Ul-Elements/HtmiHelp-TOC-Options-DY \wheneverthe searched topicis

Date Created: 2/15/2019 8:35:00 PM

Content:

Toc

Description: Welcome to MadCap Flare—the first native XM
channel publishing for the web, desktop, print, and mobile devmes:

User Searches Global Searches

21

21

modified and republished, the
Date Created field is updated to
reflect that the topic has been re-
indexed for this target.

Search

Use this search bar to find specific topics
and narrow down thelist thatis displayed
below. After you enter the search string,
click the ENTER button or click the
magnifying glass button fo search. You can
also use this search bar on the User

Searches and Global Searches windows.

Each ofthe topics displayed below includes
the topic title, the path where the topic file
resides in your project, the date the topic
was created in the index, and an abstract of
the contentin your searched topic.

offers single-source XML authoring, as well as multi

This dialog is used to do the following. Determine Look of Table of Contents (TOC) in HTML Help Output You can specify the look and feel of your table
of contents (TOC). This includes adding plus/minus squares next to entries, changing the book/folder icons, adding border around the TOC, and more.
See Specifying How the TOC Looks in HTML Help Output . Create Binary TOC You can create a binary table of contents (TOC) for your project. Binary
[0Cs are intended for very large compiled Microsoft HTML Help projects, reducing the amount of time it takes to load a TOC. See Creating a Binary
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When you click the purple box in the portal, the Micro Content window displays all of the phrases
and the corresponding content that responds to each phrase. Each box in this window contains the

phrase, the date the micro content was created, and its corresponding response.

This box lists the number of
Shared / Flare-Top-Nav-q  micro content phrasesin
your target. In this case,

H there are 84 instances of
M IC rO CO r micro content in this target.

Content [ @

Topics Micro Content

1680 84

User Searches

21

This icon will delete all search data
for the micro content associated

with this target. The information
icon to the nght of this icon warns if

you click the button fo delete the

micro content data for the target.

| Phrase(s): css variables, style variables

Date Created: 2/13/2019 3:51:23 PM

These phrases represent
the searched criteria that
trigger the micro content.

Content:

Global Searches

yA

This content is the micro
content response to the
search phrases.

Search

CSS Wariables A variable in a stylesheet that lets you place the value foétyle in one place and reuse it throughout a stylesheet. As with other kinds of
single-sourcing, this can help with speed, ease of use, and consistency. Whenever you want to change the value, you only need to do so in one place and
the new value is propagated everywhere that the variable is referenced. More Details... Basic Steps Creating CSS Variables Inserting CSS Variables
Editing CSS Variables Resolving CSS Variables for Internet Explorer
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Clicking the blue button displays the number of user searches for the specific target. This window
displays the search criteria from each individual search, the date of the search, along with the
IP address of the user who conducted the search. Each of the columns can be sorted in ascending
or descending order by clicking on the column name. You have the option to delete individual
search criteria, or delete all of the individual user searches for your target.

Theicon on the left can be used
to delete all of the user searches
from this target. The icon on the
right provides a warming message
if you wish to proceed with
deleting all of the user searches.

Shared / Flare-To

User S

Topics Micro Content

1680 84

Search Input

Ul micro content

o jdk

) content services parlal

Click this button to
delete this specific
search criteria.

zendesk

first name

I click next

@ o]

Search

Global Sez

User Searches

21

£

The blue box displays the
number of user searches
conducted on this target. There
are currently 21 unique user
searches on this target.

The Date column has been sorted
on the User Searches window. The
down arrow next to the Date
column indicates that results are
sorted in order from the earliest
search results down to the more
recent search resulis.

Date |

/13/2019 9:03:57 AM

2/13/20199:01:44 AM

2/12/2019 3:34:48 PM

2/12/2019 10:35:55 AM

2/7/2019 11619 PM

2/7/2019 11527 PM

This column lists
the IP address
thatinitiated the
specificsearch.

192.168.19.1
192.168.19.1
192.168.19.1
192.168.19.1
192.168.19.1

192.168.19.1
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The Global Searches window is displayed when you click the green button labeled Global Searches
anywhere in the portal. The Global Searches window shows each search criteria, the last time that
criteria was searched, along with the number of times that particular search string has been
searched for your Elasticsearch output. The number displayed in the Search Count field increments
higher when a specific string is searched by different IP addresses. So if the same IP address has
searched a certain search string multiple times, the search count number does not increment
higher for that particular IP address. Each of these columns can be sorted in ascending or
descending order by clicking on the column name.

Shared / Flare-Top-Nav-Server-2019 / Summary / Global Searches il @ As this box indicates there Search o
are 21 Global Searches on :
Global Searches il
Topics Micro Content User Searches Global Searches The Last Searched field indicates

the last time the specific Search
Input was searched on your target.
The down arrow indicates this filed is
2 1 sorted in descending order, with the
most recent search in the top row
followed by older searches.

1680 84 21

Search Input Last Searched | Count

w micro content 2/13/2019 9:03:57 AM 1
Tuj jdk 2/13/2019 9:03:50 AM 1
] content services portal 2/12/2019 3:34:48 PM 1
Tuf zendesk 2/12/2019 10:35:55 AM 1
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Importing Data From an Upgrade

If you are upgrading Elasticsearch from 5.6 to 7.10.2, you will see a large Import Data button in the
portal after you open a target.

@ madcap Targets Help

11823ES3/ HTMLS / Summary ©) T
Summary

Target data is available in legacy Elasticsearch database (5.x). To import, use the button below.

«

Info
Target GUID: 4035a02b-acal-48bd-aaf(-214520225f8c_en-us

Target Path: HTMLE fltar

NOTE If you have do not yet have data for Elasticsearch 7.10.2, you should see the large
Import Data button. This button will go away after your first import. There is also a smaller
import button at the top of the portal.

Targets Help

11823°ES3 / HTMLS / Summary £ I
Summary

Target data is available in legacy Elasticsearch database (5.x). To import, use the button below.

Info

Target GUID: 4035a02b-acal 48bd-aaf0 214520225f8c_en-us

Target Path: HTWMLS fltar
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Upgrading Elasticsearch and Content Services
on a Remote Server

Information for Network Administrators

Periodically, you might need to upgrade Elasticsearch or Content Services, or both.

How to Upgrade Elasticsearch From 5.6 t0 7.10.2

1. Navigate to the Elasticsearch folder at the location where you have Flare Desktop installed
(e.g., C:\Program Files\MadCap Software\MadCap Flare
22\Flare.app\Resources\Elasticsearch).

2. Copy this Elasticsearch folder from your local machine to the remote server and rename it
Elasticsearch7.x.

O

IMPORTANT This folder can be copied anywhere on the remote server, but the rest
of these steps are written assuming you have copied it to the root C:\ drive. It also
assumes your existing Elasticsearch folder for 5.6 that you previously copied during
the initial Elasticsearch installation is located on the root C:\ drive as well.

3. Onthe remote server, launch the command prompt (CMD) as an admin and run the following
commands:
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cd c:\Elasticsearch\bin
elasticsearch-service.bat stop

elasticsearch-service.bat remove

NOTE The three commands above are used to remove the Elasticsearch 5.6 service.

cd c:\Elasticsearch7.x\bin

elasticsearch-service.bat install
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NOTE The two commands above are used to add the Elasticsearch 7.10.2 service.

4. Using Windows Explorer, do the following:

a. Navigate to c:\Elasticsearch\config\elasticsearch.yml (the file that has been used for
Elasticsearch 5.6).

b. Open the elasticsearch.yml file in a text editor.

c. Under the Network section, find the string “http.port: 9200" and change the port to
something other than 9200 (e.g., 9205).

# on the system and that the owner of the process is allowed to use this
# limit.

#

# Elasticsearch performs poorly when the system i1s swapping the memory.

# Set the bind address to a specific IP (IPvd or IPvE):
#

#network.host: 192.168.8.1

#

# Set a custom port for HTTP:

#
http.port: 9205 (
#

# For more information, consult the network module documentation.

# Pass an initial list of hosts to perform discovery when new node is started:

d. Save your changes in this file.
5. Using Windows Explorer, do the following:

a. Navigate to c:\Elasticsearch7.x\config\elasticsearch.yml (the file that will be used for
Elasticsearch 7.10.2).

NOTE You might also need to open the properties for this file and remove the
Read-Only check mark.

b. Open the elasticsearch.yml file in a text editor.
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c. Under the Network section, find the string “http.port: 9200" and remove the # character
from it. Leave the port number at 9200.

Remove the #.

# Set the bind address to a specific IP (IPwv4 or IPvG):
#

#network.host: 192.168.8.1

#

# Set a custom port for HTTP:

@\ttp .port: 9200

# For more information, consult the network module documentation.

# Pass an initial list of hosts to perform discovery when this node is started:
# The default list of hosts is ["127.8.8.1", "[::1]"]

i

d. On the last line of the file (i.e., the whitelist), remove the # at the beginning of the line.
Also, change the number to match the configured port for the Elasticsearch 5.6 file

(e.g., 9205).

Remove the #.

# For more information, consult the discovery and cluster formation module documentation.

# Block initial recovery after a full cluster restart until N nodes are started:
#
#gateway.recover_after_nodes: 3

#

# For more information, consult the gateway module documentation.

#

F oo - Various --------omommmmmm i
#

# Require explicit names when deleting indices:

#

#action.destructive_requires_name: true

#

F oo - Remotes ------c-mmmmm oo
#

# This is useful for importing data from a r version of elasticsearch.

# Allow remote reindexing (importing data) iom ancther elasticsearch instance.
#

E"eindex. remote.whitelist: localhost:9285

e. Save your changes in this file.

6. Inthe command prompt, run the following commands:

B clasticsearch-service.bat start

B cd c:\Elasticsearch\bin

B clasticsearch
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NOTE This will run the Elasticsearch 5.6 service in a console and won't be part
of Windows Services. Do not close the command prompt, which would stop the
Elasticsearch 5.6 Service.

7. Continue with the next set of steps to upgrade Content Services.
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How to Upgrade Content Services From .NET Core 3.1
t0 6.0.13

If you have upgraded Elasticsearch, you also need to upgrade Content Services. There might be
other times when you need to upgrade Content Services only.

1.

On the remote server, open the Internet Information Services (1IS) Manager, and stop the
service.

Download and install the Microsoft .NET 6.0.13 Windows Hosting Bundle from the following
link.

https://dotnet.microsoft.com/download/dotnet-core

Download .NET 6.0

@ Not sure what to download? See recommended downloads for the latest version of .NET.

A~ 6.0.13

Release notes  Latest release date January 10, 2023

Build apps - SDK @ Run apps - Runtime ©

SDK 6.0.405 ASP.NET Core Runtime 6.0.13

os Installers Binaries The ASP.NET Core Runtime enables you to run existing web/server applications. On

Windows, we recommend installing the Hosting Bundle, which includes the .NET

Linux Package manager instructions Arm32 | Arm32 Alpine | Armé4 | Runtime and IIS support.

Arm64 Alpine | x64 | x64 Alpine

_ 11S runtime support (ASP.NET Core Module v2)
64 {28
mac0S | Arm64 | x64 Armed | x4 16.0.22335.13
Windows | Arm64 | x64 | x86 | Armé64 | x64 | x86
winget instructions

0s Installers Binaries

All dotnet-install scripts remliue

Package manager instructions Arm32 | Arm32 Alpine | Arm64 |
Armb4 Alpine | x64 | x64 Alpine

Included runtimes
.NET Runtime 6.0.13
ASP.NET Core Runtime 6.0.13
.NET Desktop Runtime 6.0.13

Arm64 | x64

Windows | Hosting Bundle | x64 | x86 | Armb64 | x64 | x86
winget instructions

3. On the local machine, navigate to the Web.ContentServices folder at the location where you

have Flare Desktop installed (e.g., C:\Program Files\MadCap Software\MadCap Flare
22\Flare.app\Resources\WebHelp2\ContentServices\Web.ContentServices).

Copy and paste this Web.ContentServices folder to the remote server. It can be pasted
anywhere on the remote server. This is just a temporary folder that you will use in the steps
below; you can delete this folder later.
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5. Upgrade the Content Services portal. The older files referenced in the following sub steps
have to do with those you copied to C:/inetpub/wwwroot, as described in Installing
Elasticsearch on a Remote Server. So navigate to C:/intepub/wwwroot.

a. Keep the following folders in the older Web.ContentServices folder (located under
C:/inetpub/wwwroot):

® | 0gs
B Targets
® Uploads

Remove the other folders.

b. Keep the following files in this Web.ContentServices folder:

B appsettings.json
® |ndices.db
® web.config

Remove the other files.

c. Copy all of the new folders and files (except appsettings.json and web.config)from the
temporary Web.ContentServices folder to the old Web.ContentServices folder.

6. Open the appsettings.json file. Add a comma at the end of the ElasticsearchURL line. Then
paste the following under that line (assuming the port number you entered previously is
9205):

"LegacyElasticsearchUrl": "http://localhost:9205"
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{

"ApplicationInsights™: {

"InstrumentationkKey": ""
Ts
"Logging™: {
"IncludeScopes™: true,
"Loglevel™: {
"Default”: "Information”,
"System": "Information",
"Microsoft”: "Information”
¥
¥s

"ConnectionStrings™: {

"ElasticsearchUrl™: "http://localhost:928@",
"LegacyElasticsearchUrl™: "http://localhost:9285"

Is

"ContentServicesStartUpConfigSettings™: {
"DataRootDir": "C:\\lnetpub‘\\wwwroot\\Web.ContentServices\\"
¥
¥

"DefaultConnection”: "Data Source=\"C:\\inetpub‘\wwwrooti\Web.ContentServices\\Indices.db\"",

7. Save your changes in this file.

8. Open the IIS Manager and start the service.
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Import Data From Elasticsearch 5.6 to 7.10.2
1. Launch Content Services (i.e., the URL to your server where Elasticsearch is installed).
2. Open atarget from the grid.
3. Click Import Data.

Targets Help

11823E53/ HTMLS / Summary ©]
Summary

Target data is available in legacy Elasticsearch database (5.x). To import, use the button below.

«

Info
Target GUID: 4035a02b-aca0-48bd-aaf0-214520225f8c_en-us

Target Path: HTMLS fltar

NOTE If you have do not yet have data for Elasticsearch 7.10.2, you should see the
large Import Data button. This button will go away after your first import. There is
also a smaller import button at the top of the portal.

@ madcaop Targets Help

11823-ES3 / HTMLS / Summary £] &
Summary

Target data is available in legacy Elasticsearch database (5.x). Toimport, use the button below.

Info
Target GUID: 4035a02b-aca0-48bd-aaf(-214520225f8c_en-us

Target Path: HTMLS fltar

4. Inthe popup, click Import Data again.
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You should see the tiles populated with numbers, representing your imported data.

ElasticsearchTest / Elasticsearch\SideNav / Summary 2] ]

Summary

Micro Content User Searches

57 4

Info

Target GUID: 0d0475393-3951-441d-8a04-367816796fal_en-us

Target Path: Elasticsearch\SideNav fltar
Language: en-us
Date Created: 1/30/2023 3:31:34 PM

Date Modified: 1/30/2023 3:31:38 PM

Global Searches

4
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| Google Search

Supported In:

HTML

Google Search can be used in your HTML5 Top Navigation or Side Navigation output. It provides
many configurable options.

® Verify the URL

® Add a sitemap

" Submit the site for indexing

® Exclude the TOC from indexing

® Customize how the results display

® Review indexing status

(D IMPORTANT If you implement Google Search, your Flare output will be available publicly
and listed in Google searches. To make your published output private, please refer to
Google's documentation.
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How to Set Up a Google Search Engine

1. Openan HTMLS5 target.
2. Select the Search tab.
3. From the Search Engine field, select Google Search.

4. There are several additional steps you can complete in your Google account to optimize your
search. Not all of these extra steps are required for integrating search with Flare Desktop, but
they are recommended. Also, the exact steps that you follow may be somewhat different if
you are using a free Google account as opposed to a paid account.

GOOGLE ACCOUNT—CREATE SEARCH ENGINE

a. Goto cse.google.com and log in with your Google (i.e., gmail) password.

b. Click Add to create a custom search engine.

c. Inthe Sites to search field, enter the URL for the site where your output will be
published. A name for the search engine is automatically added toward the bottom of
the page, based on your URL. You can edit the name to something more simple if you
want.

d. Click Create.
e. Onthe next page, click Get code to retrieve your search engine ID.
f. Copy the search engine ID shown.

g. Continue with the following Flare steps to enter the Google search key and generate a
sitemap.
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FLARE PROJECT—ENTER GOOGLE SEARCH KEY AND GENERATE SITEMAP
a. Return to the HTML5 target (Search tab) in the Flare project.

b. Inthe Google Search Context Key field, paste the ID that you copied from
cse.google.com.

Search Engine

Search Engine: Google Search ~

Google Search Context Key  |010234593211060245835:hdigxrr 112

Sitemap
D Generate Sitemap

Web URL:

c. To assist with indexing, we also recommend that you create a sitemap. So Click
Generate Sitemap and enter the same URL that you provided on your Google account

page (make sure you include http:.// before the path; also, make sure you end the path
with a closing /).

Search Engine

Search Engine: Google Search >

Google Search Context Key  |010234593211050246838:hdigxrr 112g

Sitemap
Generate Sitemap

Web URL: |h'c|:]:u:,.',,’help.rnadu:a|:usu:n"'t\.'~.'ana.u:u::rn,.'|:urc:nject3,|r

d. CIicklE' to save your work.

e. Generate the target and upload the output files to your URL.

f. Continue with the following steps to verify your URL.
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GOOGLE ACCOUNT—VERIFY URL

a. Inyour browser, open a new tab and go to
https://www.google.com/webmasters/tools/.

b. If you do not yet have a site, click the Add property drop-down, then select the Add
property option.

If you already have a site, click the drop-down next to the site name, then select the Add
property option.

c. Enter the URL for your site, and click Continue.
A page opens with steps for verifying your site.
d. Complete the steps on the page.

e. After you have successfully verified the site, continue with the following steps to add
your sitemap.

GOOGLE ACCOUNT—ADD SITEMAP
a. After verifying the URL, click Go to Property.
b. Click Sitemaps.
c. Enter sitemap.xml.
d. Click Submit.

e. Continue with the following steps to submit the site for indexing.

GOOGLE ACCOUNT—SUBMIT SITE FOR INDEXING
a. Inthe Google Search Console, click URL inspection.

b. Inthe text field, enter a page in your output that contains many links. For example, in
the Top Navigation project template in Flare Desktop, the “Home.htm"” topic is the
landing page and contains links to multiple topics, so in that case you would enter
Content/Home.htm in the field.

c. Click Request indexing.
d. After the status finishes processing, close the message.

e. Continue with the following steps to exclude your TOC from indexing.

CHAPTER 4 134


https://www.google.com/webmasters/tools/

GOOGLE ACCOUNT—EXCLUDE TOC FROM INDEXING

By default, Google will index each word it finds on your pages, but there may be some words
that you do not want to be indexed. This likely includes your TOC. After all, the words in the
TOC will be repeated on most, if not all, of your pages. So it wouldn't be useful for those
words to be included in searches.

a.
b.

C.

e.
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Go back to the first browser tab for your Google account and click the Advanced tab.
Click CSE context to expand that section.

Click Download (XML). The cse.xml file is added to the Downloads folder on your
computer.

Edit the downloaded context file cse.xml to add the following attribute: enable
nocontent tag="true". (If you already see this attribute in the file, you do not need
toaddit))

To add the attribute, you can open the file in a text editor such as Notepad++. Then
near the top of the file, change:

<CustomSearchEngine id= "[id]" creator="[id]">
to

<CustomSearchEngine id= "[id]" creator= "[id]" enable
nocontent tag="true">

There may be other attributes that are already in the tag as well. Save your changes
when finished.

% EXAMPLE Here is an example of an edited cse.xml file:

<?xml version="1.0" encoding="UTF-8" 2>
[El<CustomSearchEngine id="hdigxrrll2g" creator="010234593211060246838" language="en" encoding=
"UTF-8" enable suggest="true" enable nocontent tag="true">
<Title>Project3</Ticle>
=] <Context>
g <BackgroundLabels:
<Label name="_cse hdigxrrll2q" mode="FILTER" />
<Label name="_cse_exclude hdigxrrll2q" mode="ELIMINATE" />
E </BackgroundLabels>
- </Context>
<] <LookkndFeel nonprofit="false" element_layout="8" theme="T7" text_font="Arial, sans-serif"

url length="full" element branding="show" enable cse_thumbnail="true" promotion url length=
"fall"s

On your Google account page, go back to the CSE context section of the Advanced tab,
and click Upload XML file.
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f. Choose the cse.xml file that you edited.
g. Inthe popup, click OK to upload the file.

h. Continue with the following steps to customize the appearance of search results.

GOOGLE ACCOUNT—CUSTOMIZE APPEARANCE OF SEARCH RESULTS

By default, search results are overlayed on top of your output. You can change this look if you
want.

a. Click Look and feel.

b. On the Layout tab, select an option.

NOTE In your Flare output, the results layout that you select may not look
precisely the way that Google presents them in the layout thumbnails. It is
recommended that you try different layouts and test the output to see which
one best meets your needs.

TIP To make the search results appear the way that they normally do in Top
Navigation output, select Results Only.

c. Click Save.

GOOGLE ACCOUNT—REVIEW INDEXING STATUS

From your account, you can see the progress of your indexed pages.
a. Go back to the browser tab showing your Google Search Console.
b. Click Sitemaps.

It might be awhile before you see actual results, so return to this page periodically.

5. CIicklE' to save your work.
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CHAPTER 5

Setting Search Results Options

For online targets, you have a variety of options that you can enable or disable to define how search
results are treated, depending on the output type.

This chapter discusses the following:

CHAPTER &

Setting the Number of Search Results PerPage ............................ 138
Setting the Search Abstract Character Limit ................................... 140
Including Stop Words in Search ... 142
Setting Search Result Importance ... 149
Enabling Partial-Word Search ... 153
Setting Micro Content CoNtaiNers ... 155
Including Glossary Terms in Search Results ................................. 156
Excluding Non-Words From Search ... 160
Excluding Index Entries From Search ... 161
Pre-Merging Search Database Files ... .. 162
Chunking Large Search Database Files ... 163
Setting the N-Gram Size for Search ... 167
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| Setting the Number of Search Results
Per Page

Supported In:

HTHML

You can change the number of search results that appear on each page. This makes it easier to
navigate between pages of search results and improves loading times, especially for users who
access output from a mobile device. Setting a reasonable number of results per page also makes it
easier for search indexing services (i.e., spiders, crawlers, or bots) to locate pages in output,
improving search results. In order to use this feature, you must be using MadCap Search. This
feature is not supported for Google Search (see "Setting Up a Search Engine" on page 50).

Your search for "cats NOT dogs" returned § result(s).

Cats | Domestic Cats

This is a great place to start learning everything you need to know about Cats)
Cats/Cats_htm

ing how to choose, feq

Choosing a Cat Your search
Choosing a Cat There are many different types of cats in the world. Wit retumed eight hoose f
Cats/Choosing_a_Cat htm results.

Training a Cat

Training a Cat Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismaod
Cats/Training_a_Cat.htm

Feeding a Cat Becausethe paginationis
Feeding a Kat This is whera cumrently setto show five results keding cats:

per page, the remaining three
results display on the next page.

Cats/Feeding_a_Cat.htm

Feeding an Adul

Feeding an Adul
Cats/Feeding

his is where we tell you everything you need to know about feeding an adult cat.
FAdult_Cat.htm
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How to Change the Number of Search Results
per Page
1. Openan HTMLS target.

2. Select the Search tab.

3. From the Search Engine section, make sure either MadCap Search or Elasticsearch is
selected.

4. In the Results Per Page field, use the arrows to set the number of results you want to display
on each page. By default, the number of results per page is 20 for MadCapSearch and 100 for
Elasticsearch.

5. CIicklE' to save your work.
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| Setting the Search Abstract Character

Limit
Supported In:

HTHML

In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search
results, while keeping the search results page easy to scan. You can set the character limit as long
or as short as you like. When creating an automatic abstract, Flare Desktop scans all text elements
in the topic, including headings and paragraphs, and includes them in the abstract until the

character limit is met.

/

George VWashington

This abstract is
300 characters.

George YWashington (February 22, 1732 [0.5. February 11, 1731] — Decembe
United States (1789-1797). the Commander-in-Chief of the Continental Ar
and one of the Founding Fathers of the United States. He presided over ..
B_Feature Topics/George Washington.htm

=T799) was the first President of the
uring the American Revolutionary War,

-

George Washington

This abstractis
400 characters.

George VWashington (February 22, 1732 [0.5. February 11, 17,
United States (1789-1797), the Commander-in-Chief of

and one of the Founding Fathers of the United S .
Constitution, which replaced the Aricles of .*
B Feature Topics/George Washington_htm

mber 14, 1799) was the first President of the
nental Army during the American Revaolutionary War,
e presided over the convention that drafted the United States
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How to Change the Abstract Character Limit in
Search Results

If you want change the abstract character limit, do the following.

1.

Open an HTMLS target.

2. Select the Search tab.
3.
4

Select MadCap Search in the Search Engine field.

. In the Abstract Character Limit field, enter the number of characters you want to allow in the

topic's abstract. By default, the number of results per page is 300.

Click [l to save your work.

NOTE In order to use this field, you must be using MadCap Search. Elasticsearch uses a
similar field called Fragment character limit. This feature is not supported for Google
Search (see "Google Search" on page 131).

NOTE Setting the abstract character limit to 0 will remove the abstract completely.

NOTE If a word is too long and would push the abstract past its character limit, it is not
included in the abstract. Flare Desktop will not leave incomplete words at the end of the
abstract.

NOTE If you need to provide a longer or shorter search abstract, or if you do not like the
default text that appears in the abstract, you can manually enter a meta description for the
topic in the topic's Properties dialog.

George \Washington This is manual meta
This topic is about George Washington. He was the first President 1 description overrides the
B_Feature Topics/George Washington.htm automatic abstract.

See "Meta Descriptions for Topics" on page 172.
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I Including Stop Words in Search

Supported In:

Flare Desktop has a hard-coded stop words list that works behind the scenes to filter out common
structure-class words (i.e., function words) from search operations. This means the Flare search
engine excludes words (e.g., "an," "for," "of," and "the") by default. If you want the search engine to
search for queries with these words, you can include the stop words list in search.
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List of Stop Words—English

Below is the list of hard-coded English stop words that the Flare search engine excludes from
search by default. If you want to create a custom stop words list, you can create one on your local
computer using Language Skins as described below.

a
about
after
against
all

also
among
an

and

are

as

at

be
became

because

CHAPTER 5

been
between
but
by
can
come
do
during
each
early
for
found
from
had

has

have

he

her

his

however

in

include

into

its

late

later

made

many

may
me
med
more
most
near
no
non
not
of
on
only
or
other

over

several
she
some
such
than
that
the
their
then
there
these
they
this
through

to

under
until
use
was
we
were
when
where
which
who
with
you

your
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NOTE The stop words list applies to English projects only. If you wish to create a custom
stop words list for another language, use the instructions below to create a custom list of
stop words.

NOTE For best results, it is recommended that you use the default setting (i.e., stop words
are automatically excluded from search). This typically returns the most relevant search
results.

NOTE "If" and "will" are also recognized as stop words when using Elasticsearch as your
search engine.
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How to Include the Stop Words List in Search

By default, the words on the stop words list are excluded from search. To include them, complete
the following steps.

1. Inthe Project Organizer, open the target.

2. Inthe Target Editor, click the Search tab.

3. Inthe Search Results section, place a check mark in the Include stop-words in search box.
4

. Click[&l] to save your work.

Creating a Custom Stop Words List

In Flare Desktop, the stop words list is hard-coded. However, you can create your own stop words
list on your local computer using language skins.

NOTE Stop words are not customizable in HTMLS outputs.
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How to Create a Local Copy of the Stop Words List

These instructions show you how to create a stop words list for an English language skin. You can
also use these instructions to create a custom stop word list for other languages.

1. Open a Flare project.
2. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Add Language Skin.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Language Skin.

The Add File dialog opens.
3. Inthe File Type field at the top, make sure Language Skin is selected.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click 2] and select the subfolder. Otherwise,
keep the default location.

5. From the Language drop-down, select the language you want to use for the language skin.
6. Inthe File Name field, type a new name for the language skin.

7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click =] and select the conditions you
want to apply. Click OK.

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click =] and select the file tags you want to apply. Click OK.

9. Click Add. The language skin is added to the Advanced folder in the Project Organizer. The
Language Skin Editor opens to the right, with the new language skin shown. Depending on the
language you selected when creating the language skin, the skin may include default
translations for some Ul text strings.

This creates a copy of the project language skin file and places it in your Project's Advanced
folder (e.g., C:\Users\[username]\Documents\My Projects\[project name]\Project\Advanced).
The language skin file name uses the * fling file name extension (e.g., af.fling, en.fling,
es.fling).

10. Close the Language Skin Editor.
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How to Modify the Stop Words List

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Right-click the language skin file, then select Open with > Internal Text Editor.
4

In the text editor, enclose your list of stop words in the <StopWords> </StopWords> tag. All
tags are case sensitive and all stop words must be typed in lowercase.

5. Enclose each stop word in the <Word></Word> tag.

Text Editor | 4- & A-
: 1 <?xml version="1.8" encoding="u
Enclose YDU_F list of 2 <5tylesheet wml:lang="en-us" we
stop words inthe &~ frua”s
<StopWords:> tag. ——=-<Stopliords>
This tag is case T <Word>a<,/Word>
sensitive. 5 <Word>about</ Word:>
& <Wordraftter</Word:
7 <Wordragainst</Word>
8 <Wordrall</Word:
g <Wordralso</Word:>
18 <Word>among</Word:>
Endﬂse Inwe,":ase 11 <1\|Drd>an<.."'1\h:|r"d>
——— <Wordrand</Word>
StOp words between <Wordrare</Word>
<Word>tags. Tags _ <Mord>as</word>
are case senstive. 15 <Word>at</ Word:
16 <Wordrbe</Word:
17 <Wordrbecame</Word:>
18 <Word:because</ Word:>
19 <Wordrbeen</ wWord:>
28 <Wordrbetween< Word:>
21 <Wordrbut</Word>
22 <Word>by</Word>
23 <Word>can</Word:>
24 <Word>come</Word:>
25 </StopwWords:

6. CIicklE' to save your work.

NOTE You can also modify the stop words list using a text editor on your computer, such
as Notepad.
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How to Build the Target and Test the Custom Stop
Words List

1. Open the target in your Flare project.

. Select the Language tab, and choose the appropriate language.

2
3. Build the target.
4

. Perform searches in the output to test if stop words are being found.
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| Setting Search Result Importance

Supported In:

HTML

In HTML5 output, the Flare search engine uses a combination of factors to rank search results. The
search engine considers the number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each topic. This is not
recommended unless you have one topic that is linked too many times that it would skew your
search results. You must be using Elasticsearch or MadCap Search to use this feature. It is not
supported for Google Search.

How to Include or Exclude Importance in Search
Results

1. Openan HTMLS target.
. Select the Search tab.

2
3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.
4. Expand the Advanced Search Options section.

5

. Select Include Importance.

6. CIicklE' to save your work.
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% EXAMPLE Here is an example of a search with Importance turned on.

Your search for "heading" returned 13 result(s).

One important Heading with & links
Here is some general text for 8 topic. Replace this with your own content. Here is some gg
Heading 2 Hers is some genersl text for 8 topic lace this with your own content. Herd
Importance/One heading with & href links.htm

One important Heading with 5 links
Here is some genersl text for = topic. Replace this with you
Heading 2 Here is some general text for a topic. Replace this
Importance/Cne heading with & href links.htm

t. Here is some g4
content. Hergl

One important Heading with 4 links | When Importance is turmed
Heres is some general text for 5 topic. Replacs th on tDpiCS 1hat are I|nkEd tO

Heading 2 Hers is some general text for 3 topic -
Importance/Cne heading with 4 xref links.htm more Often appear hlgher
_ ) _ _ in the search results.
One |mp0r‘tant HEEI‘JII’IQ with 3 links
Hers is some general text for 8 topic. Replace th -
Heading 2 Here is some general text for 8 topic Replace this with your own content. Herg
Importance/One heading with 3 href links.htm

One important Heading with 2 links

Here is some general text for 2 topic. Replace this with your own content. Here is some gg
Heading 2 Here is some general text for 8 topic. Replace this with your own content. Herg
Importance/Cne heading with 2 href links.htm

One important Heading with 1 link

Here is some general text for 3 topic. Replace this with your own content. Here is some gg
Heading 2 Hers is some general text for & topic Replace this with your own content. Herg
Importance/Cne heading with 1 href link.htm

Many levels of headings

Heres is some general text for 5 top
MMadCap Software Heading 2 Here
Relevance/Heading Two.htm

The search engine also considers
) where the search termis in the topic
Many levels of headings | (such as a heading or the body text)

Herz is some genersl tesdt for = top

Heading 2 Here is some general tg tO dEtem]ine rankiﬁgS.

Relevance/Heading Three htm

f'-.:']ﬁl"l‘_f levels of hEEdiI‘IgS
Heres is some general text for 3 topic. Replace this
Heading 2 Hers is some general text for 3 topic
Relevance/Heading Four.htm

content. Hers is some g4
5 with your own content. Herg

Many levels of hEEﬂiI‘IgS
Here is some general text for 8 topic. Replace this with your own content. Here is some gg
Heading 2 Here is some general text for 8 topic Replace this with your own content. Herg
Relevance/Heading Five. htm
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% Hereis an example of a search in the same content with Importance turned off.

Your search for "heading" returned 13 result(s).

Many levels of headings

Here is some general text for a topic. Replace this with your own content. Here is some ge
MadCap Software Heading 2 Here is some general text for a topic. Replace this cat with
Relevance/Heading Two.htm

Many levels of I'IEEI:"I'IQS

Hers is some general text for a topic. Replace this with your own content. Here is some ge
Heading 2 Here is some general text for a topic Replace this with your own content. Here
Relevance/Heading Three. htm

Many levels of headings

Here is some general text for a topic. Replace this with your own content. Here is some ge
Heading 2 Here is some general text for a topic. Replace this with your own content. Here
Relevance/Heading Four.htm

Many levels of I'IEEI:"I'IQS

Here is some general text for a topic. Replace
Heading 2 Here is some general text for & top
Relevance/Heading Five. htm

When Importance is turned off, it
doesn't matter how many links there
are to the topic. Instead, topics are
ranked based on where the search
term appears in the topic.

Many levels of headings
Here is some general text for 8 topic. Replace
Heading 2 Here is some general text for a top
Relevance/Heading Six.htm

There are no important headings
Here is some general text for a topic. Replace
Heading 2 Here is some general text for a topic. Replace this wi
Importance/MNo topics link to me.htm

One important Heading with 1 link

Here is some general text for a topic. Replace this with v
Heading 2 Here is some general text for a topic. Repla
Importance/One heading with 1 href link. htm

ntent. Here is some ge|
ith your cwn content. Here

One important Heading with 5 links
Here is some general text for a topic. Replace this with your own content. Here is some ge
Heading 2 Here is some general text for a topic. Replace this with your own content. Here
Importance/One heading with & href links.htm

One important Heading with 4 links

Here is some general text for a topic. Replace this with your own content. Here is some ge
Heading 2 Here is some general text for a topic. Replace this with your own content. Here
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ﬁ Notice how the search results are different. This is because in the first example, with
Importance turned on, the search engine considers the number of links to that topic when
ranking the search results. In the second example, the results are ranked only using the
location of the search term in the topic (e.g., in a heading, in an index keyword, in the body
text).

If you want your users to be able to find a topic that you refer to—and link to—often in your
content, you should turn on the Importance setting so the topic appears higher in the
search rankings.

NOTE Links that occur in a template page are not considered when calculating
Importance. For example, suppose you have a link in the template page footer that appears
on every page in your output. Because you can access the page it links to from every other
page, it should be the most important page in the output, but it is excluded from
Importance rankings so it does not skew results.
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| Enabling Partial-Word Search

Supported In:

WEB
HELP

HTML

5|

For some online outputs, you can provide end users with partial-word search capabilities. This lets
users type part of a word or any string (including numbers), press ENTER or click the Search button,
and see search results matching those characters.

How to Enable Partial-Word Search

1. Inthe Project Organizer, open the target.
Select the Search tab.

In the Search Results section, place a check mark in the Partial word searching box.

> W™

In the Minimum word size field, enter the number of characters a user must type before
seeing results. The minimum value is 3, the maximum value is 10.

NOTE The higher the minimum word size that you enter, the smaller the search
database.

5. CIicklE' to save your work.
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¥% EXAMPLE In the Search field, you enter cond.

Search finds matches in "conditioning" and "second."

The string "cond" is

Search for cond. found in "Conditioning”

/ - 2 g x| TreiningaParot % ‘ l
v?_\ Help Topic | @ & W @ |Fj B % % -

Fler  |uoitered) sy Training a Parrot

cond

Title: Rank File
= : It is important to give your parrot positive reinforcement. Conditioning is the process of helping your parrot
raining & Pamot . - . .
< understand simple concepts. Far example, making a clicking sound equals a treat. This creates an important bond

between pet and owner.

As the owner, you can use your communication link to express to the parrot what you want bird to do. You can then
The Search pane shows mold the parrot's behavior and teach the bird unigue tricks.
aranked list of topics
containing the partial
word "cond.”

First Time Owner Time Owner Third Time Owner

How may parrots have 2

[ \

Thestring "cond"” Is
foundin "Second”

you owned?

(D IMPORTANT Enabling partial-word search in client-based outputs increases the size of the
search database included with your target output. It also increases the amount of time it
takes to build and publish the output.

NOTE This feature is not limited to words only. It works with any string (including
numbers) that starts and ends with a space. For example, let's say that the IP address
numbered "192.168.10.1" is included in one of your topics. To find the topic that includes
the match, simply type 10.1 in the search field.

NOTE Partial-word search is not supported in server-based output.
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| Setting Micro Content Containers

Flare Desktop provides various container types that you can use to add micro content to your
HTML5 output. Some of these can be used in search results, some in topic output, and some in
both. See the Help system for more information.
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I Including Glossary Terms in Search
Results

Supported In:

HTHML

For HTML5 output, search results display glossary terms if they are used as the search text. In
order to use this feature, you must be using MadCap Search. This feature is not supported for
Google Search (see "Setting Up a Search Engine" on page 50).

In this example, we
searched for "bleed.”

Because our HTMLS target
uses a glossary file
containing the glossary term
"Bleed," it is displayed at the
top of the search results.

Your search for "bleed" returned 13 result(s).

Bleed

The area beyond the edge of the page where printing occurs. Professional printers use the bleed to
prevent a final trimmed document from having unprinted areas along the edge of the document. You
can set the size of the bleed in the Page Properties diglog.

Specifying the Page Bleed Size
Define the bleed size settings for @ page using the Page Layout Editar. You can select the length of the bleed from the top, bottom,
eft and right.

_/Page-Layouts/Pages/Specifying-Page-Blead-Size htm

Showing the Bleed, Crop, and Registration Marks in Page Layouts
Showing printer's marks and bleeds. Crop marks, registration marks, and bleeds are specified in page layouts.

/Page-Layouts/Pages/Showing-Bleed-Crop-Reg-Marks-Page-Layouis htm
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How to Include Glossary Terms in Search
Results

1. Openan HTMLS target.
. Inthe Target Editor, select the Search tab.

2
3. Inthe Search Engine field, make sure MadCap Search is selected.
4. Expand Advanced Search Options.

5

. Select Include glossary results.

6. CIicklE' to save your work.

NOTE In order for a glossary term to display in the search results, the end user's search
text must match the glossary term exactly, with no additional words (although it is not
case-sensitive). For example, in the example above, only the word "table" was included in
the search; therefore, the glossary term "Table" was displayed. But if we had searched for
"table topic," no glossary term would have been displayed in the search results.

CHAPTER 5 157



NOTE If you open a Side Navigation, Top Navigation, Tripane, or Search Results skin, you
will notice Search Glossary styles that let you control the look of this new feature (e.g.,
change the font color to make it stand out from the other search results). The Search
Glossary Result style is used to control the entire area displaying the glossary search
result. The Search Glossary Term and Search Glossary Definition styles are used to control
the look of only the term and definition, respectively.

HTMLS Skin Editor | Preview || Web Medium | Tablet Medium Mobile Medium

Setup W |
Community |Filter
Styles 4 Search Results
e Heading
[ Suggestion
Abstract
I+ Link
Path
4 Glossary
b Term
Definition

Search Results > Glossary > Result

Filter

I Background
I Border

I Box Shadow
I Font

P Layout

b Margin

I Padding

CHAPTER 5
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Search Results > Glossary > Result

Filter

Background

Border

Box Shadow

Color
Family
Size

Weight | no:
Style nol

Layout

B

Your search f

Table

A group of intersecting columns and rows that you can add to a topic for vg
another or giving field descriptions for a software dialog.

Tables

Here is some general text for a topic. Replace this with your own content. Here is some general

3 result(s).
.[As aresult, the glossary
term and definition stand
outin the search results.

CHAPTER 5

In this example, the font

color is set to dark red for

the entire search results
glossary area...

a topic. Replace this with your own content. Here is some general text for a topic. Repld
ditions Notes Tables/Tables htm

Hitions, Notes, Tables
some general text for a topic. Replace this with your own content. Here is some general
a topic. Replace this with your own content. Here is some general text for a topic. Repld

™

ditions MNotes Tables/ConditionsMotesTables htm
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I Excluding Non-Words From Search

Supported In:

WEB
HELP

HTML

5|

Flare Desktop has a non-words list that works behind the scenes to omit common non-words from
user searches (for example, angle brackets []). When you set this option and a user enters non-
words in a search query, the system won't look for those non-words.

WEB

HELP
PLUS

How to Exclude Non-Words From Search

1. Inthe Project Organizer, open the desired target.
In the Target Editor, click the Search tab.

In the Search Results section, click the drop-down arrow next to Advanced Search Options.

> W™

Place a check mark in the Exclude non-words from search box. To include non-words in
search, clear the check mark.

5. CIicklE' to save your work.

NOTE This option is not available for HTML5 targets using Elasticsearch or Google Search.
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| Excluding Index Entries From Search

Supported In:

WEB
HELP

HTML

5|

If you insert index markers in your project, those markers by default are included in searches that
users perform in your output. If you want to exclude index entries from searches, you can do so.

WEB

HELP
PLUS

How to Exclude Index Entries From Search

1. Open the target.
Select the Search tab.

In the Search Results section, click the drop-down arrow next to Advanced Search Options.

> N

Click Exclude index entries from search.

5. CIicklE' to save your work.

NOTE This option is not available for HTML5 targets using Elasticsearch or Google Search.
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| Pre-Merging Search Database Files

Supported In:

wes [l IES
HELF PLUS

If you have multiple projects and plan to merge their outputs when building the parent project, you
can pre-merge the search database files.

How to Pre-Merge Search Database Files

1. Inthe Project Organizer, open the target.

2. Select the Search tab.

3. Expandthe Advanced Search Options section.
4

. Place a check mark in the Pre-merge search database file box.

5. CIicklE' to save your work.
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| Chunking Large Search Database Files

Supported In:

WEB
HELP

HTML

5|

When Flare Desktop builds your output files, it also automatically generates a search index. The
search database is split into a series of chunk files with JS file name extensions. These "chunks"
are very important to your project, because they help to improve the performance of the search
feature.

WEB

HELP
PLUS

Search Database Files and Maximum Chunk
Size
Important things to know about chunk files include:

® Chunk Files are Automatically Created in Sequential Order The build process automatically
creates a search database and then splits the database information into individual chunks.
Each chunk is represented by a chunk file. The naming convention used for these files is
sequential (e.g., SearchPhrase_Chunk0.js, SearchPhrase_Chunk1 js, SearchPhrase_
Chunk2.js). After running a build, these files are required by the target output and stored in
the target's Output\Data folder.
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(2] index_Chunki js
Language.js
Search.js

SearchPhrase_Chunkf.js

1/14/2015 5:25 PM
1/14/2015 5:25 PM
1/14/2015 5:25 PM
1/14/2015 5:25 PM

JScript Script File
JScript Script File
JScript Script File
J5cript Script File

1KE
1KE
1KE
30 KB

SearchPhrase_Chunkl.js

1/14/2015 5:25 PM

J5cript Script File

30 KB

SearchPhrase_Chunk2.js

1/14/2015 5:25 PM

J5cript Script File

30 KB

SearchPhrase_Chunk3.js

1/14/2015 5:25 PM

J5cript Script File

30 KB

SearchPhrase_Chunkd.js

1/14/2015 5:25 PM

J5cript Script File

28 KB

Search5tem_Chunki.js

1/14/2015 5:25 PM

J5cript Script File

30 KB

Search
Database
Chunk Files

Search5tem_Chunkl s

1/14/2015 5:25 PM

J5cript Script File

2KB

SearchTopic_Chunkf.js

1/14/2015 5:25 PM

J5cript Script File

16 KB

@

Synonyms.js

1/14/2015 5:25 PM
1/14/2015 5:25 PM

J5cript Script File

XML Document

1KE
1KE

If you installed Flare Desktop in the default location, the path to the Output\Data folder is:
C:\Users\ [user name]\Documents\My Projects\[project name]\Output\

[user name]\[target name]\Data

® There are Three Kinds of Chunk Files Search chunks come in three varieties: SearchPhrase
chunks, SearchStem chunks, and SearchTopic chunks. Each chunk type holds a different kind
of data. By separating search chunks into different files that contain phrases, stems, and
topics, Flare's search engine can locate data faster.

® Number of Chunk Files Depends on Project Content and Settings The total number of chunk
files generated by the build process depends entirely on the size of your project and the
search performance settings that you enable. As a general rule, smaller projects have fewer
chunk files than larger projects. Other factors to consider include the maximum chunk size
setting and whether the partial-word search feature is enabled. See "Enabling Partial-Word

Search" on page 153.

® New Chunk Files are Generated With Every Build When you update your content and build
new output files, Flare Desktop generates new chunk files to ensure your updated content
can be retrieved when end users perform a search. If you are publishing server-based output,
always ensure that your publishing and upload process for your output includes the updated

chunk files.
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How to Set the Maximum Chunk Size for Search
Database Files

1. Inthe Project Organizer, open the desired target.
2. Inthe Target Editor, click the Search tab.

3. Expand the Advanced Search Options section.
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4. Place a check mark in the Chunk Large Search Database Files box

Maximum Chunk Size box.

Target Editor | /) Build 5] View - [ Publish

Open Build Log

-

General

Skin

elLearning
Conditional Tet
Variables
Publishing
Glossary

Relationship Table

Search Engine

Search Results
Results per page:
Abstract character limit:
[] Partial word searching  .a
Minimum word size:

@ Advanced Search Options

Search

Indude importance (recommended)

Meta Tags

Advanced

Place a check
mark in this

box.

Language

Warnings

Debug

Incude glossary resultz
[ Exdude non-words from search
[] Exdude index entries from search

[] pre-merge s=arch database file

::“" Chunk large search database files

Maximum chunk size:

M-gram size:

Sitemap
|:| Generate sitemap

Web URL:

300

(]

Type: MadCap Search

Expandthis
section.

Selecta value
from this list.

5. CIicklE' to save your work.
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NOTE The smallest maximum file size for a chunk file is 10,000 bytes. The largest
maximum file size is 100,000 bytes. The default setting for the maximum chunk file
size is set to 30,000 bytes.

. Then select a value in the
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| Setting the N-Gram Size for Search

Supported In:

WEB
HELP

HTML

5|

N-grams can be applied to the search database to improve its ability to retrieve more accurate
matches for Chinese, Japanese, and Korean languages.

About N-Grams

In the English language, sentences are composed of a sequence of words. Because English words
are separated by spaces, search engines have a reliable pattern for detecting word boundaries
when retrieving search results. In other languages, such as Chinese, Japanese, and Korean, spaces
are not used to separate words. This makes the task of retrieving accurate matches for these
languages more challenging for search engines.

To address this issue efficiently, the search database can be set to use the n-gram model to help it
more accurately predict word patterns. This improves the search feature's ability to retrieve
accurate search results for the Chinese, Japanese, and Korean languages.
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How to Set the N-Gram Size

. Inthe Project Organizer, open the desired target.

—_

2. Inthe Target Editor, click the Search tab.
3. Expand the Advanced Search Options section.
4

. In the N-gram size box, select a value between 1- 5.

TIP Applying an n-gram value to a project affects the size of the search database. It
also affects the quantity and accuracy of the search results. In general, lower n-gram
values (e.g., 1-2) result in a smaller database. As a result, end user search queries will
typically retrieve a higher number results with less accurate matches. Similarly, larger
n-gram values (e.g., 4-5) result in a larger database. Therefore, search queries will
typically retrieve a smaller number of results with more accurate matches.

5. CIicklE' to save your work.
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CHAPTER 6

Generating Sitemaps

Supported In:

WEB
HELP

HTML

5|

For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEQ), making it easier for search indexing services (i.e., spiders,
crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine

results are improved.
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I How to Generate a Sitemap

1. Open a web-based target.

2. Onthe Search tab of the Target Editor, select Generate Sitemap.

3. Inthe Web URL field enter the path where the output is ultimately published.

% EXAMPLE https://help.madcapsoftware.com/flare2026/

NOTE Be sure to include the full path—including "https://"—when entering the web
URL.

4. CIicklE' to save your work.

NOTE If you are generating HTML5 output, you can also set up your search engine—

MadCap Search, Google Search, or Elasticsearch (for Top Navigation, Side Navigation, or
skinless outputs). See "Setting Up a Search Engine" on page 50.
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CHAPTER 7

Optimizing Search

There are several optimization tasks you can follow to improve the quality of your search results.

This chapter discusses the following:

Meta Descriptions for TOPICS ...
Optimizing Content ...
Optimizing a Site ...
Ranking Search Results ... .

Search RanKing ..o
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I Meta Descriptions for Topics

Supported In:

WEB
HELP

HTML

5|

Description meta tags contain brief summaries of web pages and are recognized by all major
search engines. These tags might not factor into the search rankings by all search engines, but they
are still useful for search engine optimization in web-based outputs, because they can help with the
click-through rate in HTML5 output. We recommend that you create a meta tag set file, which adds
an empty description meta tag by default. This is faster than adding it separately to each topic. This
meta tag then becomes available at lower file levels (including topics), and you can then provide the
value in the topic properties.
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How to Add a Description Meta Tag Value for a

Topic

1. (Recommended) In the Project Organizer, expand the Advanced folder and add a new meta

tag set.
2. Inthe Content Explorer, right-click the topic file and select Properties.
3. Select the Meta Tags tab.

4. If you are using a meta tag set (recommended), expand it.

@ Properties

? *
-
General
D Preview for: [5], HTMLS -
Topic Properties ® My Meta Tag Set
¥ a lag
File Tags My-Meta-Tag-Set.fimeta
Meta Tags Name Comment Mot set
description Description meta tag
Conditional Tet €|
= | Value
Snippet Conditions
Snippet Variables
Language @ Custom Mot from meta tag set

If you are not using a meta tag set, click [#2] to add a new text meta tag, which is added under

the Custom section. Then, enter description as the name.

@ Properties

Snippet Wariables

? x
r T
General
» B Preview for: Bl HTMLS .
TopicProperties
® Custom Nat from meta tag set
File Tags
Name g
Meta Tags description
] -2
Conditional Tet 2 | Value
Snippet Conditions

Language
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5. Inthe Value field, enter a description for the topic.

TIP When adding a value for a description meta tag, it is a good idea to ensure the
following:

® |t should not be too long (fewer than 155 characters if possible) or too short.
® |t should accurately reflect the contents of the page.

® |t should contain relevant keywords, although you should never "stack”
keywords by simply repeating them.

® |t should be unique (i.e., not the same description as you have in lots of other
topics).

6. Click OK.

This description is stored as metadata in the <head> tag of the topic file. The markup looks like this:

<meta name="description"” content="This topic provides a general introduction to MadCap
Flare, its benefits, and basic steps for getting started." />

NOTE If you do not provide a meta description, Flare Desktop will use the abstract
character limit to create an abstract from the text in your topic.
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1.
2.
3.

LEVEL

In the Project Organizer, right-click the Advanced folder and select Add Meta Tag Set.

Complete the File Name field and click Add.

When you want to provide the actual description text for a topic, open the Content

Explorer, right-click the topic, and select Properties.

In the Value field, enter a description for the topic.

¢ EXAMPLE A documentation team wants to enhance the overall experience for users to
find available information in their Help system. They establish in-house guidelines for how
these meta tags should be constructed, and create brief descriptions of each web page.
The team sets out to increase content discoverability (which in turn should build user trust,
and increase brand awareness). They work to optimize text in search results for HTML5
output—with the goal of increasing clicks and traffic.

They create a meta tag set, which automatically includes a description meta tag. They
leave the value empty, and add text at the topic level in the Properties dialog.

Topic Properties

File Tags

Meta Tags

Conditional Tet

Text

description Description meta tag

set value to file

Introduction to a variety of bird groups, and how these groupings offer key differentiators for bird identification.

Click OK.

This is an example of a description meta tag value shown in search results output.

Your search for "groups” returned 7 result(s).

Loaical Groups of North American Birds

| Introduction to a variety of bird groups, and how these groupings offer key differentiators for bird identification.

- UTCATIONBIMd-SroUps . nm
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v¢ FINDABILITY

auto-generate a description.

® SEO Description meta tags help to increase discoverability on the web. It is better to
add this tag for topics rather than leaving it blank or relying on a search engine to

® Content Management In Flare Desktop, you might rely on the Used Meta Tags

analysis report or the File List window pane to view a list of files that show the
description tags used and their definitions.

Meta Tag +  Meta Tag Set  Content File Title  Folder

description Desc.fimeta Introduction to topics for the xyz product. Gattmg-StartedJ Used Meta Tags ction-Topics/
description Desc.fimeta Resources to explore regarding xyz product functionality, — dynamic IEDCII'I shows  |ction-Topics/
description Desc.fimeta Overview of new features for the latest xyz product release. || Whats-New.hts description meta tags. ction-Topics/

s ] Company.htm
@ [ || FAQshtm Content\D-Reference\ 743 b.. | 12/16/2021 11:5.., File Listwindow paneindicating files
@ [ | Featurel.htm Content\B-Feature-Topics\, 821b... |12/16/2021 11:5... that héwe V,‘:].|il]:IeS deﬁtzl:‘:g forthe
@ [| Feature2.htm Centent!\B-Feature-Topics', 821b... |12/16/2021 11:5... escription me 9-
@ [ | Feature3.ntm Content\B-Feature-Topics\ 221b... | 12/16/2021 11:5... ~N /
@ [ Featureshtm Content\B-Feature-Tapics\ 820b... | 12/16/2021 11:5.., NS
| |@ | getting-Started him ContentyA-Introduction-Topics\ | 954 b.. | 4/22/2022 11:41... Introduction to topics for the xyz product. |
€ [ [[Homehtm Contentl, 6.35 KB | 12/16/2021 11:5... hor
| @ ||| More-Information.htm | Cantent\A-Introduction-Topics\ 968 b... | 4/22/2022 11:42... Resources to explore regarding xyz product fun... |
@ [[ [ Procedurel.htm Content\C-Procedure-Topics' 892 b... [12/16/2021 11:5..,
@ [ || Procedured.htm Content\C-Procedure-Topics' 837 b... |12/16/2021 11:5..,
@ [ || Procedured.htm Content\C-Procedure-Topics' 823 b... |12/16/2021 11:5..,
@ [ || Procedureshtm Content\C-Procedure-Topics', 822 b... | 12/16/2021 11:5...
@ [ || Tips.htm Content\D-Referencel 743 b... |12/16/202111:5...
| @ [| Whats-New.htm Centent\A-Introduction-Topics\ 965 b... |4/22/2022 11:43... Overview of new features for the latest xyz pro...
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I Optimizing Content

There are a variety of tasks you can perform to optimize your content. This includes adjusting topic
titles, heading tags, file names, index keywords, body text, and meta descriptions. You can also
determine whether or not the search engine considers how many internal links there are to a topic
when considering that topic's search result ranking.

Topic Titles

For Flare Desktop and for search engine providers, the topic title is one of the most important
considerations taken into account when ranking search results. Topic titles are important because
in addition to including important keywords, titles are also highly visible elements in search results.

Where Topic Titles are Visible:
® Flare Search Results
® Web Browsers
B Search Engine Results
® Social Media Bookmarks

Here are some recommendations for improving the quality of your topic titles for search
optimization:

® Give Each Topic a Unique Title Every page in your output should have a unique topic title. It
should also accurately describe the page content.

® Add Only One Title Per Topic A page should have only one title. For best results, it should be
contained in the <Title> tag. In Flare Desktop, you can set the topic title in the Topic
Properties tab of the Properties dialog. You have the option to always use the first topic
heading as the title or you can manually enter a topic title.
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% EXAMPLE In the topic Properties dialog, you can use the first heading in each topic
as the topic title by default. When you use this option, the topic title is not included
within a <head> tag on the page.

-

General

Topic Properties
File Tags
Conditional Tet
Snippet Conditions
Snippet Variables

Language

e

Topic Tite:

|:.-'J\|'.'.E|':'S use first topic heading) {

Topic Style Class: |

Stylesheet: |

If you leave this field
blank, the first
headinginthe topic
will be used as the

topic title.

[] Disable project and target stylesheets

Template Page:

(default)

Description:

You also have the option of manually typing a topic title in the Topic Title field of the
Topic Properties tab. When you use this option, the topic title is included in a <title>

tag within the <head> tag on the page.

General

Topic Properties

File Tags
Conditional Ted
Snippet Conditions
SnippetVariables

Language

Topic Title;

Topic Style Class: |

Stylesheet:

Template Page:

Description:

|Feeding aCat {

When you type afitle in
— the Topic Title box, it
appears on the page
inside a <title> tag within
the <head=tag.

] Disable project and target stylesheets

(default)
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® Contain the Title Tag in the Head Tag Most search engine optimization (SEO) experts agree
that you can improve page rank if you include the topic <title> tag within the <head> tag.

% EXAMPLE Below is an example of the HTML code for a topic title:
<head><title>Feeding a Cat</title></head>

In order for the title "Feeding a Cat" to appear in a <title> tag within the <head> tag,
open the Properties dialog for the topic. In the Topic Title field, type the title:

, When you type afitle in
General — the Topic Title box, i
Topic Title: |Feeding aCat { appears on the page
Topic P rti 5 o . -
opieTropertes Topic Style Class: | inside a <title> tag within
File Tags the <head=tag.
Stylesheet: |
ELTITIE: ] Disable project and target stylesheets
Snippet Conditions Template Page: (default)
Snippet Variables Description:
Language

Below is an example of how the title appears in the Flare Desktop Text Editor:

1 <?xml wversion="1.0" encoding="utf-8"7>
<html =mlns:MadCap="http://www.madcapsoftwa]
lastWidth="307">

ﬁ_{head}{title}b‘eedimg a Cat</titlex

</head>
<body>
<hl>
<MadCap:concept term="Cats" />Fj
<p>This is where we tell you everytl

[%]

This is where the L
topic title appears
in the text editor. []

-1 o I'_n‘I ,1
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® Limit Title Length to 70 Characters Because topic titles display in search engine results,

experts recommend limiting page titles to a maximum of 70 characters, including spaces.
This increases the odds of end users clicking the link.

Your search for "Context Sensitive Help in
MadCap Flare" returned 67 result(s).

ﬁ EXAMPLE Because titles display on search engine results pages, titles should be
limited to a maximum of 70 characters (including spaces).

Context Sensitive Help in MadCap Flare

Testing Context-sensitive Help
Test your context sensitive Help project to verify that the correct Help topj
or from your application.

CSHTesting_Context_Sensitive_Help htm

About Context-sensitive Hel

Because topic itles display in
search engine results, itis
recommended they do not

exceed 70 characters in
length (including spaces).

project

Planning for Context Sensitive Help in MadCap Flare. Learn who is involved, howto plan the CSH, and what tasks need to be done.

CSHAbout_Context_Sensitive_Help.him

Integrating Flare and Pulse

Learn how to integrate a Pulse system with a Flare community. This adds the Pulse social layer and community features to your published

Flare output.
Pulse/nstall/integrating_Flare_and_Pulse htm

Searching a Microsoft HTML Help System

Describes the end user search experience for the Microsoft HTML Help output type. Gives content developers information about how to set

up search in HTML Help.
Search/Searching_CQutputs/Searching_HTML_Help.htm

® Place Important Keywords at the Front of the Title Tag For best results, order keywords in a

title from most important to least important. For example, if you anticipate that your end

users use query terms such as "Online Help Writing," it may be preferable to ensure the terms
Online and Help are at the front of the title tag. For example, "Writing Online Help" or "Online
Help Writing"
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® Place Keywords at the End of a Title If you want to include your company branding or project

name in a title, it is recommended that you place those keywords at the end of the title.

topic title.

% EXAMPLE If you want to include branding keywords, place them at the end of the

~

General

Topic Properties

File Tags
Conditional Tet
Snippet Conditions
Snippet Variables

Language

Topic Title: |.ﬁ.bnut Context-sensitive Help | MadCap Software

A
Topic Style Class: | ;/ \

Stylesheet: \fl_’
[] Disable proid  IFyOU wantto include

. branding keywords,
Master Page: | {default place them at the end of
Description: the topic title.
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Heading Tags
Heading tags are important page elements. Below are some best practices for optimizing your
heading tags:

® |nclude Important Keywords in the <h1> Tag Because the text in the <h1> tags are used for
search categorization, they should always contain important search keywords.

® Limit <h1> Tags to One Per Page You should always apply the <h1>tag to the most important
heading text in a document. As a general rule, it is best to include only one <h1> tag per page.

® Keep <h1> Tags Unique Because search engines score unique pages higher, it is best that the
content of an <h1> tag is unique from other <h1>tags in a project.

CHAPTER 7 182



Index Keywords

Some search engines may also recognize the index keywords that you include. The Flare search
engine also looks at index keywords when ranking search results, so make sure that you insert
important keywords into your topics.

% EXAMPLE Here is an example of an index keyword in the XML Editor.

g - *5 Layout (Web) = Medium (default) = Page Layout a = - M- : > la| - E

Procedure Procedure 1

Lorem ipsuf Molornt amet, consectettr adipiscing elit. Eusce blandit g

Dondc sa lemensum arcu, at gravida puam mollis id. Suspdndig

us maurr, ornare tincidunt qutrum eu, gravida g

Index Keyword
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Body Text

The Flare search engine considers keywords in the body text when ranking search results. While the
search algorithm is different, major search engine algorithms also consider keywords in the body
text.

Best Practices for Body Text

Following are some best practices when it comes to body text.

® |nclude Keywords in the Topic Abstract For best results, carefully craft your paragraphs to
include your most important keywords in the first paragraph of the topic. Flare's search
engine places a high preference on keywords found in this paragraph, which acts as the topic
abstract.

NOTE If you use a meta description, the information in the meta description appears
in the search result instead of the topic abstract. See "Meta Descriptions for Topics"
on page 172.

® Use Important Keywords in Heading Tags You should always include the most important
keywords in the heading tags, as most search engines give headings more weight.

= Apply Emphasis to Keywords Some, but not all, search engines give preference to keywords
where bold or italics are applied. The Flare search engine weighs text with inline tags (i.e,
formatting applied with span tags) slightly higher than regular text.

® Consider the Frequency of Your Keywords Consider the number of times you use a keyword
on a page. Flare's search engine places gives preference to topics that use a keyword often.

® |nclude Hidden/Invisible Text You can optionally include hidden/invisible text as described
below.
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Hidden/Invisible Text

You can modify your project stylesheet if you want to include hidden/invisible text. This makes the
text invisible to the users viewing the topic, but it will be visible to the indexing programs used by
some search engines.

For the Flare search engine, it is acceptable to use invisible/hidden text to influence search results.

You might use hidden/invisible text on additional headings to give the topic more weight with
search engines.

(D IMPORTANT Be careful about using invisible/hidden text for the purpose of keyword
stuffing. For example, you should not include large blocks of hidden text in a topic because
it can lead to major search engine providers temporarily or permanently blocking your
content from their site. For that reason, it is recommended that you always research the
current content standards for your desired search engines.
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HOW TO CREATE A HIDDEN TEXT STYLE

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. Inthe drop-down field on the left, choose Heading Styles from the list. For this example, we
will show you how to create a hidden style class for your h1 tags.

4. Right-click the h1 and select Add Selector from the context menu.

Stylesheet Editor -E] View: Advanced

% Add Selector =

C55 Vanable - M

Heading Styles = | Hide Inherited =) | Medium: (ds
g N
h2 & Add Selecter
:i E: Copy Ctrl+C I Font
h5 E. Paste Ctrl=V I Background
he I Block

I Border
I Box

The New Selector dialog opens.
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5. Inthe Class Name field, type a name for your style. In this example, we will name it

HiddenHI.
e Mew Selector ? >
Manually add selector or choose Cptions.
HTML Element Class Mame
h1 V HiddenH1
@ Advanced Options
ok || cancel

The new class appears in the stylesheet under the h1 tag.

Stylesheet Editor -E] View: Advanced

% Add Selector =il CSS Variable -

Heading Styles *  Hide Inherited (= | Medium:
4 hi ﬁ
HiddenH1 (

h2 I Font

h3

hd I* Background

h> b Block

h6

I Border

[ By

6. Inthe Properties area, expand the Block properties.
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7. Next to the display field, click =] and select none from the drop-down list. Selecting none
here will let you see the element in the XML Editor and Text Editor. It will be visible to web
crawlers and spiders in the code, but completely hidden from your end users in the target
output.

Stylesheet Editor E] View: Advanced | % Add Selector =I CSS Variable + Medium = Opticns -

Heading Styles * Hide Inherited | Medium: (default) *  Show: All Properties =
4 hi Medium: (default)
HiddenH1 h1.HiddenH1
ha I Font
h3
ha I Background
h3 4 Block
hé
display: nane

hanging-punctuation:
letter-spacing:
text-align:

text-indent:

8. Save your changes.
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HOW TO APPLY A HIDDEN/INVISIBLE TEXT STYLE

After you create a hidden/invisible text style, you can apply it to content, such as additional

headings. In this example, we show you how to apply the hidden style you just created to the first-

level heading.

1. Open the desired topic.

2. Add the text that you want to be hidden/invisible. In this example, we will add a duplicate
<h1> heading in a topic.

3. Right-click the structure bar to the left of the heading text and from the context menu, choose
Style Class > h1HiddenH1.

4

hi

[4 =~ | % Layout (Web) - Medium (default) - Page Layout - :51 B E -k~

Wordsg

rocedure 1
Select Node
Cut
Copy
Paste Before consectettr adipiscing elit. Eusce blandit sapidn a d
Paste After
Unbind CuleShiftry | = Create Style Class.
Delet
= Edit Style Class
Mowve 3
£ TedtWrap ’ Reset Style Class
%% Conditions...  Ctrl+5Shift+C
I Mame.. =
= Paragraph... Ctrl+Alt+B 'bOdy-contalner
[A] Font.. Ctrl+Shift+B main Se(:tion
ﬁ Create Snippet... :
1 Create Micro Content... _Ou te r- row
Style Class v -
Sty D . h1.HiddenH1

S

nt
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The illustration below shows you h

ow the hidden text style appears in the XML Editor.

This is the hidden text

hidden text is represented
by an icon within brackets.

= - ﬁ Layout (Web) ~ Medium (default) ~ Page Layout a =

style. If you have markers
enabledintheeditor e - *Procedure 11

| Lorem ipsum dolor rit amet, cansectettr adipiscing elit. Eusce blandit sap

~b -8 - [ - GDE

n

Procedure Procedure 1

Dondc sagittis elemensum arcu, at gravida puam mollis id. Suspdndisse
placerat. Akiquam purus maurir, ornare tincidunt qutrum eu, gravida qhis

finibus telpus nisl.

4. View the new style in your output.

In Flare Desktop, the topic has

does not appear in the output.

CHAPTER 7/

two firstlevel headings, but
the one using the hidden style /> PrOCEdure 1

You are here: Procedures = Procedure 1

Lorem ipsum dolor rit amet, consectetir adipiscing elit. Eusce blg
orci vel, mollis frhngilla mauris. Dondc sagittis elemensum arcu,
fringilla id dnlor. Suspendisse bhbendum imperdiet Korem ac pla
Integer pukvinar lacus libern, eget volutpat enil finibus non. Aligy
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Meta Descriptions

You can use a text editor to add a meta description (summary or abstract) manually to a topic.
However, an easier method is to use the topic's Properties dialog in Flare Desktop to add them.
Meta descriptions are supported for HTML5, WebHelp, and WebHelp Plus targets. See "Meta
Descriptions for Topics" on page 172.

A meta description is typically not an important consideration for ranking results. However, many
(but not all) search engines display meta descriptions as page summaries in search results.

In Flare Desktop, meta descriptions are weighted heavily when ranking search results. In addition,
meta descriptions are used to display topic summaries on the search results page of the output.
This is also true for many, but not all, search engine providers.

If you include a meta description in a topic in an output type using the Flare search engine, the
description will always be displayed as the page summary in the search results, rather than of the
first paragraph of the topic.

¥ EXAMPLE Below is an example of a meta description that has been added using the
topic's Properties dialog.

General
—_— Topic Tite: Cats | Domestic Cats X="
Topic Properties
_— Topic Style Class: W
File Tags Stviechect Type meta ——
esheet: - - elect...
- t descriptionsin
Conditional Tet [] pisable project and target stylesheets this field.
Snippet Conditions Masterpage: (default) v
Snippet Variables Description: This is a great place to start learning everything you need to know about cats. This indudes how to choose,
feed, and train your domestic cats.
Language

\
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% If you decide to include a meta description for your topic, the text you write will appear in
the summary field of the Flare search results. The same is true for some, but not all, major
search engine providers.

When you include a topic
title, it appears here.

—\ —

r search for "Cats" returned 11 result(s).

When you include a ats | Domestic Cats

meta description, it \""pThis is a great place to start learning everything you need to know about C
appears he_n_:__F 7 Animals/Cats/Cats_htm

Download a File About Cats

Download a File About Cats Click the link below to download the a file abo
Animals/Files/PDF/Files_Cats.htm

Feeding a Cat
Feeding a Cat This is where we tell you everything you need to know abou
Animals/Cats/Feeding_a Cat htm

When you exclude a

topic title, the first ™\, Raising Dogs and Cats Together
topic heading ~ Raizing Dogs and Cats Together This is where we give you advice for raisi
appears here. ,&.nim}&ﬂisingMultiples.-"F‘.aising_Dngs_anu:I_Cats_Tngether htm

7 N

When you exclude a
meta description, the
firsttopic heading
and/or paragraph text
appears here.
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Guidelines for Writing Meta Descriptions

While not always used for ranking, most major search engine providers identify content with meta
descriptions as sign of higher-quality content. Also, because end users read meta descriptions and
make decisions as to whether or not to visit a page, it is generally a good practice to write meta
descriptions that satisfy these minimum guidelines:

® Create Readable and Well-Written Descriptions It is beneficial to add a high-quality meta
description to your topics. Just after the title on a search results page, a well-written meta
description can influence a person's decision to click to view a page. This, in turn, typically
improves the quality and quantity of page visits from internet search traffic.

® Provide Searcher with an Accurate Description of Page Content Think of a meta description
as part page summary and part advertisement. You want your descriptions to contain
descriptive keywords, and since it will also be displayed in search results, you want it to be
readable, concise, accurate, and to the point. A description should always provide a summary
of the content on a page. To avoid creating confusion, disappointment, or frustration for end
users, never load a meta description with repetitive keywords, inaccuracies, or promises that
they will find information that isn't actually in the body of the page.

® Contains Between 68-155 Characters Depending on which SEO experts you consult and
where you anticipate the page summary being displayed, you will find a wide variety of
recommendations about meta description length. The short answer is the different search
engine providers impose different limits. However, the Google limit is widely reported as
being 155 characters, so as a general guideline we recommend writing descriptions between
68-155 characters in length.

= Avoid Keyword Stuffing Although it can be tempting to repeat descriptive terms in a meta
description, there is little reason to include the same words and phrases multiple times. For
example, there is no need to stuff a meta description with keywords (i.e., "Toolbar, tool bar,
toolbars, tool bars"). First, this renders the description useless to anyone trying to read the
summary. Also, most major search engine providers will flag keywords in meta descriptions
as spam which can trigger ranking penalties and result in your page (or your entire site) being
disregarded by their search engine.
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File Names

Flare Desktop considers file names in rankings if you do not have a <title> tag in the document.
When the Flare search engine looks at the file names in your project, it considers the following
when listing results:

® Keyword Matches in File Names File names with exact keyword matches are favored. For
example, if you are searching for "choosing a cat," topics containing the keywords "choosing
a cat" will be ranked higher than file names containing "choose a cat" or "choosing cats."

® Do Not Run Keywords Together in File Names For best results with keyword recognition, it is
recommended that you do not run keywords together in file names (e.g., choosingacat.htm).
When keywords run together, there is a greater risk of the keywords not being recognized, as
well as not being parsed properly by search engines.

® Shorter File Names are Better Because file names are part of a URL, studies show that the
general rule of thumb for page URLs is that shorter URLs are better. For example, a file
named "choose-a-cat.htm" would be a more compelling link for an end user to click than a file
named "how-to-go-about-choosing-a-cat-or-a-kitten.htm."

® Use Hyphens While it is a common practice to use underscores in file names (e.g., Choosing_
a_Cat.htm), many search engine providers and SEO experts no longer recommend it because
the underscore is considered by some indexes to be its own word character. While it provides
visible separation between words, one point to consider is that some search engines might
take regular expressions such as "Choosing_a_Cat" and interpret it as "ChoosingaCat."
Because of this, some SEO experts recommend that you use hyphens to represent a space
between keywords. Whichever separator you decide to use, it is recommended that you do
not use periods (.) or blank spaces to separate words in file names. Periods are used by some
computer systems to indicate different file extension types. Blank spaces can cause issues
for Web servers, particularly those running UNIX or Linux.

® Be Aware of Case Because some major search engine providers run indexing systems on
case-sensitive servers (e.g., Apache, Unix, and Linux servers), whether a file name is written in
lowercase or uppercase can make a difference as to whether the file is indexed. For example,
a page named "choosing-a-cat.htm" may be interpreted differently from "Choosing-A-
Cat.htm." It can also lead to search engines creating duplicate page entries, which can result
in error codes when users click links, as well as penalties for content ranking. While it is
difficult to predict how each and every search engine will handle a file name, it is good to pick
your file naming convention wisely and then use it consistently.
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E Contents

E Index

|| choosing a cat
|£] choosing a.cat

| choosing_a_cat

This praject contains files with matching
keywords (i e , exact keywaords with different
separators to represent spaces).

| El choosmgacaf‘,\

E] ch-J-Jsing—a—cal\\

When file names run keywords
together, they are not included in
search results.

% EXAMPLE You have a project with only five topic files. The file name for each topic uses a
different separator to represent the space between keywords (e.g., choosing a cat.htm,
choosing.a.cat.htm, choosing_a_cat.htm, and choosing-a-cat.htm. In addition, one of the
file names runs the keywords together (e.g., choosingacat.htm).

If you were to search for "choosing a cat," note how the search results will list only the
exact matches (i.e., the file name that runs keywords together is not detected as a match).
For example, "choosingacat.htm" is not listed in the results.

a cat.

=]

A

Your search for "choosing a cat" returned 4 resulf(s).

choosing a cat
Delete this text and replace it with your own content.
choosing a cat.htm

choosing a cat

Delete this text and replace it with your own content.
choosing.a.cat.htm <
choosing_a_cat

Delete this text and replace it with your own content.
choosing_a_cat.htm

Search kewwords choosing

choosing a cat

Becausethe search
keywords exactly match
the file names, Flare
Desktop considers the
TOC orderwhen listing
search results.

choosing-a-cat
Delete this text and replace it with your own content.
choosing-a-cat.htm
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Search Result Importance—HTMLS Output

In HTML5 output, the Flare search engine uses a combination of factors to rank search results. The
search engine considers the number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each topic. This is not
recommended unless you have one topic that is linked too many times that it would skew your
search results.

When optimizing your content for HTML5 output, consider if you are going to use Importance in
your searches and tailor your content appropriately. For example, if you plan to use Importance, you
should make sure you link to important topics throughout your output. However, if you do not plan
on using Importance in your searches, you should focus on adding keywords throughout your topic.

See "Setting Search Result Importance” on page 149.
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I Optimizing a Site

You can take actions to optimize the site where your output is published. This includes generating a
sitemap, including a robots.txt file, enabling non-XHTML files in search, showing links, changing
search pagination, and adding search abstracts.

Generating Sitemaps

For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEQ), making it easier for search indexing services (i.e., spiders,
crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine
results are improved.

How to Generate a Sitemap

1. Open a web-based target.
2. Onthe Search tab of the Target Editor, select Generate Sitemap.
3. Inthe Web URL field enter the path where the output is ultimately published.

¢ EXAMPLE https://help.madcapsoftware.com/flare2026/

NOTE Be sure to include the full path—including "https://"—when entering the web
URL.

4. Click[&l to save your work.
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Including a Robots.txt File

A robots.txt file is typically implemented by a website developer or website owners. It is used to
advise search engine robots and spiders about what site content can and cannot be crawled. The
robots.txt protocol is a simple text file that you can create in a text editor.

There are several reasons why you may want to consider creating a robots.txt file to use with your
published output:

® Block Access to Content If you do not want the robot or spider to crawl certain content, you
may want to publish those content files in a password-protected directory and include a
robots.txt file. It is recommended that you work with your website or web server
administrator to ensure your requirements are met.

® Block Access to Specific Files and/or Folders If you have specific content that want to block
from search engines, you can advise cooperating robots and spiders to exclude that content
from their index. Keep in mind that most major search engines cooperate with these
instructions. However, some search engines do not.

® Block Your Site from Specific Search Engines If you would like to block a specific search
engine from crawling your site, you can advise its robot or spider to exclude your site from its
index. To be successful, the robots.txt file must explicitly define the robot to block by name
and the spider must be programmed to cooperate with your instructions.
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How to Include a Robots.txt File

. Open a text editor.

N =

Create a new file and name it "robots.txt."

w

Include the desired instructions.

TIP To learn what to include in a robots.txt file, see http://www.robotstxt.org/. You

should discuss specific requirements with your web server administrator and/or
website developer.

4. Place the file at the root of the website hosting your published content.

ﬁ EXAMPLE You plan to publish your Help content to a site named:
https://www.help.example.com
In this scenario, you should place the robots.txt file at the root of the site:

https://www.help.example.com/robots.txt

5. Publish your content and ensure the robots.txt file is still in place.

6. Test your robots.txt using a validation tool. Some major search engines provide their own
testing tools (e.g., Google) .
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NOTE Most major search engines (e.g., Google, Bing, and Yahoo) are known to
cooperate with the instructions in a robot.txt file. However, many search engines also
have the ability to discover information using other methods. For example, let's say
you have blocked a file named "form_1.html" in robots.txt. However, another website
has created a link on their site to your "form_1.html" page. In this scenario, the URL
for that linked page may be included in an engine's search results.

NOTE It is also generally understood that there are existing search engines, including
malicious ones, that do not cooperate with the robots.txt protocol. Be sure to work
closely with a web developer or your web host to ensure you get the best results
possible with your robots.txt file.
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Enabling Non-XHTML Files in Search

Because search engines have added non-HTML formats to their search indexes, it is helpful to
enable non-XHTML search in your output. This allows the Flare search engine to return matches for
non-HTML content in your project (e.g., PDF, DOC, and XLS files). You can enable non-XHTML
search in the HTML5 and WebHelp Plus server-based outputs. See "Including Non-XHTML Files in
HTMLS5 Search" on page 257.

Showing Links

You can add a link to the top or bottom of topics in HTML5, WebHelp, or WebHelp Plus outputs.
This link will not display unless the output topic is opened as a standalone (outside of the main
navigation framework of the output). By clicking the link, a user can view the standalone topic in the
main navigation framework.
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Changing the Number of Search Results Per
Page

You can change the number of search results that appear on each page in HTMLS5 outputs. This
makes it easier for users to navigate between pages of search results and improves search result
loading times, especially for users who access your output from a mobile device. In order to use
this feature, you must be using Elasticsearch or MadCap Search. This is feature is not suppoted for
Google Search. See "Setting Up a Search Engine" on page 50.

Your search for "cats NOT dogs" returned § result(s).

Cats | Domestic Cats

This is a great place to start learning everything you need to know about Cats
Cats/Cats htm

ing how to choose, feg

Choosing a Cat Your search
Choosing a Cat There are many different types of cats in the world. Wit  retumed eight hoose f
Cats/Choosing_a_Cat htm results.

Training a Cat

Training a Cat Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod
Cats/Training_a_Cat htm

Feeding a Cat Becausethe paginationis
Feeding a Kat This is where currently setto ShU'"-"'-_" ﬂ_"-"'e results Eeding cats:
Cats/Feeding_a_Cat htm per page, the remaining three

results display on the next page.

Feeding an Adul

Feeding an Adul
Cats/Feeding

his is where we tell yvou everything you need to know about feeding an adult cat.
FAdult_Cat.htm
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Changing the Abstract Character Limit in Search
Results

In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search
results, while keeping the search results page easy to scan. You can set the character limit as long
or as short as you like. When creating an automatic abstract, Flare Desktop scans all text elements
in the topic, including headings and paragraphs, and includes them in the abstract until the
character limit is met. This feature is only supported for MadCap Search. See "Setting the Search

Abstract Character Limit" on page 140.

This abstract is
/ 300 characters.

~T799) was the first President of the
uring the American Revalutionary VWar,

George ‘Washington

George Washington (February 22, 1732 [0.5. February 11, 1731] — Decembe
United States (1789-1797). the Commander-in-Chief of the Continental Ar
and one of the Founding Fathers of the United States. He presided over ..
B_Feature Topics/George Washington.htm

This abstractis
/ 400 characters.

mber 14 1799) was the first President of the
nental Army during the American Revolutionary YWar,
e presided over the convention that drafted the United States

George VWashington

George VWashington (February 22, 1732 [0.5. February 11, 17,
United States (1789-1797), the Commander-in-Chief of

and one of the Founding Fathers of the United S .
Constitution, which replaced the Aricles of .=
B_Feature Topics/George Washington_htm

You can also add a manual search abstract using meta descriptions in the topic's Properties dialog.
See "Meta Descriptions for Topics" on page 172.
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I Ranking Search Results

The Flare search database generates organic search results and looks at numerous signals,
factors, and metrics to determine how relevant the results are to the query terms. Understanding
how searches are ranked in the different output types helps you determine strategies for optimizing
your search results.

Ranking Results—HTMLS5, WebHelp

Flare's search engine uses content signals and content weighting to determine search rankings.

NOTE In HTMLS5 outputs, the Flare search engine uses one additional concept to rank
search results: Importance.

A topic's importance is determined by the number links to a topic in the output. A topic that
is linked from ten other topics is more important than a topic that is only linked from one
other topic. See "Setting Search Result Importance" on page 149.

Content Signals

When end users enter their query terms in output, the search engine looks at a variety of signals,
such as:

® Do the search terms occur in the topic title?

® Do the search terms occur in a heading tag, and at what level (e.g., H1, H2, H3)?
® Do the search terms occur in the abstract text or meta description?

® Do the search terms occur in an index marker in the topic?

® Do the search terms occur in a glossary term?

® Do the search terms occur in the topic's body?

® How many times do the search terms occur in each location (e.g., topic title, hyperlinks, body
text)?

These items are used to determine the topic's search ranking against other topics.
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Content Weighting

As with most search engines, Flare Desktop takes a variety of factors into account when ranking its
search results. Since retrieved results are relative to the search query and indexed content, the
following describes in general terms how different content elements are ranked.

Micro Content Search Results

If you create micro content, Flare Desktop considers only the text in the phrases and alternate
phrases for the micro content search results. The content in the response associated with each
phrase is not weighed. So the response that is paired with the phrase most closely matching the
search query (or having the most weight) is used. If you want to help boost a particular micro
content phrase/response so that it displays when a certain search term is used, you can add more
keywords to the phrase or alternative phrases for that response.

Regular Search Results

1. Title Tags

The topic title lets readers know the topic of a particular page. It is placed in a <title> tag,
within a <head>tag in HTML documents. You can add a topic title by right-clicking the topic
in the Content Explorer, and selecting Properties from the context menu. In the Properties
dialog, click the Topic Properties tab, and enter text in the Topic Title field.

You also have the option to leave the Topic Title field blank. If you do this, the first topic
heading will be used as the topic title by default.

Topics with a keyword in the <title> tag appear first in search results, and always are ranked
higher than topics where a keyword appears elsewhere in the topic, regardless of how many
times the keyword appears. This helps you find the most expected topics when searching.

NOTE If you do not have a <title> tag in your topic, Flare Desktop uses the first
heading in the topic as the title tag for the file. If there are no headings in the topic,
the file name acts as the title tag. This text is given the same search ranking as a
<title> tag.

2. H1 Tags
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3. H2 Tags
4. H3 Tags
5. H4 Tags, Index Keywords in Topics

NOTE If you do not want index keywords to be considered when retrieving search
results, you can exclude them from the search. See "Excluding Index Entries From
Search" on page 161.

6. HS5 Tags, Glossary Terms
7. H6 Tags, Keywords in Body Text
8. Keyword Frequency

The search engine looks at how many times the search term appears in each topic. Topics
with frequent keywords are ranked higher than topics with fewer keywords.

NOTE While topics with more frequent keywords are ranked higher, they will never
outrank a keyword with a higher base weighting.
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higher in the search results than the second topic.

ﬁ EXAMPLE You have two topics that are almost identical. However, the search term
appears in a Heading 2 three times in the first topic and only two times in the second
topic. Because the search engine accounts for frequency, the first topic will appear

Your search for "food" returned 7 resul

In this topic, the search term
appears in three Heading 2s,
soitis ranked first.

Feeding an Older Cat

Feeding an Older Cat This is where wi
some text Wet Food This is some text Dry Food This is somae t
Cats'F -_'-_'l:|lllg_;j"_:_: da _L;gll hm

Feeding an Adult Cat

Feading an Adult T3t This is whera wa tell you everything you n
some text Wt Food This is some te
Cats/Feeding_an_»Adult_Cat htm

Eeeding a Parrot
This is where we show you how to feed a pamrat. Provide Your P,
food as it provides your birds with reguired vitamins and rminesal
not respond to cemain colors. This is
Parrols/Feedmng_a_Parrot.htm

Cats | Domestic Cats
This 15 a grest place to star learming averything you need to kno
domestic cats
Cats/Cats.htm

Eeeding a Harmsler
Feeding a Harnster This is where we tell you how to feed your p
Hamsters/Feeding_a_Hamster htm

In this topic, the search term

itis ranked second.

In the remaining topics, the
search term appears
elsewhere in the topic.

1 2 Mg

appears in two Heading 2s, so

faur
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EXAMPLE You have two topics. In the first, your search term appears many times,
all in Heading 4s. In the second it appears once, in a Heading 3. The second topic will
appear higher in the search results because even though the search engine accounts
for frequency, search terms that appear in a Heading 3 still take priority over search
terms that appear in a Heading 4, regardless of how many total times they appear in
the topic.

Your search for "food" returned 7 result(s).

Feeding an Older Cat

Feading an Oldar Cat Ths is whars w L is
some text This is soma text This is some tex In this tﬂpic the search term
Cats/Feeding_an_0ider_Cat_htm . .

appears in one Heading 3.
Eeeding an Adult Cat
Feeding an Adult Cat This is wherg we tell you everything you nek i

some text Wet Food This is same
Cats/Feeding_an_Adull_Cat kit

Dry Food This is sorme text Cat Food This is some text

Feeding a Parrat
This is where we show you how to feed a pam
fond as it prondes your berds with reguirad wtam
not raspond to certain colors. This is
Parrots/Feeding_a_Parrot.htm

Cals | Domestic Cats

o 24 1IN this topic, the search term |
<] Aappearsinfour Heading4s. |
Even though there are more
instances of the seach termin
Ell;:ien:;cgg;a; place to stan leaming everything you need to k th|5 t[}pic: the Heading 3 i5
Cats/Cats htr ranked higher, so it appears
firstin the results.

Feeding a Hamstar
Feading a Hamster This is whare we tall you how 1o feed your 2 |
Hamsters/Feeding_a_Hamster htm

1 2 Mext

NOTE Some search engines might also consider the text in a "description” meta tag that
you add for a topic (e.g., <meta name="description" content="Here is my description of this
topic." />). However, some search engines do not include this text in search rankings.
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Ranking Results—Server-Based HTMLS5 and
WebHelp Plus

If you enable server-based output for HTML5 or WebHelp Plus, the Flare the search engine is
supported by one of these tools:

® Microsoft Indexing Service To learn about the Microsoft Indexing Service, see Microsoft's
documentation. Here is a link to get you started:

http://technet.microsoft.com/en-
us/library/cc723263.aspx#XSLTsection123121120120

® Windows Search Service To learn about the Windows Search Service, see Microsoft's
documentation. Here is a link to get you started:

http://msdn.microsoft.com/en-us/library/windows/desktop/aa965362(v=vs.85).aspx

See "Enabling HTMLS Server-Based Output” on page 241.

Ranking Results—Eclipse Help

Search is provided by the Eclipse platform. You can configure a variety of different search options
in Eclipse. For more information, see the Eclipse documentation: help.eclipse.org.
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CHAPTER 8

Search Filter Sets

A filter can be included in the search feature to let users narrow their search based on concepts
that you have inserted into topics. Concepts are simply markers that you add to topics that have
some kind of relationship with each other. They are also used for inserting concept links into topics.

NOTE Search filters are not supported in Elasticsearch.

This chapter discusses the following:
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Creating Search Filters ... . 219
Customizing Search Filter Ordering ...........ccoooiiiiii 221
Associating a Search Filter Set Witha Target ... 223
Search Filter Set Example ... 224
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I Adding Search Filter Set Files to
Projects

Supported In:

WEB
HELP

HTHML

5|

The first step to using a search filter set is to add a special file for it to your project. A search filter
set file has an .fIsfs extension and is stored in the Project Organizer under the Advanced folder.

WEB

HELP
PLUS

How to Add a Search Filter Set

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Search Filter Set.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.
2. Inthe File Type field at the top, make sure Search Filter Set is selected.
3. Inthe Source area, choose to create the new file based on a template or an existing file.

® New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

® New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click =, use the Open File dialog to find a file, and
double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click 2] and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, type a new name for the search filter set.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click [z] and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click ] and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

What's Next?

After you add the new search filter set, you need to insert concepts into topics (if you have not
already done so0). After that, you can create search filters based on the concepts that you inserted.
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I Importing Search Filter Sets

Not only can you add new search filter sets, but you can also import an existing search filter set
(FLSFSfile).

How to Import a Search Filter Set

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Search Filter Set.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.
2. Select New from existing and click [==].
3. Find and select the FLSFS file that you want to import.

4. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.

5. If you want to give the search filter set a different name than that for the imported file, click in
the File name field and replace the text.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click =] and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click =] and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added and opens in the Search Filter Set Editor.
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| Opening a Search Filter Set

The following steps show you how to open a search filter set that you have added to your project.

How to Open a Search Filter Set From the Quick

Launch Bar

The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the
upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the

Quick Launch bar so you can begin typing.

= ” # Quick

L = =l _.':quic
Attributes Find and o
Window Replace in Files ~ @ Fin

Attributes Find and Repl Properties

The Quick Launch bar
appears in the upper-right
comer of the interface.

1. Inthe Quick Launch bar, type a few letters of the name of the file you want to open. Any

available results appear in a drop-down list.

2. From the list, click the name of the file.

How to Open a Search Filter Set From the

Project Organizer

1. Open the Project Organizer.

2. Double-click the Advanced folder. The search filter sets in your project are displayed.

3. Double-click the search filter set that you want to open. The Search Filter Set Editor opens to

the right.
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I Inserting Concepts

You can open a topic and use the top area of the Concept window pane to insert concepts into that
file.

Drag-and-Drop Method

Use this method to quickly insert a concept that already exists in your project.
® Advantage It is extremely fast.

® Disadvantage The concept that you want to insert must already exist in the project. This
means you must first insert the concept into a topic using one of the other methods.

How to Insert a Concept Using the Drag-and-Drop
Method

1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter|:| between them and drag it up or down.

3. Inthe bottom (explorer) area of the Concept window pane, click the concept and drag it to the
location in the topic where you want to insert it. As you drag the concept into the topic, a
vertical red bar acts as a guide to help you place the concept in the topic. The concept is
displayed within a marker in front of the word where you added it (as long as markers are
turned on). A marker can hold multiple concepts, but most times you only need one concept
per marker.

4. CIicklE' to save your work.
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Concept Window Pane Method

Use this method to insert a concept in the Concept window pane.

® Advantage It lets you continue to perform other tasks in the topic without having to "switch
modes."

® Disadvantage It is not quite as fast as the other methods.

How to Insert a Concept Using the Concept Window
Pane Method
1. Open the content file.
2. Click at the location where you want to insert a concept.
3. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.
The Concept window pane opens.
4. Click in an empty field in the Terms column.
5. Type the concept as you want it to appear.

6. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

7. CIicklE' to save your work.
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Concept Entry Mode Method

Use this method to accomplish the same thing as the Concept window pane method. The
difference is that, with this method, you do not need to move your cursor from the topic to the
Concept window pane. You simply click at the spot in the text where you want to insert the keyword
and start typing. The words you type are added directly into the Concept window pane. This is a
good method to use if you plan to create concepts in a lot of topics all at once, without performing

any other tasks in the topic.
® Advantage It is extremely fast.

® Disadvantage If you are adding a concept as you work on a topic, you need to remember to
switch off the Concept Entry Mode so that you can return to editing your topic.
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How to Insert a Concept Using the Concept Entry Mode
Method

1. Open the content file.

2. In the local toolbar of the XML Editor click (€]

3. Click at the place in your topic where you want to add a concept.
4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.

NOTE As you type in the Concept window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you

are adding the concept. When you return to the XML Editor, the cursor returns to its

previous state.

5. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

6. If you want to add more concepts in the topic, repeat steps 3-5.
7. CIicklE' to save your work.

To turn off the Concept Entry Mode and return to regular editing, you can click again.

What's Noteworthy?

NOTE If you want to see all of the concepts that you have inserted in your project, they are
displayed in the bottom portion of the Concept window pane.
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| Creating Search Filters

After you add a new search filter set and insert concepts into topics, you can create search filters,
which let users narrow their search based on concepts that you have inserted into topics.

How to Create a Search Filter

1.
2.

Open the Project Organizer.

Double-click the Advanced folder. Any search filter sets that you have added are listed. See
"Adding Search Filter Set Files to Projects” on page 211.

Double-click the search filter set in which you want to create a search filter. The Search Filter
Set Editor opens to the right. By default, Flare Desktop provides you with an initial search filter
called "subset,” which you can rename and use.

To create a new search filter, cliokE in the local toolbar. A new search filter row is added,
with a temporary name for the search filter.

To enter a new name or comment for a search filter, do one of the following.
® Double-click in the appropriate cell and type the name or comment.

® Click once in the appropriate cell and press F2 on your keyboard. Then type the name or
comment.

To associate a concept with the search filter, click the Concepts cell. The Select Concepts for
Search Filter dialog opens. The concepts that you have inserted into topics are listed on the
right side of the dialog.

In the All Concepts section, click on a concept that you want to add to the search filter. Then

cIick.

The concept is added to the "Selected Concepts" section on the right side of the dialog. Do
this for each concept that you want to add to the search filter.

NOTE If you do not associate a concept with the search filter, the search filter will
not appear in your output.

Click OK.

CIicklE' to save your work.
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NOTE When merging projects in WebHelp and HTML 5 output, only the parent project's
concepts and search filter sets retained after the merge. You will not be able to find the
child project's topics even if the concept links are identical. A workaround is to create an
external resources folder that all the projects share and put the search filter set in that
folder. .
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| Customizing Search Filter Ordering

Supported In:

WEB
HELP

HTML

5|

By default, search filters display alphabetically. However, you can customize the ordering of the
search filter set so they display in the order that is most useful for your audience.

AllFies v O
All Files
First Fitter
You can customize search cccond Fiter
filter order if you don't want to .
use alphabetical ordering. Last Fiter
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How to Customize Search Filter Ordering

1. Open the Project Organizer.
2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the order displayed in the output.

4. In the Filter Name column, select the filter you want to move.

5. To customize the order of the filters, do one of the following:
» Click[4] or [ in the local toolbar.
® Select Move Up or Move Down from the context menu.
6. (Optional) To reset the search filters to alphabetical order, click .

7. CIicklE' to save your work.

NOTE You can create search filters for merged projects in WebHelp and HTML 5 output.
However, when you merge projects, ordered search filter sets are separated by project in
the output. To control the order of the search filters from all of your merged projects, you
can create an external resources folder that all the projects share and put the search filter
set in that folder.
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| Associating a Search Filter Set With a
Target

After you create search filters, you need to associate the search filter set with the target that you
want to build.

How to Associate a Search Filter Set With a
Target

1. Open the target that you plan to build.
2. Inthe Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. CIicklE' to save your work.
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| Search Filter Set Example

Concepts and search filters might seem a little confusing to you at first. The following example is
designed to help make these ideas clearer and guide you through the steps for creating your own
search filter by using concepts.

Scenario

Let's say we have a Flare project called "Pets." In this project, we have dozens of topics about all
kinds of animals (cats, dogs, parrots, hamsters, and so on). We have written five topics about dogs.
These are:

® Choosing a Dog
® Feeding a Dog
® Training a Dog
® Grooming a Dog
® Walking a Dog

We want our users to be able to search for information about dogs. However, we want to limit their
search to these five topics (so that they aren't bothered with seeing search results in other "non-
dog" topics). We'll use a concept to tie our five "dog" topics together, and then we'll customize the
search feature to include this concept.
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Step 1—Create and Insert a Concept

First, we need to create a concept to tie these five topics together. We can create a concept with
any name that we want, but it helps to name the keyword something that is obvious and all topics
have in common. Therefore, we'll give our concept the name "dogs."

1. Open any of the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topic where you want to insert the concept. Typically, you'll insert
the concept somewhere near the top of the topic. In our example, we will click right before our

topic title "Choosing a Dog."

3. Do one of the following, depending on the part of the user interface you are using:

® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. The cursor should already be placed in the Terms cell. If not, click in that cell. Then type dogs
and press ENTER. A concept marker labeled "dogs" is added before the topic title. If you
cannot see the marker, you need to turn your markers on by clicking the down arrow next to

the Show tags button in the XML Editor. Then select Show Markers.

= Choosing_a Dog.htm AL S — Concepts v I x
"B Choosing_a_Dog.htm = Start Page x Fee

[ ~ | % Layout (Web) = Medium (default) = Page L i
Here is the

concept
keyword marker.

h?

Dog Dogs Choosing a Dog

choosing a dog, some important this to consider

include:

animal-oriented websites provide dog breed

» [Use an Online Dog Breed Selectorj Many

-

This is where we explain how to choose a dog. When

Enter Concepts:

Terms

»

22 Concepts
Cats
v Dogs

‘@ Animals/Dogs/Choosing_a_Dog.htm
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Step 2—Copy and Paste the Concept Marker
Into All Relevant Topics

Next, we need to place the same concept marker in our other four "dog" topics. We could repeat the
same steps above for each topic, but we'll copy and paste our first concept marker instead.

1. Inthe "Choosing a Dog" topic, click on the concept marker and choose Select.
2. Press CTRL+C on your keyboard.

3. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic
title (or somewhere near the top of the topic), and press CTRL+V on your keyboard. Repeat
this until you've pasted the concept marker into all five of the "dog" topics.

Step 3—Add a Search Filter Set and Create a
Filter

Now that we have the concepts in place, we can create a search filter for the "dog" topics.
1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Search Filter Set.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.

2. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

3. Click in the cell under the Filter Name column until "My Subset" is highlighted. Type Dog
Topics and press ENTER.

4. Click in the cell under the Concepts column. The Select Concepts for Search Filter dialog
opens.

5. In the Selected Concepts section, double-click dogs. The concept is added to the "All
Concepts" section on the left side of the dialog.

6. Click OK.

7. Click[&ll to save your work.
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Step 4—Customize Search Filter Ordering

If you have created multiple search filters, you can rearrange them to best suit the needs of your
audience (in web outputs). By default, they are alphabetical, but you want to move the "dog" filter to
the top of the list.

1. Open the Project Organizer.
2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the displayed order in the output.

4. In the Filter Name column, select the "dog" filter.

5. To customize the order of the filters, do one of the following:
" Clickm or in the local toolbar.

" Select Move Up or Move Down from the context menu.
6. (Optional) To reset the search filters to alphabetical order, click =)

7. Click[&ll to save your work.
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Step 5—Associate the Search Filter Set With a
Target

Finally, we need to make sure the search filter set that we created is associated with the target that
we plan to build.

1. Open the target that you plan to build.
2. Inthe Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. Click[wl to save your work.

Now when people use the search feature in our output, they can select "Dog Topics" from the Filter
field to limit their search to our five "dog" topics.

What's Noteworthy?

NOTE Search filters are not supported in Elasticsearch.
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CHAPTER 9

Search Highlighting

WEB
HELP

Supported In:

HTML

M5
HTML
HELP

When users initiate a search query, the search hits (i.e., the matching keywords and phrases) may
be highlighted when the individual topics are opened. This feature is called "search highlighting" and
it is supported for simple text search and phrase search. Note that when searching with wildcard
characters, the search feature will not apply highlighting to search hits.

This chapter discusses the following:

Search Highlighting in Online Outputs ... 230
Turning Off Search Highlighting in Flare's Output ........................... 231
Customizing the Highlight Color for Search Hits ............................. 232
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| Search Highlighting in Online Outputs

Online output types use a highlight color when revealing search hits. HTML5 Tripane output shows
highlights words in color by default. In Side and Top Navigation outputs, search results are
transparent, but you can customize this, adding colors. See "Customizing the Highlight Color for
Search Hits" on page 232.

In Eclipse Help, search highlighting is provided by the Eclipse platform and cannot be changed
using Flare Desktop.
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I Turning Off Search Highlighting in
Flare's Output

If you search in a Help system and open a topic from the search results, terms are automatically
highlighted in the topic. To turn off the highlighting, click £ in the upper-right of the topic.

You are here: Step 2: Adding Content and Features = Snippets [-E-] gx
Snippets PDE
Outputs Supported Q Getting Started Tutorial

[=]

A snippet is a chunk of formatted content that is heavily used in single-sourcing.
Snippets can include text, tables, images, and whatever else can be included in a
normal topic. You can insert snippets into one or more topics throughout your
project, thus allowing you to reuse content that is maintained in one place. You can
even insert them into other snippets, creating nested snippets.

Getting Started User Guide

- Single-Sourcing Tutorial

IIO:

E| Snippets User Guide

' General Information

= Benefits of Snippets Video

= Snippet Files ® Getting Started

= Text and Block Snippets August 2,202

1:04:32
= Snippets and Auto Suggestions
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I Customizing the Highlight Color for
Search Hits

Supported In:

HTHML

M5
HTML
HELP

When users perform searches in your online output, the keywords that are found may be
highlighted in the topics. The background for each term found in a topic can be highlighted in a
different color. In Flare Desktop you can use styles to change not only the color background, but
other settings as well (e.g., font style, text decoration).

WEB
HELP

Customizing the highlight color for search hits is useful when you want to coordinate the visual
elements of your online target with a color palette or scheme. It can also be used to improve the
accessibility of your documentation. For example, if you are developing a project for an audience
with impaired vision, you might want to customize the search highlighting to provide users with a
higher color contrast.

For most types of output, you can customize the highlight color using span styles (e.g.,
span.SearchHighlight1, span.SearchHighlight2) in a regular stylesheet. For HTML5 Tripane output,
this is done in the Skin Editor instead.
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% EXAMPLE You have the following three classes: span.SearchHighlight1,
span.SearchHighlight2, and span.SearchHighlight3. For span.SearchHighlight1, you change
the background color to blue. For span.SearchHighlight2, you change the background color
to orange. And for span.SearchHighlight3, you change the background color to yellow.

If a user enters "topic information help find" in the search field, the term "topic" will be
displayed with a blue background everywhere it occurs in a topic. The term "information”
will be displayed with an orange background, and the term "help” will be displayed with a
yellow background. The term "find" will be displayed with the default background color
specified by Flare Desktop (since you did not change it).

If another user enters "help find topic information" in the search field, the term "help" will be
displayed with a blue background. The term "find" will be displayed with an orange
background, and the term "topic” will be displayed with a yellow background. The term
"information” will be displayed with the default background color specified by Flare Desktop
(since you did not change it).
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How to Customize Search Highlight Colors

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Complete one of the following sets of steps, depending on whether you want to use the
Simplified view or Advanced view in the Stylesheet Editor.

= Simplified The Simplified view displays styles in a grid view and is often best for brand
new users.

This view provides an easy way to apply properties to styles, with format options
available from a toolbar and dialogs (similar to the way one would use an interface
such as Microsoft Word). In some cases, only the most common property options are
available in the Simplified view (e.g., font, letter/word spacing, paragraph
alignment/indentation, autonumbering format, borders, background). One advantage of
the Simplified view is that you can apply a property to multiple styles at the same time.
You can also click a check box to hide the properties in the editor, allowing you to see
only the styles.

® Advanced The Advanced view displays styles in a tree structure, and despite the name,
is user friendly for authors of all levels.

For the properties, you can toggle between a grouped display and an alphabetical
display. The Advanced view of the Stylesheet Editor lets you edit more settings than are
available in the Simplified view. In addition, the Advanced view lets you see and apply
settings to multiple mediums and media queries at the same time.

IF USING SIMPLIFIED VIEW
a. Inthelocal toolbar, make sure the first button displays (which means

that the Simplified view is currently shown in the editor). If the button displays

instead, then click it.

b. Inthe upper-left corner of the editor, click in the drop-down field and select
|Character Styles - |

c. (Optional) If you have an older stylesheet that does not yet contain the appropriate
span classes you need for search highlighting, you can create them. You can do this for
a main "SearchHighlight" class, as well as for the first 10 terms that users enter in the
search field, naming each class "span.SearchHighlight1," "span.SearchHighlight2," and
so on until you create "span.SearchHighlight10." The easiest way to create these
classes is to import them from a Flare factory stylesheet, but you can also create them
manually.
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TO IMPORT THESE CLASSES FROM A FLARE FACTORY STYLESHEET

i. Inthe local toolbar, click the Options button and select Import Styles. The Import
Styles dialog opens.

i. Inthe Library Folders section, make sure Factory Stylesheets is selected.

ii. Inthe Stylesheets section, select SearchHighlight.

(Optional) In the [Medium] drop-down list, you can select a specific medium. This
determines the medium to which the styles are imported in your current
stylesheet. If you select "default," the imported style properties will be applied to
all of the mediums in the other stylesheet. If you select a custom medium, the
imported style properties will be imported to that medium in the other stylesheet.

2.

v. Inthe section below, click the Import check box next to each style class named
span.SearchHighlight followed by a number. There are 10 of these style classes.

vi. Click OK. The style classes are added to the current stylesheet.

TO CREATE THESE CLASSES MANUALLY
i. From the grid in the bottom portion of the Stylesheet Editor, select the span tag.

ii. Inthelocaltoolbar, click [5_Add Selector] The New Selector dialog opens.

iii. Enter searchHighlight1 (orreplace 1 with another number at the end, up to
10).

iv. Click OK.

d. Select the style class that you want to modify. If you select the main SearchHighlight
class, the same color will be used for all search terms found. Otherwise, you can select
a numbered SearchHighlight class (e.g., SearchHighlight1, SearchHighlight2) to set
individual colors for different terms found.

e. In the local toolbar of the editor, click [2]. The Properties dialog opens.
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f. Use the Properties dialog to change values for the style's properties.

ﬁ EXAMPLE You want to change the background color for the class
span.SearchHighlight1. After you select that class on the left you can select the
Font tab in the Properties dialog. Then click the down arrow in the Background
field and choose the color you want.

g. Inthe Properties dialog, click OK.

IF USING ADVANCED VIEW

a. Inthelocal toolbar, make sure the first button displays . If the button
displays instead, then click it.

b. Inthe upper-left corner of the editor, click in the drop-down field and select
|Generateu:| Content Styles *|'

c. (Optional) If you have an older stylesheet that does not yet contain the appropriate
span classes you need for search highlighting, you can create them. You can do this for
a main "SearchHighlight" class, as well as for the first 10 terms that users enter in the
search field, naming each class "span.SearchHighlight1," "span.SearchHighlight2," and
so on until you create "span.SearchHighlight10." The easiest way to create these
classes is to import them from a Flare factory stylesheet, but you can also create them
manually.

TO IMPORT THESE CLASSES FROM A FLARE FACTORY STYLESHEET

i. Inthe local toolbar, click the Options button and select Import Styles. The Import
Styles dialog opens.

ii. Inthe Library Folders section, make sure Factory Stylesheets is selected.
iii. Inthe Stylesheets section, select SearchHighlight.

iv. (Optional) In the [Medium] drop-down list, you can select a specific medium. This
determines the medium to which the styles are imported in your current
stylesheet. If you select "default," the imported style properties will be applied to
all of the mediums in the other stylesheet. If you select a custom medium, the
imported style properties will be imported to that medium in the other stylesheet.
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CHAPTER 9

v. Inthe section below, click the Import check box next to each style class named
span.SearchHighlight followed by a number. There are 10 of these style classes.

vi. Click OK. The style classes are added to the current stylesheet.

TO IMPORT CREATE THESE CLASSES MANUALLY
i. Onthe left side of the editor, select the span tag.
ii. Inthelocaltoolbar, click. The New Selector dialog opens.
iii. Enter searchHighlight1 (orreplace 1 with another number at the end, up to
10).
iv. Click OK.

Select the style class that you want to modify. If you select the main SearchHighlight
class, the same color will be used for all search terms found. Otherwise, you can select
a numbered SearchHighlight class (e.g., SearchHighlight1, SearchHighlight2) to set
individual colors for different terms found.

From the Show drop-down list on the upper-right side of the editor, select
| Show: All Properties = |

(Optional) You can use the toggle button in the local toolbar to show properties below
inagroup view or an alphabetical view .

Locate the property you want to change. Not only can you change the background
color, but you can change any other property for the class as well.

The area to the right of the property is used for selecting and entering values. If you
know how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button =] to the right of the property. Depending on
the type of property, the appropriate controls and options display, allowing you to
choose or enter values (e.g., select from a drop-down list, click a button, complete
fields in a dialog or popup). If you completed values in a popup, click OK at the bottom
of the box.
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% EXAMPLE You want to change the background color for the class
span.SearchHighlight1. After you select that class on the left you can open the
Background property group on the right side of the editor. Then to the right of
background-color, click ], then choose the color you want.

3. Click[&ll to save your work.
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How to Customize Search Highlight Colors—
HTMLS Tripane Only

Use the following steps if you are creating HTML5 Tripane output. If you are creating HTML5 Side
Navigation, Top Navigation, or skinless output, use the steps above for doing this in a stylesheet.

1. Inthe Project Organizer, open the Skins folder.

2. Open the desired HTML5 Tripane skin.

3. Inthe Skin Editor, click the Styles tab.

4. On the left side of the editor, in the Search Results section, expand the Search Highlight style.
5

. If you want the setting(s) to be applied to all of the items, complete the fields under the main
Search Highlight style itself. Otherwise, expand any of the child styles (Search Highlight 01 to
10) to apply settings to them individually. Each search highlight style is numbered to
coordinate with the order search terms are entered. For example, the style named "Search
Highlight 01" will be used for matches to the first search term entered and "Search Highlight
10" would coordinate with the tenth entered term. You can customize up to 10 highlight
colors.

6. CIicklE' to save your work.

What's Noteworthy?

NOTE Search highlighting for Eclipse Help is provided by the Eclipse platform. Highlight
colors for search cannot be modified in Flare Desktop.
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CHAPTER 10

Server-Based Search HTML5

For HTMLS5, there are additional tasks that you can perform when producing server-based output.

This chapter discusses the following:

Enabling HTMLS5 Server-Based Output ... 241
Including Non-XHTML Files in HTMLS Search ................................. 257
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| Enabling HTMLS Server-Based Output

You can create HTMLS output in its regular state, or you can select an option in the Publishing tab
of the Target Editor to enable server-based functionality.

If you want to take advantage of the advanced server-side features of HTMLS5 (i.e., automatic
runtime project merging, server-side search, searching of non-XHTML files), you must enable
HTMLS5 server-based output. This includes performing the following tasks: (1) installing Microsoft
Internet Information Services (1IS) and ASP.NET, (2) setting up the HTML5 target and
generating/publishing, (3) configuring IIS on the production server, (4) starting Microsoft Indexing
Service or Microsoft Windows Search (depending on the operating system), and (5) enabling
HTMLS search.

It is not necessary to install these in order to simply build HTMLS5 server-based output. However, if
you want to be able to view and display HTML5 server-based output, the following steps are
necessary. You must perform these steps on the machine that will be hosting the published HTML5
server-based output. If you want to view the output on your local machine to test the results, then
you also need to perform these steps on your local computer, except for the procedure "Configuring
[IS on Production Server."
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Installing 1IS and ASP.NET

The following steps show you how to install [IS and ASP.NET, depending on the operating system.

Windows 8

The following steps show you how to install [IS and ASP.NET 4.5 for Windows 8.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

Select Programs and Features.
Click Turn Windows features on or off.

Select Internet Information Services.

a > L N

Expand Internet Information Services > Web Management Tools > IIS 6 Management
Compatibility.

6. Click IIS Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET 4.5
1. Under Internet Information Services expand World Wide Web Services.
2. Expand Application Development Features.
3. Click the check box next to ASP.NET 4.5 to add a check mark.
4. Click OK.
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Windows 7

The following steps show you how to install [IS and ASP.NET for Windows 7.

INSTALLING IIS

1.

a > L N

Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

Select Programs and Features.
Click Turn Windows features on or off.
Select Internet Information Services.

Expand Internet Information Services > Web Management Tools > IIS 6 Management
Compatibility.

Click IS 6 Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET

1.

© N o o A~ W N

Under Internet Information Services expand World Wide Web Services.
Expand Application Development Features.

Click the check box next to ASP.NET to add a check mark.

Click OK.

Click Start.

In the search field enter run.

Click Run. The Run dialog opens.

In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet regiis -1

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet regiis -1
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9. Click OK. A window opens, displaying the installation progress of ASP.NET. The window will

close automatically when the installation finishes.

Windows Server 2012

The following steps show you how to install [IS and ASP.NET 4.5 for Windows Server 2012.

INSTALLING IIS

1.

Open the Server Manager.

. Click Add roles and features. The Add Roles and Features Wizard opens.

2
3.
4
5

Click Next two times until you ge to the Server Roles page.

. Click the check box next to Web Server (lIS).
. Inthe dialog that opens click Add Features.

INSTALLING ASP.NET 4.5

1.

2
3.
4
5

In the Add Roles Wizard click Next.

. Expand .NET Framework 4.5 Features and click ASP.NET 4.5.

Click Next.

. At the Web Server Role (IIS) tab, click Next again.
. Expand Management Tools > IS 6 Management Compatibility and click IIS 6 Metabase

Compatibility.
On the Confirm Installation Selections page of the wizard, click Install.

After the installation is completed, the Installation Results page opens. Click Close.
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Windows Server 2008 r2

The following steps show you how to install [IS and ASP.NET for Windows Server 2008 R2.

INSTALLING IIS
1. From the Start menu open the Server Manager dialog.
Click Add roles. The Add Roles Wizard opens.
Click Next.
Click the check box next to Web Server (lIS).
In the dialog that opens click Add Required Features.
In the Add Roles Wizard click Next.
Click Next again.

© N o g A~ L N

On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6
Management Compatibility and click IS 6 Metabase Compatibility.

©

On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET
1. Inthe Server Manager dialog, expand Roles.
Select Web Server IIS.
In the Role Services section, click Add Role Services.
Click the check box next to ASP.NET to add a check mark.
Click Next.
Click Install.
Click Close.

In the search field enter run.

© o N ok N

Click Run.The Run dialog opens.
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10. Inthe Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet regiis -1

64-BIT

C:\WINDOWS\Microsoft .NET\Framework64\v4.0.30319\aspnet regiis -1

11. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close
automatically when the installation finishes.
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Windows Server 2008

The following steps show you how to install [IS and ASP.NET for Windows Server 2008.

INSTALLING IIS
1. From the Start menu open the Server Manager dialog.
Click Add roles. The Add Roles Wizard opens.
Click Next.
Click the check box next to Web Server (lIS).
In the dialog that opens click Add Required Features.
In the Add Roles Wizard click Next.
Click Next again.

© N o g A~ L N

On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6
Management Compatibility and click IS 6 Metabase Compatibility.

©

On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. Inthe Server Manager dialog, expand Roles.
Select Web Server IIS.
In the Role Services section, click Add Role Services.
Click the check box next to ASP.NET to add a check mark.
Click Next.
Click Install.

N o~ W N

Click Close.
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Windows Server 2003

The following steps show you how to install [IS and ASP.NET for Windows Server 2003.

INSTALLING IIS VIA THE MANAGE YOUR SERVER DIALOG
1. From the Start menu open the Manage Your Server dialog.
Click Add or remove a role. The Configure Your Server Wizard opens.
Click Next.
Select Application server (IS, ASP.NET) and click Next.
Click Enable ASP.NET and click Next.Your selections are summarized.

Click Next. The Windows Components Wizard opens, displaying the status of the installation.

N g~ W N

After the installation is completed, click Finish.

INSTALLING 11S VIA THE CONTROL PANEL

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

2. Double-click Add or Remove Programs.The Add or Remove Programs window opens.
3. Click Add/Remove Windows Components. The Windows Components Wizard opens.

4. Inthe list of components select Application Server and then click Details. The Application
Server Dialog opens.

5. Click the check box next to Internet Information Services (IIS) to add a check mark.
6. Inthe Windows Component Wizard, "Application Server" should now be selected. Click Next.

7. Click Finish.
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INSTALLING ASP.NET
1. Click Start > Run.The Run dialog opens.
2. Inthe Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:
32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet regiis -1

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet regiis -i
3. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close
automatically when the installation finishes.

NOTE ASP.NET pages by default are prohibited in IIS. Therefore, you must set these
pages to be allowed if you are running Windows Server 2003. To do this: (1) In
Internet Information Services (11S) Manager, select Web Service Extensions from the
left pane; (2) in the right pane, make sure that ASP.NET v4.0.30319 is set to Allowed.
If it is not, select it and click the Allow button.
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Setting Up an HTMLS5 Target

The following steps show you how to set up your HTMLS5 target for server-based output.

How to Set Up the HTMLS Target

1. In Flare Desktop, open the HTML5 target.The Target Editor opens.
2. Select the Publishing tab.

3. Inthe Server-based Output section, click the check box.

4

. In the Indexing Service Catalog Name field, type the catalog that you are using for the output.
In most cases, this will be Web, which is the default value. However, if you or someone in your
company (e.g., network administrator) creates a custom catalog, you need to enter that name
in the field.

What is a catalog? Microsoft Indexing Service stores all of its index information in catalogs. A
catalog comprises index information and stored properties for a particular group of file
system directories. If Internet Information Services (IIS) is installed, the Indexing Service also
creates a web catalog, which contains an index of IS, the default virtual server of the World
Wide Web.

NOTE This step is necessary only for Windows Server 2003.

5. CIicklE' to save your work.
6. Generate the target.

7. Publish the output to any location on the web server. If you want to use the default location
that was created after you installed IS, you can publish the output to C:\Inetpub\wwwroot. If
you do this, you can use the "Default Web Site" folder that you will encounter when
performing the next set of steps (i.e., configuring IIS on the production server).

If you are working on your local machine for testing purposes, you do not need to publish the
output. You can simply view your WebHelp Plus output. When you view HTMLS5 output on
your local computer, you need to create a special folder called "MCPreview" within your
"C:\Inetpub\wwwroot" folder. Place a copy of your HTML5 output files in it. This enables you
to test the advanced features of HTML5 on your local machine.
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Configuring 1IS on Production Server

The following steps show you how to configure IIS, depending on the operating system. These
steps are necessary only for the server where you will be publishing the final output. It is not
necessary to perform these steps on your local computer for testing HTMLS5 server-based output.

Windows Server 2003

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

N

Double-click Administrative Tools. The Administrative Tools dialog opens.
3. Double-click Internet Information Services.The Internet Information Services dialog opens.

4. Find your output folder and right-click the Service subfolder. Then select Properties.The
Service Properties dialog opens.

5. Select the Virtual Directory tab.

6. Next to the Application name field, click the Create button.

NOTE If this button has already been selected, it will display as "Remove" instead. In
this case, you do not need to click the button.

7. Inthe Execute Permissions drop-down, make sure Scripts only is selected. It should already

be selected by default.
8. Click OK.
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Windows Server 2008 and 2008 r2, Windows 2012,
Windows 7, and Windows 8

1.
2.

w

© N oo g »

10.

Open the Control Panel.

Select System and Security.

Select Administrative Tools. The various operating systems have different ways to find this

option.

Open the Internet Information Services (IIS) Manager.

Expand the node with the computer name.

Expand the Sites folder.

Expand the website folder corresponding to the one that you published.

Find your output folder and right-click the Service subfolder. Then select Convert to
Application.

Make sure the application pool is using the .NET 4 framework.

a. Inthe dialog click Select.

b. From the drop-down select an application pool that is using the .NET 4 framework.

c. Click OK.
Click OK.
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Starting Microsoft Indexing Service

The following steps show you how to start the Microsoft Indexing Service on machines that are
running Windows Server 2003. This procedure is not necessary for the other operating systems.

Windows Server 2003—How to Start Microsoft Indexing
Service

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

Double-click Administrative Tools. The Administrative Tools dialog opens.
Double-click Computer Management. The Computer Management dialog opens.
Expand Services and Applications.

Right-click Indexing Service.

S e

In the context menu, click Start. The Indexing Service is now started.

CHAPTER 10 253



Starting Microsoft Windows Search

The following steps show you how to start the Microsoft Windows Search on machines that are
running Windows Server 2008. This procedure is not necessary for the other operating systems.

Windows Server 2008—How to Start Microsoft
Windows Search

From the Start menu open the Server Manager dialog.

—_

Click Add roles. The Add Roles Wizard opens.

Click Next.

Click the check box next to Files Services.

Click Next twice.

Click the check box next to Windows Search Service.
Click Next twice.

Click Install.

© o N o o A~ W N

Click Close.
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Enabling HTMLS Server-Based Search

The following steps show you how to enable HTMLS5 server-based search. These steps must be
done for each catalog that you are using on the server (or on your local machine, if you are viewing
HTMLS5 server-based output on your computer for testing purposes).

How to Enable HTML5 Server-Based Search

1. Navigate to the output folder for the HTMLS target on the server or on your local machine.

If you are enabling HTML5 server-based output on your local machine, you can quickly find
the output folder by doing the following.

a. Open the Project Organizer.

b. Double-click the Targets folder.

c. Right-click on the target and select Open Output Folder.
In the output folder, double-click the Service folder.
Double-click the folder labeled Console.ConfigureSearch.

Double-click ConfigureSearch.exe. A window appears very briefly and then disappears.

a > N

Create a folder called "AutoMergeCache" at the root of the site. Then you must set security
preferences on the AutoMergeCache folder so the application can create and update files.

a. Right-click on the root folder and choose Explore to open Windows Explorer.

b. Right-click on AutoMergeCache and choose Properties.

c. On the Security tab click the Edit button.

d. Click Add.
i. Type Everyone and click Check Names, making sure it gets underlined.
ii. Click OK.

e. Make sure Everyone is highlighted and check the option for Full Control.

f. Click Apply.

g. Click OK to exit the Permission dialog.

h. Click OK to exit the Properties dialog.
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Testing HTMLS Server-Based Search

The following steps are optional for testing HTML5 server-based search (for Microsoft Windows
Search).

How to Test Search

1. InlISright-click on the directory where your HTMLS5 project is published to and choose
Explore.

2. Inthe upper-right corner of the window you will see a Search input box. Perform a search for
a term that is commonly found in your project.

3. If you see results, your project is ready to go live.

What's Noteworthy?

NOTE If you want to test HTML5 server-based output on your local computer, the
advanced search features of HTMLS5 are not operable.

NOTE Flare's HTML5 Side and Top Navigation skins do not support runtime project
merging.
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I Including Non-XHTML Files in HTMLS
Search

Supported In:

HTHML

When end users perform a search in your online output, you can ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that search. The files do not even need to be linked to any of the
content in your Flare project. This feature is available if you publish HTML5 server-based output to
a web server running Microsoft Internet Information Services (lIS).

How to Include Non-XHTML Files in HTML5
Search

1. Enable HTMLS5 Server-Based Output If you want to take advantage of the advanced server-
side features of HTMLS5 (i.e., automatic runtime project merging, server-side search,
searching of non-XHTML files), you must enable HTMLS5 server-based output. This includes
performing the following tasks: (1) installing Microsoft Internet Information Services (II1S) and
ASP.NET, (2) setting up the HTMLS5 target and generating/publishing, (3) configuring 11S on
the production server, (4) starting Microsoft Indexing Service or Microsoft Windows Search
(depending on the operating system), and (5) enabling HTML5 search. For more information
see the Help system.

2. Generate HTML5 Server-Based Output In Flare Desktop, generate a target using the HTML5
output format.

3. Publish HTMLS5 Output to Server Publish the HTML5 server-based output to your Microsoft
[IS Web server.
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4. (Optional) Add IFilter File types that are automatically supported for HTML5 server-based
search include: Microsoft Office files, HTML files, and TXT files. For other non-supported file
types, such as PDF documents, you can download and install a simple IFilter in order to
include that file type in the search. To find and download the IFilter for the file type that you
want to include, go to a website that provides these (such as http://www.ifilter.org) and
follow the instructions for downloading IFilters. You must install the appropriate IFilters on
the server where the output files will be published, and if you are testing HTMLS5 server-based
output on your computer, you need to install the IFilter(s) locally as well.

5. Copy and Paste Non-XHTML Files to Appropriate Folder Copy all of the non-XHTML files that
you want to be included in the search. Then paste them in the appropriate subfolder of the
HTML5 server-based output that you published. By default, HTML5 server-based will find any
files located in the project output folder, as well as the "AutoSearch” subfolder. Therefore, you
can paste your extra non-XHTML files in the AutoSearch subfolder.

NOTE When you view HTML5 output on your local computer, you need to create a special
folder called "MCPreview" within your "C:\Inetpub\wwwroot" folder. Place a copy of your
HTMLS5 output files in it. This enables you to test the advanced features of HTML5 on your
local machine. When testing this search feature on your computer, you need to place the
non-XHTML files in the AutoSearch subfolder at this location (as opposed to the output
folder that was generated where your Flare project is located).

NOTE If you are testing HTML5 server-based output on your local machine, you may need
to wait a few minutes after viewing the output for the Indexing Service to fully scan your
files. Otherwise, you may not immediately see the effects of the scan (e.g., searches of
non-XHTML files, incorporation of merged output files) in the output. If you avoid
performing other tasks during this period, the scanning of the files will be completed more
quickly.

NOTE If you want to test HTMLS5 server-based output on your local computer, the
advanced search features of HTML5 are not operable.
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CHAPTER 11

Synonyms

Supported In:

WEB
HELP

HTML

5|

If users enter search phrases in your online output and those phrases are not returning results, you
can make improvements to your output so that, in the future, users are able to find the search
results they need. One way to enhance your output is to create synonyms for search phrases.

You can determine what search phrases are being used in your output by using MadCap Flare
Online Analytics.

% EXAMPLE You view search keyword results from end users and find that many are
entering the search term "sofa.” You have not used that word in your project, so users are
unable to find the topics that they need. However, you have used a similar word, "couch." In
the Synonyms Editor, you enter "couch” as a synonym for "sofa.” The next time a reader
enters "sofa" as a search keyword, topics containing the word "couch” will be returned in the
results.

NOTE Synonyms are not supported in Elasticsearch.
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NOTE Depending on the browser being used, the cache may need to be cleared in order to
see the synonym results.

NOTE If you create micro content, synonyms can help display the best search results. The

search engine looks at the micro content phrases and alternate phrases that you have

added to a file, but it also considers any relevant synonyms.

This chapter discusses the following:
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I Adding Synonym Files

Supported In:

WEB
HELP

HTML

5|

The first step to creating synonyms for enhanced search is to add a synonym file to the Flare
project.

WEB

HELP
PLUS

How to Add a Synonym File

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Synonym File.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Synonym File.

The Add File dialog opens.
2. Inthe File Type field at the top, make sure Synonym File is selected.
3. Inthe Source area, choose to create the new file based on a template or an existing file.

® New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

® New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click [=], use the Open File dialog to find a file, and
double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click 2] and select the subfolder. Otherwise,
keep the default location.
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5. Inthe File Name field, type a new name for the synonym file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click =1 and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click [=2] and select the file tags you want to apply. Click OK.

8. Click Add. The synonym file is added to the Advanced folder in the Project Organizer. The
Synonyms Editor opens to the right.

NOTE If you merge projects, synonym files will remain separate in each project. For
example, if you create synonyms in Project A but not in project B, only the topics from
Project A will use the synonyms when users perform searches in the output.
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I Creating Synonyms

Following are steps for creating synonyms.

How to Create Synonyms

1. Do one of the following to add or open a synonym file:

TO ADD A SYNONYM FILE

a. If you have not done so already, add a synonym file to the project. Start by selecting
Project > New > Advanced > Synonym File.

b. Enter a name for the synonym file and click Add.

2. TOOPEN A SYNONYM FILE
a. Open the Project Organizer.
b. Double-click the Advanced folder.
c. Double-click the synonym file.

3. Inthe Synonyms Editor, you can create directional synonyms or synonym groups for single
words, or multiple words (including hyphenated words and phrases). For example,
centerline=center line=center-line.
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SYNONYM GROUP

This is a collection of synonyms that produces the same search results for all of the words in
the group. It is a useful method if you have multiple terms in your project that are similar, and
you want the same search results to be returned when users enter any of those phrases. In
the Synonyms Editor, you enter the terms with an equal sign between each one
(Synonym1=Synonym2=Synonym3). When users enter any of those terms in future searches,
all topics containing any of those words are found.

ﬁ EXAMPLE You have written some content about sports, and many of your topics
include the words "sports," "athletics," or "games." If a user enters the word "athletics"
as the search term, it will return not only topics containing that word, but also topics
containing the words "sports" or "games" (even if "athletics" does not occur in those

other topics).

TO CREATE A SYNONYM GROUP
a. Select the Groups tab.
b. Click in the empty Group cell and press F2 on your keyboard.

c. Type the words that you want to include in the group, with an equal sign between each
(e.g., sports=athletics=games). Press ENTER when you are finished.

d. (Optional) Click the Stem check box if you want Flare Desktop to find other variations of
the synonyms that have the same stems.

% EXAMPLE You enter "hike=walk" in the Group cell. Then you select the Stem
check box. In the future, if users search for the word "hike," it will find all topics
containing the words "hike" or "walk." It will also find topics containing words
that have the same stem as those terms, such as "hiked," "hiking," or "walking."
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DIRECTIONAL SYNONYM

This is a synonym that works in one direction (Word—>Synonym). It is a useful method if
readers enter a search term that is not contained in your project, but you have a similar word
that is contained in the project. It works like this... In the Synonyms Editor, you enter the word
that is not producing search results (because it is not contained in your project content). Next
to it, you enter a synonym—a word that will produce search results (because it is contained in
your project content). When users enter the original word again in future searches, topics
containing the synonym are found.

% EXAMPLE You use Flare Online Analytics to view search keyword results from your
users and find that many are entering the search term "sofa." You have not used that
word in your project, so users are unable to find the topics that they need. However,
you have used a similar word, "couch.” In the Synonyms Editor, you enter "couch” as a
synonym for "sofa." The next time a reader enters "sofa" as a search keyword, topics
containing the word "couch” will be returned in the results.
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HOW TO CREATE A DIRECTIONAL SYNONYM
a. Select the Directional tab.
b. Click in the empty Word cell and press F2 on your keyboard.
c. Type the phrase that does not produce search results (e.g., sofa). Press ENTER.
d. Click in the empty Synonym cell and press F2 on your keyboard.

e. Type the parallel search phrase that is contained in the project content (e.g., couch).
Press ENTER when you are finished. When users perform a search and enter the term
from the Word cell (e.g., sofa), Flare Desktop will find all topics that contain the term
that you entered in the Synonym cell (e.g., couch).

f. (Optional) Click the Stem check box if you want Flare Desktop to accept other
variations of the search term that have the same stem.

4. CIicklE' to save your work.
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| Exporting Synonyms

(D IMPORTANT Feedback is deprecated in Flare Desktop, which means that it is slated to be
removed in a future version.

After creating synonyms in a Flare project, you may want to export the synonyms file (MCSYNS) to
another location. Those synonyms can then be added to a different Flare project.

How to Export Synonyms

1. Open the Project Organizer.

Double-click the Advanced folder.

Double-click the synonym file. The Synonyms Editor opens.
Select the File drop-down.

Click the down arrow on the Save button.

Select Save As or Save To.

Noo o~ W N

In the Save As dialog, navigate to the folder where you want to save the exported file. If you
want to add the synonym file to another Flare project, you can navigate to the Project >
Advanced subfolder where that project is stored.

8. In the File name field, enter a name for the synonym file.

9. Click Save.
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I Opening Synonym Files

After a synonym file is created, you can open it at any time to make adjustments to it.

How to Open a Synonym File From the Quick

Launch Bar

The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the

upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the

Quick Launch bar so you can begin typing.

= ” # Quick

L = =l _.':quic
Attributes Find and o
Window Replace in Files ~ @ Fin

Attributes Find and Repl Properties

The Quick Launch bar
appears in the upper-right
comer of the interface.

1. Inthe Quick Launch bar, type a few letters of the name of the file you want to open. Any

available results appear in a drop-down list.

2. From the list, click the name of the file.
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How to Open a Synonym File From the Project
Organizer

1. Open the Project Organizer.
2. Double-click the Advanced folder.

3. Double-click the synonym file. The Synonyms Editor opens to the right.
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CHAPTER 12

Including or Excluding Topics in
Search

Supported In:

HTML

5|

WEB
HELP

You can include or exclude a topic when full-text search is generated. If you disable this feature, the
topic is excluded from the search, but it is still included in the generated output.
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I How to Include or Exclude Topics in
Search

1. Open the Content Explorer.

2. Locate and click on the topic file.

. Inthe local toolbar, click. The Properties dialog for the file opens.

3

4. Click the Topic Properties tab.

5. Click the check box labeled Include topic when full-text search database is generated.
6

. Click OK.

NOTE In Microsoft HTML Help, all topics are always searchable.
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APPENDIX

PDFs

The following PDFs are available for download from the Help system.

| Tutorials

Autonumbers Tutorial
Back-to-Top Button Tutorial
Context-Sensitive Help Tutorial
Custom Toolbar Tutorial
eLearning Tutorial—Basic
elLearning Tutorial—Advanced
Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

APPENDIX

Micro Content Tutorial—Basic
Micro Content Tutorial—Advanced
Responsive Output Tutorial
Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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| Cheat Sheets

Context-Sensitive Help Cheat Sheet
Folders and Files Cheat Sheet
Learning & Development Cheat Sheet
Lists Cheat Sheet

Micro Content Cheat Sheet
Print-Based Output Cheat Sheet
Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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| User Guides

Accessibility Guide

Analysis and Reports Guide
Architecture Guide
Autonumbers Guide
Branding Guide

Condition Tags Guide
Context-Sensitive Help Guide
Eclipse Help Guide
elLearning Guide

Flare Online Integration
Guide

Getting Started Guide
Global Project Linking Guide
HTMLS5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

APPENDIX

Meta Tags Guide

Micro Content Guide
Navigation Links Guide
Plug-In API Guide
Print-Based Output Guide
Project Creation Guide
QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide
Targets Guide

Template Pages Guide
Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide
Videos Guide

What's New Guide
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